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Introduction

The Management Center for IDS Sensors is
a tool with a scalable architecture for
configuring Cisco network sensors, switch
IDS sensors, and IDS network modules for
routers. With the Management Center for
IDS Sensors, administrators can save
considerable time by configuring multiple
sensors concurrently using group profiles.
Additionally, it provides a powerful
¢ ature management feature that
increases th icity of
detecting possible network intrusions.
The Management Center for IDS Sensors is
a component of the CiscoWorks VPN/
Security Management Solution (VMS).
VMS is an integral part of the SAFE
blueprint and combines web-based tools for
configuring, mor l
troubleshooting:

e Virtual Private Networks (VPN)

« Firewalls

¢ Network Intrusion Detection Systems

(Ds)
* Host-based IDS.

CiscoWorks VMS addresses the needs

of both small- and large-scale VPN and
security deployments by protecting
productivity gains and reducing operating
costs fororganizations.

Cisco Systems, Inc.
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Management Center for IDS Sensors, Version 1.2

Intended Usea

Many enterprises have increased the
deployment of Cisco network and switch
IDS sensors to provide security against
network attacks. The Man  ment Center
for IDS Sensors helps centrally manage this
rising number of sensors, and provides
added security in a way that reduces
management time and cost of operations.

This tool has significant feature
enhancements and is an evolution from the
previou and

New Features since v1.0

The Management Center for IDS Sensors,
version 1.2 has additional support for IDS
4.0 and 4.1 sensor code. The administrator
will see a number of usability
enhancements. Fo sign

now listed by logical groups to help you
find signatures much more easily. The
operator can  ble or disable

signature groups to customize for a specific
networking environment. This can be done
with a few clicks, which saves time. Tuning
s _ tures has also become easier enabling
more specificity in setting signature
parameters.

The Management Center for IDS Sensors,
version 1.1 is now supported on Solaris 8.
This software does not have some of the
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features that are available on the Management Center for IDS Sensors, version 1.2, which is available only on
Windows 2000 currently. Examples of features not supported on the Solaris platform include:

» No support for managing Ciscc Network Modules for rout
« No support for managing Cisco network IDS and switch IDS sensors that use IDS 4.1

Features and Benefits
Easy to use —Can be utilized without in-depth security expertise:
» Easy to use web-based interface
* “Wizards” to walk the user through common management tasks
 Access to the Network Security Database (NSDB). This will help those without IDS security expertise, by
providing meaningful information on alarms.
Centralized management:
* Define hierarchy of sensors, containing groups and subgroups.
Scalability:
* Support several hundred sensor deployments from each console
 Use of a robust relational database to storeah _ lm
Security:
« Five authorization roles to delegate responsibility to different administrators
Workflow model:
 Determine which administrators can generate, approve and deploy configurations. Sep e tasks into a
v flow. Forex lep se changes tc ‘Approver” before deployment.
Enhanced signature management:

* Create and customize signatures for further tuning
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Network sensing can be accomplished using either a sensor or an IDSM (Intrusion
Detection System Module). Both of these sensing pli ~ b nents of
the Cisco Intrusion Detection System and can be managed by 1D mu. Both
sensing platforms monitor and analyze network traffic in real time. They do this
by looking for anomalies and  suse on the basis of an extensive embedded
signature library. However, the two platforms differ in how they can respond to
perceived intrusions.

The sensor is a high-performance plug-and-play appliance. When it detects
unauthorized network : ity, the or can inate the connection,
permanently block the associated host, log the incident, and send an alarm to
Ir = MC.

The IDSM is a switching module designed for the Catalyst 6000 family of
switches. When the Cisco Intrusion Detection System detects unauthorized
network activity, the IDSM responds by generating an alarm that can be logged
and displayed by IDS MC. The IDSM can terminate network connections when it
is running sensor software version 3.0, and later, but not when it is running earlier
versions.

Network sensing using either the sensor or the IDSM requires configuring a

n Her of sensor (or IDSM) settings and signature settings. After configuring,
tuning is required to achieve optimal performance, particularly to minimize false
positives and false negatives.

Tuning sensor configurations should not be confused with tuning parameters for
individual signatures.

Using Management Center for IDS Sensors 1.1
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Configurin

To identify an internal network, follow these steps:

Step1  Select Configuration > Settings.
Step2  In the TOC, click the Object Selector handle.

Step3  Inthe Object Selector, select the sensor for which you want to identify an internal

network.
The Object Selector closes.
Step4  Select Internal Networks.

The Internal Networks page appears, and the Object bar displays the sensor you

selected in the sct Selector.

78161

Step5  On the Internal Networks p -, you can add an internal network. After you have

added an internal network,

U

ies or delete it.

[l Using Management Center for IDS Sensors 1.1
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Cc figuring Link Status

Step 1
Step 2
Step 3

Step 4

For each sensor or group of sensors that you manage with IDS MC, you can
k t] r that you want to your link atus reported by the Event

Viewer in Security Monitor. Link status refers to the communication between a

4
\ :j;%««f,_’?:; '
Sl

particular sensor or group of sensors and Security Monitor. You can specify how
much time is to elapse before an interruption in your link is reported. You also can
specify whether the interruption is to be regarded as an event of h™ *, low, or

medium severity.

You can perform this procedure for the sensor appliance but not for the IDSM.

.v query for link us, fol

tl e

Select Configuration > Settings.
In the TOC, clickt Object Selector handle.

In the Object Selector, select the sensor for which you want to configure the

reporting of link status.
The Object Selector closes.
Select Link Status.

The Link Status page appears, and the Object bar displays the sensor you selected

in the Object Selector.

Using Management Center for IDS Sensors 1.
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Step 6

Step 7

Step 8
Step 9

To edit information associated with a host or network on the list of those that
should never be blocked by the sensor that you selected, select the ch = box
adjacent to the address of that host or network, and click Edit.

The Enter Network page appears.

Enter the following information on the Enter Network page:
o IP address
» Network mask
« Comment

To delete a host or network from the list of those that should never be blocked by
the sensor that you selected, select the check box corresponding to the address of
that host or network, and click Delete.

_.le host or network that you selected is deleted.
To add, edit, or delete additional hosts or networks, repeat Step 2 through Step 7.

To continue configuring sensors, select Configuration > Settings.

Us 1g Blockir., De..:ces

Step 1
Step 2
Step 3

Step 4

You can configure a sensor to block an attack by  nerating ¢/ . rules for
publication to a Cisco IOS router. The Cisco IOS router in that situation is referred
to as a blocking device. Before you can use a Cisco IOS  iter as a bl

device, you must identify it in IDS MC and specify its )

To identify a blocking device and specify its properties, follow these steps:

Select Configuration > Settings.
In the TOC, click the Object Selector handle.

In the Object Selector, select the sensor for which you want to specify a blocking
device and its properties.

The Object Selector closes.
In the TOC, select Blocking Devices.

The Blocking Devices page appears, and the Object bar displays the sensor you
selected in the Object Selector.

Using Management Center for IDS Sensors 1.1
r’. 78-15615-01 |
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Note By selecting the Mandatory check box, you ensure that your settings
cannot be overridden by groups that are lower in the hierarchy of the
Object Selector.

Ad ingFk e Hosts

This procedure applies to 3.x  sors. Unless you specify otherwise, the sensor
will publish its audit event stream to the host on which you have installed

IDS MC. You can identify additional network objects to which the sensor can
publish its audit event stream. These additional network objects are referred to as
remote hosts in IDS MC. A remote host can be any management client that is
capable of processing the sensor’s audit event stream, which uses postoffice-based
network sessions.

A sensor normally generates a notification and audit event record when it detects
an attack. Using this procedure, you can set the minimum level of events to be
reported to you. Setting the minimum level of events to be reported to you is one
way that you can tune your signatures. Tuning yc _itures reduces the number
of false positives.

To specify remote hosts for a 3.x sensor, follow these steps:

:p1  Select Configuration > S.
Step2  Inthe TOC, select Communic ' ms ite ~ ists.

The Remote Hosts page appears.

Using Management Center for IDS Sensors 1.1
m. 78-15615-01 |






Step6  Specify the service in the Service list box. Four services, also called daemons, are
available:

+ loggerd
< eventd
* smid

+ managed

Note  More information on loggerd, eventd, smid.  .man: _  is published in
Cisco Secure Intrusion Detection System Internal Architecture, available

at
http://www.cisco.com/univercd/cc/td/doc/product/iaabu/csids/index.htm

Step7  Set the minimum event level to be sent to the remote host in the Minimum Event
Level list box.

Youc select one of the following values:

« Inf “ategorizes an event that is the result of standard activity on your
network.

« L. —Categorizes the attack as mildly severe. These attacks are shown with
a green icon in the Event Viewer in Security Monitor.

» Medium—Categorizes the attack as moderately severe. These attacks are
shown with a yellow icon in the ...ent Viewer in Security Monitor.

e H*-“—Categorizes the attack as highly severe. These attacks are shown with
areaiconinthe¢ —  :Viewer = Security Monitor.

Step8  Enter a comment (optional).

Step9  Enter the host name.

Step 10  Enter the host ID, which typically is the last octet of the IP address of the remote
host.

Using Management Center for IDS Sensors 1.1
m. 78-15615-01 |
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I :ntifying A lowed Hosts

This procedure applies to 4.x sensors. Unless you specify otherwise, all hosts on
your network are allowed to connect to a sensor to configure it and receive alarm
data from it. However, you can identify allowed hosts; if you do, no other ho -
will be allowed to connect to a sensor.

To identify allowed hosts for a 4.x sensor, follow these steps:

£ | Select Configuratior Settings.
Step2  In the TOC, select Communications > Allowed Hosts.

The Allowed Hosts page appears.

Step3  To add a remote host, click Add.
The Enter Allowed Host page appears.

l-ing Management Center for IDS Sensors 1.1
r—a. 78-15615-01 |



Step 4
Step 5
Step 6
Step 7

T R s

Enter the IP address of the allowed host in the IP Address field.
Enter the net mask of the allowed host in the Net Mask field.
To discard your changes and close the Enter Allowed Host page, click Cancel.

To save your changes and close the Enter Allowed st page, click OK.

1g Additional “ "t

Step 1
Step 2

This procedure applies to 3.x sensors. Configuration file settings that are not
supported by IDS MC can be entered manually, as text input.

To enter additional settings for a 3.x sensor, follow these steps:

Select Configuration > Settings.
In the TOC, select Advanced > Additional Settings.
The Additional Settings page appears.

Using Management Center for IDS Sensor
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Step 3

Step 4

Step 5
Step 6
Step 7

ooz

Select the sensor configuration file to which you want to add additional text in the
File Name list box.

In the Contents field, enter the text you want to add to the sensor configuration file
that you selected.

To discard your changes and restore the previous settings, click Reset.
To save your changes, click Apply.

To make your settings mandatory, select the Mandat , check box.

Note By selecting the Mandatory check box, you ensure that your settings
cannot be overridden by devices that are lower in the hierarchy of the
Object Selector.

Using Mar~~~=ent Center for IDS Sensors 1.1
m. 78-15615-01 |
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Step 8

Step 9

Step 10

A

RN ..

_ ingSensorsanc  nature Setting., M

In the Postoffice Settings content area, enter the postoffice settings of the sensor:
Host ID (typically the last octet of the IP address of the sensor), Org Name (all
lov se ers and no spaces), and Org ID (default value 100).

Within a postoffice domain, each Org ID/Host ID pair must be unique. That is, no
sensor or sensor group can have the same Org ID/Host ID pair as another sensor
Or sensor group.

S

Note You should use only lowercase letters to detine organization names.
Additionally, do not include spaces within the organization name. The
host name and organization name are case sensitive with respect to how
postoffice processes audit events on the local host. Host names and
organization names are not passed between different postoffice clients,
only the Host ID and Org ID values.

To discard your changes and restore the previous settings, click Reset and skip the
rest of this procedure.

To save your changes, click Apply.

Caution

Step 11

Your changes will have no effect on your sensor configuration until you commit
them to the database.

To see the identification properties you just changed, select Configuration >
Pending.

The Pending page appears, showing the device whose identification properties
you just changed:

Using Management Center for IDS Sensors 1.1 g

[ 78-15615-01



Che~*~-=  Configuring Sensors and Signatures |

eIV

Step 12 To delete a pending configuration without committing it to the database, select the
check box for the configuration that you want to delete and click Delete.

Step13 Tocor ta pending configuration to the database, select the check box for the
configuration that you want to commit to the database and click Save.

i

Le N._e About Signatures

Network intrusions can be defined as attacks or other misuses of network
resources. Cisco IDS sensors use a signature-based technology to detect network
intrusions. A signature specifies the types of network intrusions that you want the
sensor to detect and report. A signature can be thought ofas asetofru  that your
sensor uses to detect typical intrusive activity, such as denial of service ~ )S)
attacks. As sensors scan network packets, they use signatures to detect known
attacks and respond with actions that you define.

On a basic level, signature-based intrusion detection technology can be compared
to virus-checking programs. Cisco Systems produces a list of signatures that the
sensor compares with network activity. When a match is found, the sensor takes
some action, such as logging the event or sending an alarm to the Event Viewer
provided with Monitoring Center for Security (Security Monitor). Sensors allow

Using Management Center for IDS Sensors 1.1
ﬁ 78-15615-01 |
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users to modify existing signatures and define new ones. However, most
customers depend on Cisco Systems to  wide ~ :latest s’ atures to keep the
sensor up to date and thus able to detect the latest attacks.

Tip To be informed about the latest signatures by e-mail, you can subscribe to the
Cisco IDS Active Update Notification. The subscription form is available at
http://www.cisco.com/warp/public/779/1argeent/it/ids_news/subscribe.html.

Signature-based intrusion detection can produce false positives, because certain
normal network activity can be construed as malicious. For example, some
network applications or operating systems may send out numerous ICMP
messages, which a signature-based detection system might interpret as an attempt
by an attacker to map out a network segment. You can minimize false positives by
tuning your sensors.

Sensors can be configured to take one or more of three actions in addition to
generating alarms:
o IP Log—This action writes the IP session data to a file. By default, this action
is not taken. The IP log action is not available when using the IDSM. It is
iilable only when using the sensor appliance.

e Reset—Thisacti 3 IsaTCF etcommand to the session in which the
attack signature was detected. By default, this action is not taken. The reset
action is available only for TCP-based attack signatures. The reset action is
not available when using the IDSM. It is available only when using the sensor
appliance.

» Block—This action causes the sensor to issue commands to a 1 to block
any source addresses from sending traffic that matches an attack signature.
These commands are issued as temporary ACL statement changes to the
ro « ig ion. After a specified period of time, the sensor removes
those statements, restoring the rou  to its pre-attack configuration.

Using Management Center for IDS Sensors 1.1
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e

Tip You can filter the display of the signature table. Using the Filter Source list, select
any of the displayed columns as the filter source. Next, enter a value in the
adjacent field and click Filter. For example, select Severity in the list box and
enter the value High in the adjacent field. When you click Filter, the signature
table displays all signatures that have a high severity. Clearing the search string
or entering the wildcard character (“*”) cancels filtering. Note that this filter is not
the s :as Filters in the Configuration > Settings TOC.

Step2  Enable or disable all signatures in a particular grouping, if desired:

a. In the category you want, such as Signature ID for 3.x sensors, select a
grouping, such as General.
b. To enable all the signatures in, for example, the General grouping, select the

check box corresponding to general signatures and click Enable. By default,
tl  most critical signatures are enabled when you install IDS MC.

-.2p3 Configureoneor wres  tures in a particular grouping, if desired:

a. In the category you want, such as Signature = for 3.x:  ors, select a
grouping, such as General.

The Signature(s) in Group page appears, and the Object bar displays the
group name and sensor name. Notice that the Signature Group list displays
General in this example.

b. Select the check box corresponding to the signature that you want to
configure. Configure in this context means to enable or disable, set severity,
and select an action.

K-.'\

..nesaver  You can select more than one check box, you

e

Tip You can select all signatures by selecting the check box in the heading of the
signature table. Also, you can sort a column by clicking the title of the column.

Using Management Center for IDS Sensors 1.1
m. 78-15615-01 |
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h. To edit the string (only for string-matching signatures), make changes in the
String field.

A

Caution  The regular expression you enter here is not compiled by a regular expression
compiler. Therefore, you must be careful to enter a valid regular expression; it is

nnt validatad hera

i. To edit the number of occurrences of the string that will cause the sensor to
generate an alarm (only for string-matching signatures), make changes in the
Occurrences field.

j- To edit the port number (not used for all signatures), make changes in the Port
field.

k. To edit the ACL name or number (used only for ACL violation signatures),
make changes in the ACL Name field.

I. To edit the direction of the traffic to be monitored (not used for all signatures),
use the Direction list box. You can select one of the following values:

« To—Specifies that incoming packets should be searched for the defined
string.

« From—Specifies that outgoing packets should be searched for the
defined string.

» Both—Specifies that both incoming and outgoing packets should be
searched for the defined string.

m. To accept your changes and close the Edit Signature(s) page, click OK.
The Signature(s) in Group page appears, showir ~ the changes that you just

made.

Step4  Tune a particular signature, if desired:

Note  Not all signatures can pDe Tuned. II 4 paruculal sygLatuLc uuss nu have an
entry in the Engines column, that signature cannot be tuned. Also,
signatures that use the engine named othexr cannot be tuned.

a. In the category you want, such as Signature ID for 4.x sensors, select a
grouping, such as General.

b. Select the Engine Name corresponding to the signature that you want to tune.

Using Management Center for IDS Sensors 1.1
mL 78-15615-01 |
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Configurii

Step 1
Step 2
Step 3

Step 4

Step 5

Step 6
Step 7

s .

Lo uring Sei x _nat ir

This procedure defines filters for a sensor as described in this e ple. The
example assumes that you have added Devicell in GroupW to your network.
Devicell is a 4.x appliance sensor in this example.

To define a filter for a sensor as described in the example, follow these steps:

Select Configuration > Settings.
In the TOC, click the Object Selector handle.

In the Object Selector, select Devicell, the sensor for which you want to define a
filter in this example. Devicell is a 4.x sensor.

The Object Selector closes.
In the TOC, select Filters.

The Filters page appears. This page shows that no filters have been defined for
Devicell, the sensor that you selected.

To begin defining the exclusive filter in this example, click Add.

The Enter Filter page appears.
Enter a name for the filter: Use “First Filter--Exclusive”

Select the action of Exclude.

Using Management Center for IDS Sensors
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The Enter Filter page now appears as shown here.

Step8  Click the Signatures link.
The Enter Signatures page appears.

Step9  On the Enter Signatures page, add All Signatures from the Available Signatures
field to the Selected Signatures field.

The ter Signatures page now appears as shown here.

YWCO 0

Step10  Click OK.
The Enter Filter page appears again.
Step 11  Click the Source Addresses link.
The Filter Source Addresses page appears.

i Using Management Center for IDS Sensors 1.1
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Step 12

Step 13

Step 14
Step 15

Step 16

Step 17

Step 18

Step 19

Step 20

Y o -

.ask List fu. onfiguring Sensors and Signature  ings

Click Add.
The Enter Filter Address page appears.

Select the radio button corresponding to Network and enter 10.10.10.0, the
network address being used in this example, along with its network mask of
255.255.255.0. The Enter Filter Address page now appears as shown here.

PEs

Click OK.

The Filter Source Addresses page appears, showing the addition of Network
10.10.10.0 with a subnet mask of 255.25.255.0.

Click OK.

The Enter Filter page appears again.

Click the Destination Addresses link.

The Filter Destination Addresses page appears.

Click Add.

The Enter Filter Address page appears.

Select the radio button corresponding to an address of Any and click OK.
The Filter Destination Addresses page appears, showing the addition of Any.
Click OK.

The Enter Filter page appears again.

Using Management Center for IDS Sens
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Step21 Click OK.

s
;oY
[
E r
Y \
L

The Filters page now appears as shown here. You have just finished defining the

first filter in this example.

Step22 To begin defining the inclusive filter in this example, click Add.

rncor

_.2p23 Add a filter with the name “S Filter--Inclusive” with an action of Include.
2 995.

Step24 Continue with this example by adding Signature 994 and S: _

Step25 Add the same source address and destination address that v

used

tl  frst

filter, and then display the Filters page again. It should now appear as shown here.

F Using Management Center for IDS Sensors 1.1
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Step2  Start the Copy Wizard. The Copy Wizard uses three steps to copy configuration
file settings:

a. Select Source Object.

Y3440

b. Select Ta :t Object(s).

Using Management Center for IDS Sensors 1.1
m. 78-15615-01 |
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¢. Select Setting(s).

Using Management Center for IDS Sensors 1.1
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To unlock the pending configuration in this example, follow these steps:

Step1  Select Admin > System Configuration.
Step2  In the TOC, select View Current Locks.

The View Current Locks page appears. Note that the owner of the pending
conﬁguration called doc-intern-sensor is doc-intern.

ow an
ydminstretor ta
shange the
ywnershipof a ;
sonfiguration
whenthe ;
surrent owner
5 No longer a
ralid user.

9190

] It  in this example, you are logged in as “admin”. Click Take Lock.

(7]
-

The View C1 nt Locks _ ge appears again. Now, note that you, logged in as
admin, are the owner of the pending configuration.

Using Management Center for IDS Sensors 1.1
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Note

Note

_, __iiny we vense. -....are Versions and Signature Release Levels Wl

We strongly recommend that you download and apply all update files, in order and
without exception, as they become available. To be informed of the latest update
files by e-mail, you can subscribe to the Cisco IDS Active Update Notification.
The subscription form is available at

httn-//www cisen.com/warn/public/779/largeent/it/ids_news/subscribe.html.

We strongly discourage upaating sensor sortware versions

levels in a direct session to an individual sensor if you manage that sensor w1th
the IDS MC. You should instead use this procedure of performing updates
through the IDS MC. If you have changed the configuration of a sensor, or
updated a sensor, outside of the IDS MC, we recommend that you delete that
sensor from your configuration and then add it to your configuration.

Updating sensor software in a direct session to an individual sensor instead o1 by
performing an update through the IDS MC will result in the rejection of the SSH
fingerprint for that sensor. This is because the — 3 MC is not involved in a session
to an individual sensor.

To use this procedure effectively, you must understand the numbering system used
for sensor software versions and signature release levels. For example:

» 3.1(2)s823—A sensor appliance is operating with sensor software version
3.1, service pack 2, signature release level 23.

e 3.0(5)820-1DsM—An IDS module is operating with sensor software version
3.0, service pack 5, signature release  :1 20.

You should also understand the update es:

» Cisco releases its periodic updates of sensor software versions and signature
release levels for its IDS Sensors in the form of update files that are
compressed (.zip). IDS MC works with these compressed files directly; you
should not extract anything from them.

Using Management Center for IDS Sensors 1
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« There are two types of update files:

- Service pack update files—You can identify service pack update files by

their names: the letters “sp” precede the version number. When these
update files are applied, they change the version number of a sensor.
Service | ck update files contain executable code; they affect the actual
micro-engine software on the sensor. They also contain signatu
updates.

Signature update files—Signature update file names« ~ ‘nthe ~ ters
“sig” before the version number. Signature update files contain newly
released signatures but not executable code.

« By inspecting the name of an update file, you can identify the device type
(sensor appliance or IDSM), type of update (service] ': T are),
version number, and signature release level. For example:

IDSk9-sp-3.1-2-823.zip. This file the following characteristics:
1psk9—Applies to a sensor appliance.

sp—Contains a service pack update. Service pack updates include
signature updates.

3.1—Applies to sensor software version 3.1.
2—Applies to Service Pack 2.
s23—Contains signature release level 23.
zi- s compressed but should not be extracted.
IDSM ~ -3.0-5-520.zip. This file has the following characteristics:
1pst  Chis update file applies to an IDS module.
sig—Contains a signature update only.
3.0—Applies to sensor software version 3.0.
wpplir o Service Pack 5.
s20—Contains signature release level 20.

zip—Is a compressed file but should not be extracted.

Using Management Center for IDS Sensors 1.1
m. 78-15615-01 |
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The two types of update files are applied in different ways:

~ Service pack update files must be applied individually, stepwise, and
sequentially. For example, if you are using a sensor appliance operating
with 3.1 (1) s32 and you want to update it to 3.1 (3) s33, you must apply
the update file 1DSk9-sp-3.1-2-32.zip and then the update file
IDSk9-s8p-3.1-3-33.zip.

Serv’  pack update files can move major and minor+  “on numbers.
For instance, if you apply the first 3.1 service pack update to the last 3. 0
version of a sensor, you will move the version number from 3.0 10 3.1.

~ Signature update files do not need to be applied individually bec e they
are cumulative. That is, a given revision level contains all the signatures
from previous levels. For example, if you are using a sensor appliance
operating with 3.1 (3)s32 and you want to update it to 3.1 (3) s34, you
can apply the update file 1psk9-sig-3-1-534.zip.

Signature update files can be applied only to sensors operating with the
same version number, or with the same version number plus service pack
designation. For example, the signature update file
1DSk9-sig-3.1-3-34.zip can be applied to a sensor operating with
version 3.1(3)S32 but not to a sensor operating with version 3.1(2)S22 or
3.1(4)S34 or 3.0(3)S22.

Signature update files can be applied only to sensors that are not already
operating at that file’s signature revision level. For example, the signature
update file 1psk9-sig-3.1-3-34.zip cannot be applied to a sensor
operating with 3.1 (3)S34. The reason is that this sensor is already
operating at the same signature version level (s34) 1" the update file
provides.

To use this procedure, you must have access to the server:

You must have access to the IDS MC server if you want to update the IDS MC
Or a Sensor.

You must have access to the Security Moni  se :r if you want to update
Security Monitor.

If you have installed IDS MC and Security Monitor on the same server, you
must have access to that server if you want to update the IDS MC or a sensor
or Security Monitor.

Using Management Center for IDS Sensors 1.1
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Step 14

49658

Click Finish.

The sensors you selected, if any, are updated using the ' _ ate file that you chose
in , 8orStep 9.Inaddition, the server where you installed IDS MC is updated.
If you have installed Security Monitor on the server where you have installed
IDS MC, this procedure will update the server operations that apply to

Security Monitor; more specifically, this procedure will supply Security Monitor
with the names of new signatures and an NSDB reference for them; sensors are
not (and cannot be) updated through Security Monitor. The update process may
take several minutes, depending upon the ~ and complexity of your network
and its traffic. However, the update process is performed by a separate thread, so
the Update Network IDS Signatures page appears again almost immediately.

Using Management Center for IDS Sensors 1.1
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To update your sensor software from 3.x to 4.x, follow these steps:

Step1  Gain physical access to the sensor and re-image it to sensor software 4.x. You
must re-image it using a Cisco CD; you cannot download the software.

Note  Some sensors cannot be re-imaged from 3.x to 4.x. Specifically, NRS
platforms (the older Netra: r sensors) cannot be re-imaged from 3.x to

4.x.

Select Configuration > Updates.
Step2  From the TOC, select Update Sensor Version.

The Update Sensor Version page appears.
Step3  Select the sensor that you want to update from a 3.x version to a 4.x version.
~ .4 ClickU) ~ e

The Update Status page appears.

Using Management Center for IDS Sensors 1.1
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Table 2-1 Server Requirements (continued)
System Component Requirement -
Operating System You must have one of the following operating
systems:

«  Windows 2000 Server, Service Pack 2 or
Service Pack 3

«  Windows 2000 Professional, Service Pack 2 or
{ ice Pack 3

I “"scoWo1’" Common Services has not been
tested with any other Windows or Windows
2000 operating system or service pack;
therefore, installing CiscoWorks
Common Services on any other operating

system - =~¢ mrmmactad
File System NTFS T
I'I_emory 1 Gigabyte, minimum
Virtual Memory 2 Gigabytes, minimum
Hard Dri*  Space 9 Gigabytes of free hard drive space, minimum

Note The actual amount of hard drive space
required depends upon the number of
CiscoWorks Common Services client
applications you are installing and the number
of devices you are managing with the client
applications.

Additionally, you should not install CiscoWorks Common Services on a Windows
server that is running any of the following services:

« Primary domain controller
» Backup domain controller
* Terminal server

You can access all product features from a client that fulfills the hardware,
software, and browser requirements. Table 2-2 shows client hardware and
software requirements.

Quick Start Guide for the VPN/Security Management Solution 2.1
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W Installation Sequence

Note  Forinformation about installing CiscoWorks Common Services on a server where
CiscoWorks is already installed, see Installing CiscoWorks Common Services 1.0
on Windows 2000.

Before You Begin

e Obtain a license for CiscoWorks Common Services and make it available on
the target server or floppy disk.

« Disable any virus scanning or intrusion detection software that may be
running in the background on the server. These types of software can interfere
with the installation.

* Close all other running pr«  ams.

« If you are reinstalling CiscoWorks Common Services, make sure the target
directory is empty or does not exist before beginning the installation.

To install CiscoWorks Common Services in a standalone configuration, follow
these steps:

Step1  Put the Common Services 1.0 CD-ROM in the server CD-ROM drive, and then
click Install on the Installer page that appears.

The CiscoWorks Common Services installation program starts. The Welcome
page of the installation application appears.

If the installation program does not start, select Start > __un from the Windows
taskbar, and then enter d: /: v in the Run dialog box, where d is the drive letter
of the CD-ROM drive. Press Enter to start the installation program.

Step2  Click Next.
The Software License Agreement page appears.

Step3  __ accept the terms of the license agre  nt, click Yes.
)

Note  If you do not accept the terms of the license agreement, click No. The
install wizard closes.

If you accepted the terms of the license agreement, the Choose Destination
Location page appears. The default installation directory, c:\program
Files\CScOpx, appears in the Destination Folder area.

Quick Start Guide for the VPN/Security Management Solution 2.1
ml 78-14634-01 |



TS San

I€ Be:~dle Cor-~~~~nt Installation

Installation  uence W~

Step4  To change the default installation directory, click ™ ‘owse and perform one of the
following steps:
« Enter a new path in the Path field. If the directory specified does not exist, the
installation program creates it.

» Use the Directories and Drives fields to navigate to an existing directory.
Step5  Click Next to continue.

The System Requirements page appears.

~

Step6  Review the requirements to ensure that the drive specified has eno * ” ze space
for the installation. If the selected drive does not have enough free ¢ perform
one of the following steps:

e Click Back to return to the Choose Destination Location screen and select a
drive that meets t!  Irive space requirements.
« Click Cancel to terminate the installation. You need to either install

additional drive space on the target system or install CiscoWorks
Common Services on a system that has the drive space requirements.

Verify that the system has enough men y.Ifthesys nd  notha yugh
memory, click Cancel to terminate the installation. You should either install
additional memory in the target system or install CiscoWorks Common Services
on a system that meets the minimum memory requirc :nts.

If your system meets all of the system requirements, click Next.
The Select License File screen appears.

Step7  Enter the path to the license file in the License file location field. You can also use
the Browse button to navigate to the correct license file. Click Next to continue.

Note  You can bypass this step oy cucking Skip. However, some of the client
applications will not function if you do not enter a valid license. Refer to
your client application documentation to note the licensing requirements
for the applications you plan to install.

The Account Information page appears.

Step8  Enter the password used to log in to Windows in the Password and Confirm
Password fields. Click Next to continue.

If the two passwords do not match, the system prompts you to enter them again.
If the passwords match, the Ports Configuration page appears.

Quick Start Guide for the VPN/Security Management Solution 2.1
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commands, restoring the router to its pre-attack configuration state. The sensor
can also make similar changes to the Cisco PIX Firewall and the Cisco Catalyst

6000 switch.

Sensors have a number of settings associated with them, beginning with the
following:

The IP address that IDS MC uses to communicate with the sensor.
The software version that is running on the sensor.

The signatures that are used to study network traffic.

The signature overrides that may have been applied.

The devices that are used to block active attacks.

The networks and syslog data streams that are litored.

Whether the sensor copies its alarm log data to an FTP server.

The sensor follows a basic task flow from initial setup to deployment. The
following list identifies the primary tasks and the order in which you should

form them.

Bootstrap the sensor so that IDS MC can detect the sensor on the network.
Bootstrapping involves getting the sensor up and running on the network,
assigning it an IP address, and connecting it to the physical media.

Add the sensor to IDS MC. Next, manually define the settings that match the
configuration settings of the bootstrapped sensor.

Configure signatures for specific responses to an attack, such as logging the
packets to and from the source address of an alarm, to a file. You can edit an
existing signature or define a new signature.

Tune the signatures for the sensor. You can tune s« ir signa “1g four
general methods: by specifying reassembly options tor IP fragments and TCP
sessions, by identifying hosts and networks that should be exempt from
sending an alarm for certain signatures, by filtering alarms in accordance with
their severity, and by changing parameters for the signature (such as
identifying which ports to monitor).

Generate, approve, and deploy the configuration files to the sensors.

Use Security Monitor to view historical and real-time attack and system
status notifications. After you configure the sensors to study network
activities, any notifications generated by the sensors are published to the
database. Using Security Monitor, you can study these notifications to

Using Management Center for IDS Sensors 1.1

[ 78-14420-01






I frocen-2 Mgman~ine Sapgors with IDS MC

Figure 3-2 Major Types of Network Connections

In location 1, the sensor is placed to monitor traffic between the protected network
and the Internet. This is commonly referred to as perimeter protection and is the
most common deployment for a sensor. This location can be shared with firewall
protection, and is discussed in Placing a Sensor on Your Network, page 3-7.

In location 2, the sensor is monitoring an extranet connection with a business
partner. Although most organizations have defined policies on the use and security
of this type of connection, there is no guarantee that the partner network is
adequatelv protected. Con Yy, an outsider can enter your network through
this type “conn . T a1 connections also may have f  ralls.

In location 3, the sensor is monitoring the network side of a remote access server,
labelec _ .al-up server in Figure 3-2. Although this connectior .y be for
employee use only, it could be vulnerable to external attack.

In location 4, the sensor is monitoring an intranet connection. For example, the
protected network of one department may contain an e-commerce site where all
the connection types described so ire required. The

department may contain company-specific research and development or other
engineering information and should be given additional protection.

Keeping these connection types in mind, consider the network you want to
protect. Determine which segments to monitor. Remember that each sensor
maintains signatures configured for the segment it monitors. Signatures can be
standard across the organization or unique for each sensor. You may consider
defining your network topology to force traffic across a specific monitored
network segment. There are always operational trade-offs when determining
sensor placement. The end result should be a good idea of where to place sensors
in your network, the number of them, and their hardware configuration.

Using Management Center for IDS Sensors
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How t 2 Sensor Functions

The next step in protecting your network is understanding how the sensor captures
network traffic.

Each sensor comes with two interfaces. In a typical installation, one interface
monitors the desired network segment, and the other interface communicates with
the IDS MC and other network devices. The monitoring in @ erates in
promiscuous mode, meaning it has no IP address and is not visible on the

monitored segment.

The sensor captures network traffic at the IP layer. Therefore, it must understand
and interpret Media Access Control (MAC) layer protocols, which most networks
use to pass along data packets.

The command and control interface is always an Ethernet interface. __is interface
has an assigned IP address, which allows it to communicate with IDS MC or other
network devices (typically Cisco routers). Although this interface is “hardened”
from a security perspective, it is visible on the network and must be protected.

Wi _ ing to attacks, the | it can do the following:

 Insert TCP resets via the monitoring interface.

Note The TCP reset action is only appropria s an action se tion on
those signatures associated with a TCP-based service. If selected as
an action on non-TCP-based services, no action is taken.
Additionally, TCP resets are not guaranteed to teatr ~ /n an offending
session hecanse of limitations in the TCP protocol.

Using Management Center for DS Sensors 1.0
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» Make ACL changes to block traffic on routers (or PIX Firewall or Cisco
Catalyst 6000 switches) that the sensor manages, using the command and
control interface.

~

Note  Suchroutersarerefi  dto as blocking routers, and the sensor opens
and maintains a Telnet session (or an SSH session, in the case of a
PIX Firewall) to such routers to reduce the time required to publish
the £ . rule sets that block tr:

The last step in understanding how a sensor functions is the data speed or load on
the monitored network. Because the sensor is not in the data path, it has no impact
on network performance. However, there are limitations on the data speeds it can
monitor. The following list identifies the available models and the maximum
network speed they can monitor:

« IDS 4230 sensor appliance—Supports up to 100 Mbps.
o IDS 4210 sensor applianc  jupports up to 45 Mbps.

* Intrusion Detection Module for Catalyst 6000—Supports up to 120 Mbps,
depending on network traffic.

ing ~ Sensor on Your | atwork

You can place a sensor in front of or behind a filtering router. Each position has
benefits and drawbacks.

Placing the monitoring interface of the sensor in front of a filtering router allows
the sensor to monitor all incoming and outgoing network traffic. However, when
denlnyed in this manner, tl nsorcani no Ul i1 network
tr.....c. An internal attacker taking advantage of vul: BT etwork
services would remain undetected by the external sensor (see Figure 3-3). In
Figure 3-3, the Outermost router is the filtering router.

Using Management Center for IDS Sensors 1

[ 78-1a420-01



-~ - am - ~ e I~ mEn

W Piacing a Sensor on Your Network

Figure 3-3 Sensor in Front of a Fiftering Router
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Placing the monitoring interface of the sensor behind a filtering router shields the
sensor from any attacks that the filtering router blocks. This configuration

_ ides a more robust reaction capability because the sensor can work with the
router to block future attacks.

L loyment C_; -id_ . ations

To enable the sensor to manage the filtering router to defend your network, yo\u
must do the following:

« Enable Telnet services on the router.
« Add the router to the Object Selector ir. .. 3 MC.

The sensor then will be able to dynamically update the router ACLs to deny
unauthorized activity.

Using Management Center for IDS Sensors 1.0
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Implementatio T

i gnature WWW fing  attempt

Signatureld/

subla 5039/0

CSID Versions: 7 ~ 1.1

Signature This signature triggers when an attempt is 1

Description  finger | via the http server. It is reco
all unn yp 1sbe oved fromr
directory.

Alarm Level 3

?ﬁg;’g;rs No known triggers.

Signature Type NETWORK
Signature  ~oMPOSITE

Structure

Impiementation CONTENT

Scanner xxx
CSS Versions:2.0

Statistics

Statistical Data - for Hosts with HTTP service enabled

Indus  Vertical

Perspective

Advanced
Technology

Aerospace
Photography
Computers
Computers
Electronics/Chips
Software
Consumables
Food/Beverage
Financial Services
Banking
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Healthcare
Pharmaceuticals
Industrial
Building Materials
Construction
Forest/Paper
Industrial Equipment

Internet

Other
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Percentage of Hosts with

this Vulnerability

Intermnal

0.05%
0.08%

0.07%

0.10%

External

0.38%

0.96%
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St -

+ of Hosts with

Service vuinerable

Internal

22.36%
29.15%
37.84%
10.07%
44.85%
44.89%
37.22%
54.93%
29.18%
60._. ..
58.24%
46.67%
59.11%
52.33%
55.00%
36.84%

26.83%
26.83%
33.59%
33.59%
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External

33.33%

66.67%
28.57%
15.98%
18.59%
54.55%
10.05%
50.00%
50.00%
1.86%
8.96%
1.01%
61.¢
59.89%
62.50%
36.84%
47.94%
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56.82%
39.84%
44.C
44.C
36.¢
51.¢
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Unspecified
Public Sector
Education
Government
Retail
Furniture
Service/lnformation
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Outsource Services
Services
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ISP
Telco
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Overall
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Affected Operating Systems
Operating System Versions
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Any

Affected Software and Programs

Soft
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80/TCP

External
CVE Information

Web gngorTcp

0.10%

0.11%

0.02% 0.06%
Versions

.~

CVE ID: CVE-2000-0128

Advisories
Advisory Name

Stock fingerd running>>Read

Finger service>>Read

Finger Server Pipe Vulnerability>>Read

Links
General Information
General Information

Advisory
Fix

Exploit, Solution & Discussion

" loit

Aliases
Vendor

Product Alias

34.38%
58.87%
31.10%
36.51%
36.51%
17.37%
23.91%

10.00%
16.67%
8.33%
100.00%
5.71%
30.11%
29.57%
1.67%
31.64%
90.00%
39.96%

Program
cgi-finger

28.26% \; (
61.90%
86.36%
35.00%
63.33%
63.33%

28.21%

28.57%
9.09%
100.00%
50.00%
100.00%

22.43%
22.22%
27.74%
4.44%

17.80%

Versions
Any

Advisory
Source
1SS
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Click Add.
The Select Group page appears.
Select any group, and then click Next.

The Enter Sensor Information page appears.

oIyl

__.ater ar. .. address, a sensor name, a user __ , and a password as if you were

_1¢ sjor; however, you will not complete the addition of a sensor in
this step of this procedure. You will only determine the sensor software and
signature version that your IDS MC server is operating with.

Click Next.
The Sensor Information page appears.
Display the Version list.

A scrolling list appears. This list displays all the sensor software and
signature versions that your IDS MC server is operating with.

Using Management Center for IDS Sensors
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Step 8

Assume for this example that your IDS MC installation cor  ins one IDS module,
as illustrated here.

U

Select an update file, IDSk9-sp-3.1-3-831.zip in this example, from the Update
File list, and then click Apply.

_.e Update Summary page appears. It states that the update file will be applied

to __ 3 MC. That is because the update ¢ does not apply to any devices in your
IDS MC installation. (The update file begins with 1Dsko9, so it applies to sensor

appliances, not to IDS modules, and there are no sensor appliances in your

IDS MC installation.)

Using Management Center for IDS Sensors 1.
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Advisories

Advisory Name

All versions of Microsoft Internet
Information Services Remote buffer
overflow (SYSTEM Level Access)
>>Read

.ida "Code Red" Worm>""--d
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Exploiting Buffer Overflow In 1S
Indexing Service DLL>>Read
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Implementation CONTENT
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Alarm Level 4
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Signature

Structure ATOMIC
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Statistical Data - for Hosts with FTP service enabled
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Farm Equipment 50.00%
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Industrial Equipment 40.00%
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* PruneSpecifyCmdLine.plxd1 Prunes alarms from the specified tables using
the specified alarms. Use as follows:

PruneSpecifyCmdLine.pl -r«tablelist” [-p] [-t“date”] [-a#]
[-s“severities”] [-w*“dirname”]

- -r“tablelist” (Required)—Specifies the type of table to be p 1. You
can list more than one table in a comma-delimited list. You can choose

from the following table types:
- syslog—SYSLOG event table
= alert—Alert table
- auditlog—Audit log table
= deploy—Deployment jobs table
- § -

For example, -r“alert,syslog”.

- -p .- ptional)—Prunes all records already marked for deletion in the
specified table. By default, al records are not pruned from the
database. .

-~ -t“date” (Optional  ’runesallreco ~ roli tthe ecified
date from the specified table. The date tormat 1s
“MM/DD/YYYY,HH:MM”.

~

Note  You cannot use -t“date” and -a# in the same argument.

- -a# (Optional)—Prunes all records that are older than the specified
number of days from the database, where # is a positive integer
representing the number of days.

~

Note  You cannot use -t“date” and -a# in the same argument.

- -s“severity” (Optional)—Prunes all records with the specified severity
from the specified table. You can list more than one severity in a
comma-delimited list.

- h—High severity

- m—Medium severity

Using Management Center for IDS Sensors 1.2
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- l—Low severity
- i—Informational severity
For example, -s*i,l,m”.

= -w“dirname” (Optional)—O1 _ tsc ma-delimited files to the
specified directory. There is one file output for each table specified.

Additionally, you can add your own custom scripts. To add a custom script, place
your script file in the X:/Program Files/CSCOpx/MDC/etc/ids/scripts folder,
where X is the drive where IDS MC is installed. If you add your script to this
folder, it will appear in the Script File list box.

IDS MC cannot verify that scripts are valid or that they will execute as expected.
A poorly written custom script can cause your system to fail.

1se Rule

Editing a database rule is similar to creating a database rule. The edit database
rule wizard takes you through the same panels that you used to create the database
rule.

To edit a device configuration, follow these steps:

Select Admin > Database.
The Database Rules page appears.

Select the radio button corresponding to the database rule that you want to edit,
and then click Edit.

The Specify the Trigger Conditions page appears.

Make any necessary changes to the fields that you want to revise. Click Nt to
access the Choose the Actions page to make changes.

To save your changes, click Finish.

To edit another database rule, repeat Step 2 through Step 4.

0 acced n1 |
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parameters of a scheduled report on the Edit Scheduled Reports page, which you
access by selecting Reports > Scheduled. You can also delete scheduled report

templates from this page.
Each time a scheduled report is run, it is added to the Completed Report page.

¢ heduling and Generating ! orts

Step 1

Step 2

Step 3

Step 4
Step §

On the Select Report page, you can select the type of report to generate and define
the parameters for the selected report. Based on the scheduling parameters you
select, the report runs immediately, at a later time, or at regular intervals.

To generate a report, follow these steps:

Select ...ports > Generate.

The Select Report page appears.

In Security Monitor, you can filter which reports : _, Lo
Report Group list, select All to show both alarm and audit reports, Alarms to
show only alarm reports, or Audit to show only audit reports.

Select the report type that you want to generate, and then click Select.

The Report Filtering page appears.

Enter the report parameters for the report type you selected. Then, click Next.
The Schedule Report page appears.

~ ter a name for the report in the Report Title field.

To export the generated report to an HTML file, select the Export to check box.
Then, specify the exact path to the filet* "is zont =~ =~ . r  eport. The
path should include the filename and the desired extension; tor example,
/<dir>[/<dir>/[...]})/<filename>[.<ext>]. No extension is appended to the
filename if you do not specify an extension.

Using Management Center for IDS Sensors
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! _ 6  Click the Run Now or Schedule for Later radio button under Schedule Options.
If you select Run Now, skip to Step 7. If you select Schedule for Later, specify the
following options:

a. Specify the date and time that you want the report to run in the Start Time list
boxes. The date is specified by month, day, and year. The time is specified in
hours and minutes. The time zone used to determine the time is to the right
of the Start Time list boxes.

b. To run the report at regular intervals, select an option in the Repeat every list
box. You can schedule the report to run every day, week, weekday, weekend
day, hour, or minute.

Step7  To send an e-mail notification to someone when the report runs, select the I' il
report to check box and enter an e-mail address in the adjacent field. Use commas
to separate multiple addresses. Then, click Finish.

If you select Run Now, the report runs and you can view the generated report by
selecting Reports > View. If you select Schedule for Later, you can view the
scheduled report template by selecting Reports > Scheduled.

About Viewing Reports

When you select Reports > View, the Choose Completed Report page appears.
From that page, you can view generated reports. You also can export reports to
ML files and delete unwanted reports. If the report was generated from a
scheduled report template, deleting the report does not delete the associated

eduled report template.

This section contains the following procedures:
» Viewir Reports, pa; 3-15
« Saving a Generated Report as an HTML File, page 8-15
« Deleting Generated Reports, page 8-16

Using Management Center for IDS Sensors 1.2
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Tip

Step 1

Tip

Step 2

Step 3

Step 4

After you generate a report, you can view it.

To understand how data is sorted in a report, refer to the numbers that appear in
the column headings of the generated report. These numbers represent the sort
keys. For example, data is sorted first based on the data in the column with a (1)
in it, followed by the data = "he column with a (2) in it, and so on.

To view a report, follow these steps:

Select Reports > View.

The Choose Completed Report page appears.

In Security Monitor, you can filter which reports appear on the page. From the
Report Group list, select All to show both alarm and audit reports, Alarms to
show only alarm reports, or Audit to show only audit reports.

Select the check box corresponding to the title of the report you want to view.
To view the selected report, click View.

The report appears in the Report page.

To view the report in a new browser window, click ( _  in ¥

The ortap; rsina new browser window.

Saving a Generated ReportasanH AL File

Step 1

After you generate a report, you can save the report as an HTML file.

To save a generated report as an HTML file, follow these steps:

Select Reports > View.

The Choose Completed Report page appears.

Using Management Center for IDS Sensors 1
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In Security Monitor, you can filter which reports appear on the page. From the
Report Group list, select All to show both alarm and audit reports, Alarms to
show only alarm reports, or Audit to show only audit reports.

To select the report that you want to export, select the check box corresponding
to the title.

_.ick Open in ..indow.

If you are using Internet Explorer, the report appears in a new browser window;
proceed to Step 4. If you are using Netscape Navigator, the Unknown File Type
dialog box appears; skip to Step 5.

To save the report, select File > Save As from the Internet Explorer menu bar.
Browse to the location where you want to save the file and enter a filename. Then,

click Save.
The report is saved using the filename and location you specified.
Skip Step 5.

To save the report, click Save File. Browse to the location where you want to save
the file and enter a filename. Then, click Save.

The report is saved using the ..._name and location you specified.

You can delete generated reports. If the report was generated from a scheduled
report template, deleting the report does not delete the associated scheduled report

template.

To delete a report, follow these steps:

Select Reports > View.

The Choose Completed Report page appears.

Using Management Center for IDS Sensors 1.2
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1 Settings

The following list contains examples of events that can be viewed in Event
Viewer:

e An attempt to break into a computer (IDS Alerts)
» General security-related messages (Security Summaries)
« A status message from a program or a computer (Audit Logs)

Event Viewer qu s the database at regular intervals to extract the most recent
events.

To learn more about Event Viewer, see the following topics:
» Event Display, page 4-2
« Selecting Cells, page 4-4
« The Count Column and the Event Count Tool-"" ge 4-5
 Status Propagation, page 4-7
» Context Buffer, page 4-8
e Sorting Data and Shifting Columns, page 4-9
« Graphing . .atures, page 4-11
« Deleting Columns, page 4-12

Event Viewer combines the functionality of a spreadsheet (such as Lotus 1-2-3 or
Microsoft Excel) with that of a hierarchical, drill-down directory (such as
Windows Explorer) to create a collection of event records called a drillsheet (a
drilldown spreadsheer). The drillsheet displays groups of similar event records on
a single row of a grid, enabling you to detect patterns in the data.

Event Viewer contains a grid: e that o s and displays event records.
Event Viewer can read real-time events and historical events from the database.
You can configure the grid pane in a variety of ways to display information about
alarms detected by the sensor. For example, you can delete unwanted columns and
expand and collapse cells.

A drillsheet has rows and columns, and the intersection of a row and a column is
called a cell.

ll‘ Using Monitoring Center for Security 1.2
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Figure 4-2  Event Viewer Drillsheet

(XN

Furthermore, if you select a cell that is blank because its value is implied by the
cell above it (for example, the cell just below the “ICMP Unreachable” cell), the
branch of the node that is operated on is the branch that is defined by the first cell
that is filled in to the right of the blank cell that you selected. For ex: ple, in
Figure 4-2, if you select the blank cell just below the “ICMP Unreachable” cell,
when you perform an action, Event Viewer behaves as though you selected the
“172.21.163.163” cell.

Note  You can use the Preferences panel to change this behavior. For more information,
see Specifying Event Viewer Preferences, page 4-21.

1ine Count volumn and the vent Count Tool-Tip

Event Viewer provides two mechanisms for displaying the number of events in a
group: the Count column and the event count tool-tip.
e Count Column—The Count column is the first column in the drillsheet; you
cannot move, collapse, or delete it. In the Count column, a cell for a given

row displays the number of events represented by that row. For example, the
drillsheet in Figure 4-3 indicates that there are 18 “ICMP Echo Req” events.

Using Monitoring Center for Security 1.2
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Howe'  the count of 7 in the fourth row does not mean that there are 7
“ICMP Unreachable” events; it means that there are 7 “ICMP unreachable”
events with a source address of “172.21.163.190” and a destination address
of “64.101.28.56”.

* Event Count Tool-Tip—You can find out how many events are represented
in a branch that spans more than one row by resting the mouse pointer on the
cell you are interested in. A tool-tip indicates how manv events pass through
that branch. The tool-tip also displays a child count. ...e child count is the
number of quedatael nts to the right of the cell you have ted.

In Figure 4-3, when you rest the mouse pointer on the source address
172.21.163.190, you see a count of §  d a child count of 2. This means that there
¢ 8 “ICMP Unreachable” e tswithasour ad¢ sof172.21.163. The
values in the Count column confi  :his. The Count column indicates that there
are 7 events with the fields “ICMP Unreachable,” 172.21.163.190 and
64.101.128.56 and 1 event with the fields “ICMP Unreachable,” 172.21.163.190
and 171.70.168.183. The sum of 7 and 1 is 8.

Figure 4-3 Event Count Tool-Tip

Using Monitoring Center for Security 1.2
|| T 1






V4 Q O \
i
Vo ¢
) - H
\‘\ X\\Y z/ ‘
\\,-.‘\ , - : ;.)","
e

‘erd

Und  inding Evein viewer Basics and Lowuays

Context Buffer

Some alarms have context buffers associated with them. Context buffers record
exactly what traffic was traversing the network at the time the alarm’s signature
was detected. The context buffer contains up to 256 bytes of incoming traffic and
256 bytes of outgoing traffic.

Not all events have context buffers. The following is a partial list of alarms that
have context buffers:

* 3100 Smail Attack

* 3101 Sendmail Invalid Recipient

¢ 3102 Sendmail Invalid Sender

« 3103 Sendmail Rec 5 oce

e 3104 Archaic Sendmail Attacks

* 3200 WWW Phf Attack

e 3201 WWW General cgi-bin Attack

¢ 6251 Telnet Authorization Failure

» 8000 String Match

The 8000 signature contains the following subsignatures:

- 2101 FTP Retrieve Password File
= 2302 Telnet-/etc/shadow Match
- 2303 Te t-t+
- 51301 Rlogin-IFS Match
= 51302 Rlogin-/etc/shadow Match
= 51303 Rlogin-++

For more information about signatures, see the Network Security Database
(NSDB). You can access the NSDB at
https://hostname/vms/nsdb/html/all_sigs_index.html, where hostname is the
name of the computer on which Security Monitor is installed. For information
about viewing the NSDB entry for an event in Event Viewer, see Learning About

Attacks, page 4-25.

Using Monitoring Center for Security 1.2
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If even one event represented by a row has a context buffer, the value in the Count
column is bold. To view the context buffer(s) associated with an event group,
select a cell, and then select View > Context Buffer in the TOC. For more
information, see Viewing the Context Buffer, page 4-23.

¢ rting Data and Shifting Columns

Note

You can sort data within a column and you can change ti  rder of columns to
help you find data.

Sorting Data

By default, all columns except time-related columns and Severity columns are
displayed in ascending order. This means that, from top to bottom, numbers are
displayed from least to greatest, and words are displayed from A to Z. To change
the sorting scheme of a column from ascendingtod  n¢ _ (or vi a),
click the column header. To change it back, click the column header again.

By default, time-related columns (times, dates, and timestamps) are displayed in
d nding order. The most recent dates are displayed at the top of the list,
ensuring that recent events are displayed at the top of lists. To change to ascending
order, click the column header. By default, Severity columns are displayed in
ascending order on the basis of priority (Info, Low, High). To change to
descending order (High, Low, Info), click the column header.

Sorting within a drillsheet is different from sorting in a spreadsheet in one
significant way: In a drills’ so1 zdi ° ntsina tic ° column is
constrained by the nature of the data in the columns to the lett.

Fore _ z, Table 4-1 shows two columns. The first column has last names, and
the  ond column has first names.

Table 4-1  First Names Sorted in Ascending Order

Last Name First Name
Baker Alan

Wanda
Jones Bob

Using Monitoring Center for Security 1
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You can select which events in the viewer are graphed. You can also specify how
the events :  graphed; in other words, you 1 specify the field ti
x-axis grouping. Each is described below.

Selecting the subset of events to graph—In the Event Viewer “grid” display,
select the node (cell) that corresponds to the events you want to graph. If you
want a graph of all events in the viewer, select the top-left cell in the display
(the root node).

Selecting the way in which events are grouped (x-axis)—You can select
how events are grouped on the x-axis in several ways.

If you want to see how the selected events were distributed over time, select
Graph > By Time.

r

If you want to group events by some field in the display, select Graph> _,
Child. The “Child” means that for a selected node in Event Viewer, a graph
will be drawn in which the x-axis is defined by the selected node’s “child”

nodes, that is, the nodes in the column to the right of the selected node. For

example:

Let’s say that you are viewing All IDS Events in your Event Viewer, and you
would like to see a graph that breaks down the events by attack type (denial
of service, reconnaissance, w¢  , and so on) for just IDIOM (4.0 and later)
Sensors.

To do this, drag and drop the IDS Alai  Type column just to the right of the
Count column, and then drag the Attack Type column justtotl -ight of the
IDS Alarm Type column. Now, select the cell in the IDS Alarm Type column
that says IDS IDIOM, and then select Graph > By Child.

You will see a _ ph of all IDIOM (4.0 and beyond Sensor) events, grouped
by attack type. For each bar, which represents a particular attack type, you

will seethet  m er of events (represented by the height of the bar) and
the breakdown by severity (represented by the height of the colors within the

bar).

Deleting Columns

You can delete a column from the Event Viewer display. Deleting a column affects
only the Event Viewer display that you are viewing. It does not change the default
column arrangement for other existing or future Event Viewer displays.

Using Monitoring Center for Security 1.2
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Working in Event Viewer IR

» PruneBySeverity.pl—Choose this script when you want to delete events
because your database contains low-severity events that you do not need to
keep.

« PruneDefault.pl—Choose this script when you want to delete events
because your database has too many events (because your database is too
big).

« PruneSpecifyCmdLine.pl-—Choose this script when you want to delete
events by specifying alarms.

Tip The available scripts are stored on the Security Monitor server in
~CSCOpx/MDC/etc/ids/scripts.

Step2  Open a command window and execute the script that you have chosen.

The script will run in a separate thread, so you can continue working with
Security Monitor.

Step3  If your database has less than 1,000,000 events, you can delete those events
through Event Viewer:

a. To delete events through Event Viewer if your database ! less than
1,000,000, select one or more cells in Event Viewer.

b. Select Edit > Delete > From Database.
c. Execute the PruneMarkedForDeletion.pl script or the Alarm Export Utility.

Col p 'nguell

Wl  acellis: ) L ‘hes that _ ss through the selected cell provide
less detail. For each branch, the background color of the cells in the newly hidden
column changes from white to gray. Also, rows are removed as necessary to
conceal the appropriate data.

Note  Collapsing does not delete anything; it merely hides data from view.

Using Monitoring Center for Security 1.
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M Working in Event Viewer

Events can be collapsed by one column, by first group, or all the way (all
columns). If a cell is collapsed by one column, each branch through the selected
cell gives one less column of detail. If a cell is collapsed by first group, Event
Viewer traverses the tree from the selected node and collapses all nodes up the
branch until a node with multiple child nodes is collapsed. If a cell is collapsed
all the way, all branches through the selected cell are condensed into the selected

cell.

To collapse a cell, follow these steps:

Step1  Select a cell in Event Viewer.

The selected cell is highlighted and outlined in gray.
Step2  To collapse a cell by one coli 1, select Edit  Collapse One Column.
Step3  To collapse a cell by first group, select Edit > Collapse > First Group.
Step4  To collapse a cell all the way, select Edit > Collapse > All Columns.

Se ... th_ _._...Expansion oundary

The Event Expansion Boundary dictates the number of a new event’s columns that
will be expanded if the ~w event does not match an existing even* —oup. The
cells in an event are expanded as long as the event matcl  an exisung event
group. After there are no matches, a new row is created for the event, and the cells
in the new event are expanded until the Event Expansion Boundary is reached.

The default value for the Event Expansion Boundary is one column. You can
change the default value in the Preferences dialog box.

To set the Event Expansion Boundary, follow these steps:

Step1  To establish a column as the Event Expansion Boundary, select a cell in that
column.

The selected cell is highlighted and outlined in gray.

Using Monitoring Center for Security 1.2
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Expanding C

Step 2

Note

Step 1

Step 2
Step 3
Step 4

Working in Event Viev | |

Select Edit > Set Event Expansion Boundary.

The Event Expansion Boundary is set. The column heading is bold.

‘Is

When a cell is expanded, all branches that pass through the selected cell provide
more detail. For each branch, the background color of * cells in the newly
filled-in column(s) changes from gray to white. Also, rows are created as
necessary to display the exposed data.

Event rows can be expanded by one column, by first group, and by all columns. If
a cell is expanded by one column, each branch through the selected cell gives one

sol of detail. If a cell is expanded by first group, Event Viewer traverses
the tree from the selected node and expands all nodes down the branch until a node
with multiple children is reached. If a cell is expanded all the way, all branches
through the selected cell are fully expanded.

S ) B many rows to be created. If the number of
new rows exceeds a certain maximum, a popup window asks you to confirm that
vou want to continue.

To expand a cell, follow these steps:

Select a cell in Event Viewer.

The selected cell is highlighted and outlined in gray.

Tc _  lacell by one column, select Edit > Expand > One Column.
To expand a cell by first group, select Edit > Expand > First Group.
To expand a cell all the way, select Edit > Expand > All Columns.

Using Monitoring Center for Security * ~

[ 78-15663-01









M Working in Event’

Step 5

Step 6

Step 8

Step 9

rer

Configure tl 1 display behavior. Select the check box that corresponds to the
desired behavior:

Select... To set this behavior...

Blank Left When multiple, contignous rows contain the same information in a
column, selecting this option causes the first instance of the
inf  ation to display and subsequent instances to appear blank.
When this option is cleared, the rej  ed information appears in
every row. This option is selected by default.

Blank A group of events is typically shown in a single row, with the first

Right column (not counting the Count column) on the left defining the
group. Mulitiple entries in associated columns are shown with a +
(plus) sign in the column. Double-clicking the cell with the + sign
expands the group by adding rows.

When Blank Right is selected, the + sign appears even when there
is only one member of a group. You have to: he <

the details for the one event. When Blank Right is cleared, a group
of events with only one event will show the information for the
single event on the top line; you do not need to “drill down” to the
sit  : event. Blank Right is cleared by default.

Specify whether events are sorted by count or content:

a. To sort events based on the number of events per row from highest to lowest,
click the Count radio button.

b. To sort events alphabetically based on =~ columnte ~ 31" "t of the Count
column, click the Content radio button.

Specify the default Event Expansion Boundary in the Default Expansion
Boundary field.

To specify the maximum number of events that can be displayed in a single grid,
enter a value in the Maximum Events per Grid field.

Specify whether Event Viewer uses colors or icons to indicate event severity.
a. To use colors to display event severity, click the Color radio button.

b. To use icons to display event severity, click the Icon radio button.

| Using Monitoring Center for Security 1.2
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Step2  Select View > Hostnames.

The Hostname Resolution dialog box displays the addresses and corresponding
hostnames, if available.

Gi >hing vent Viewer Data

You can create a graph of the data, or a subset of the data, shown in Event Viewer.
The graphs do not update dynamically; they provide a static view of the data at
the time the graph was created.

To view a graph of Event Viewer data, follow these steps:

Step1  Select the events to graph.
< To select all events, select the top-left cell in the display (the root node).

« To select a subset of events, select the cell that corresponds to the events you
want to graph.

Step2  To see how the selected events were distributed over time, select Graph > By
Time from the menu.

The graph displays along the x-axis the range of time over which the event
occurred; along the y-axis the number of occurrences. Event severity is indicated
by the color of t|  »ar.

Step3  To see the distribution of child events, select Graph > By Child from the menu.

-..2 graph displays the child events (the intheco™ nt ~ rightof the
selected node) across the X-axis of the graph and the number of trences along
the Y-axis. Event severity is indicated by the color of the bar.

Step4  To close the graph, click the close button (designated by the X icon) in the
upper-right corner of the graph window.

Using Monitoring Center for Security 1.2
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Learning About Attacks

Step 1

Step 2

The Network Security Database (NSDB) provides detailed information about
signatures, including descriptions, versions, benign triggers, and related
vulnerabilities. You can access the NSDB information for a signature directly

from Event Viewer.

To access the NSDB, follow these steps:

Select a cell in Event Viewer.
The selected cell is highlighted and outlined in gray.
Select View > Network Security Database.

If there is an NSDB entry for the event you selected, the NSI in a new
window. Otherwise, a dialog box notifies you that there is not an NSDB entry for
the event you selected and the NSDB index page opens.

V.. wing _sent _ atistics

Step 1

You can view event statistics for a cell in Event Viewer. The statistics can include
the following:

» The number of events represented by the cell.
» The severity level.
¢ The number of child cells.

o« T centage of total events that the selec ~« landits ild
represent in the curren. _ rent Viewer display.

To view event statistics, follow these steps:

Select a cell in Event Viewer.

The selected cell is highlighted and outlined in gray.

Using Monitoring Center for Security 1.2
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Step8  To specify how often, in minutes, that Event Viewer queries the database for new
events, enter a value in the Query Interval (minutes) field.

Step9  To enable automatic queries of the database for new events, select the Auto Query
Enabled check box.

Step 10  Specify whether E Viewer uses cc or icons to indicate event severity.
a. To use colors to display event severity, click the Co  radio by L
b. To use icons to display event severity, click the Icon radio button.

Step11  Configure the grid display behavior. Select the check box that corresponds to the
desired behavior:

Select... To set this behavior...

Blank Left When multiple, contiguous rows contain the same information in a
column, selecting this option causes the first instance of the
information to display and subsequent instances to appear blank.
When this option is cleared, the repeated information appears in
every row. This option is selected by default.

Blank A group of events is typically shown in a single row, with the first

Right column (not counting the Count column) on the left defining the
group. Multiple entries in associated columns are shown with a +
(plus) sign in the column. Double-clicking the cell with the + sign
expands the group by adding rows.

When Blank Right is selected, the + sign appears even when there

is only one member of a group. You have to expand the group to see

the details for the one event. Wher ™~ "ank Right = :L ', a group
“events with only one event will show the information for the

single eventontl op line; you donot:1 dtc

siI event. Blank Right is cleared by defaulit.

Step 12 Specify whether events are sorted by count or content.

a. To sort events based on the number of events per row from highest to lowest,
click the Count radio button.

b. To sort events alphabetically based on the column to the right of the Count
column, click the Content radio button.

Step13  To save your changes, click Apply.

Using Monitoring Center for Security 1.2
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Using the Event Viewer

Step 1
Step 2

Step 3

Step 4

Defining Event Viewer Preferences M

To delete a user from the Event Viewer database, follow these steps:

Select Admin > Event Viewer.

Select Users from the TOC.

The Users page appears.

.- select which user to delete, select the check box next to the user ID.

~

Note  You can select all users by clicking Select All.

A check mark appears next to the user ID that you selected.
To delete Event Viewer preferences for the selected u  click Delete.

The event viewing preferences for the selected user are deleted from the Event
Viewer database.

Using Monitoring Center for Security

[ 78-15663-01



Chapter 4

1g the Event Viewer |

i Using Monitoring Center for Security 1.2

78-15663-01 |






























~f e

-



B LY O

IDS MC uses a hierarchy of groups and sensors. A group can contain sensors,
other groups, or a combination of sensors and groups. When you start IDS MC,
you always have at least one active, defined grou -the Global group. The

IDS MC hierarchy can contain many Jevels of groups and sensors, just as a folder
in Windows 2000 can contain many levels of folders and files. Figure 4-1
illustrates an example of the IDS MC hierarchy.

Using Managemént Center for IDS Sensors
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Figure 4-1 IDS MC Hierarchy Consisting of the Global Group, Groups, and
Sensors

Notice the Global group in Figure 4-1.

T] DS MC hierarchy of groups and sensors enables you to configi  more than
one sensor at a time by configuring an entire group of sensors. Configuring more
than one sensor at a time in this way is possible because a sensor can acquire
settings from its parent group. A sensor must, in fact, acquire settings from its
parent group if a parent defines those settings as mandatory. A child cannot
override the values for such settings.

This chapter explains how to add groups and  sors to your IDS MC h chy
and to perform other tasks.

[l Using Management Center for IDS Sensors 1.1
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Step 4

Step 5

rs and Sensor Groups

Task List for Adding Sensors and Sensor Groups I

Click Next.

The Enter Sensor Information page app

Provide the information required by the Enter Sensor Information page:

a.
b.

C.

Enter the IP address of the sensor.
Enter the NAT address of the sensor, if there is one.
Enter the sensor name.

To retrieve sensor settings from the sensor, select the Discover Settings
check box.

Note It you choose to daiscover setiings, you may have to wait from 30
seconds to several minutes, depending upon the size and complexity
of your network and its traffic.

Enter the user ID and password for Secure Shell (SSH) communications
between your host and the sensor:

«  When you are using a sensor appliance, the user ID is netrangr, and the
password is one that you assign.

«  When you are using an IDS module, the user ID is ciscoids, and the
password is one that you assign.

Using Management Center for IDS Sensors 1.1
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f. Click Load.
Your saved settings appear in the configuration panel.
Click Connection.
h. Enter the auto-login username: netrangr.
i. Click session.
Click SSH.
k. Enter the private key file for authentication: sensorname.key.
I. Enter save.
m. Enter cancel.
n. Enter putty@host name.
You will be prompted for the passphrase that you generated in Step 1.

n More About SSH Fingerprints

SSH fingerprints are described in the following material, which is quoted
verbat  from the PuTTY User Manual
(http://www.chiark.greenend.org.uk/~sgtatham/putty/docs.html). PuTTY is
copyright 1. . ./-2001 Simon Tatham.

“If you are using SSH to connect to a server for the first time, you will probably
see a message [similar to the following]:

“The server’'s host key is not ca . in the registry. You have no
guarantee that the server is the computer you think it is.

. server key 1024
7b:e5:6f:a7:£4:£9:81:62:5c:e3:1f:! 6c:5a

“If you trust this host, hit Yes to add the key to PuTTY’s cache and
carry on connecting.

“If you want to carry on connecting just once, without adding the key
to the cache, hit No.

“If you do not trust this host, hit Cancel to abandon the connection.

Using Management Center for IDS Sensors 1.1
‘ mlf —
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Tasn cion o -Adding Sensors and Sensor Groups

2w

Ci1 1ting Sensor Subgroups

You can add a subgroup to any sensor group, including the Global group.

To create a sensor subgroup, follow these steps:

Step 1 Select Devices > Sensor Group.

The Sensor Group page appears.

Using Management Center for IDS Sensors 1.1
| W 1R-16815.01 |
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" asors and Sensor Groups

Step 2
Step 3

Step 4

Step 5

Task List for Adding Sensors and Se

In the tree, select the name of the sensor group that you want to add a subgroup to.

Click Create Subgroup.
The Add Group page appears.

e

In the Group Name field, enter the name of the subgroup you want to add. Next,
select the Default (use parent values) radio button, or select the Copy settings
from group radio button and select the name of the group from the associated list

box.
Click OK.

The Sensor Group page appears, showing the sensor subgroup that you just added.

Using Management Center for IDS Sensors 1.1
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Step 2
A

Caution

Step 3

In the tree, select the group that you want to delete.

If you choose to delete a sensor group, IDS MC does not ask you to confirm your
choice.

Click Delete.

The Sensor group page appears again, showing the parent of the group you just
deleted.

Using Management Center for IDS Sensors 1.1

[ 78-15615-01
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Affected Services

il

111/TCP

[P/ 77" 1]Any

Trewy dax

rwaii;100008
cmsd/100068

rstatd/100001
amd/300019
ypbind/100007
yppasswd/100009
mountd/100005

RPC File_sharing 111/UDP pcnfsd/150001

External
CVE Information

CVE ID: CVE-1998-0312

Advisories
Advisory Name

CA-93:01.REVISED.HP.NIS.ypbind.vulnerabilit

Links

|
AUVISUTY QUUILVE

amd/100065
portmapper/100000
rquotad/100011
selection_svc/100015
rexd/100017
YPServ/100004
ypupdated/100028
sadmind/100232
bootparam/100026
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Access
Required:
Access
Gained:

network

root

ery Da
"

£UU 1

Products

Scanner

CSS Versions:2.0.2.3

IDS Signature DNS TSIG Overflow

Signatureld/
Subld 6059/0

CSID Versions: Any

Signature Alarms when a DNS query type TSIG is detected and the

Description  domain name is greater than 255.
Alarm Level 5

Benign :
Triggers No known triggers.
Signature Type NETWORK
Signature

Structure ATOMIC

Implementation CON", _.IT
IDS Signature DNS complain overflow

5ugbr}(:ﬁ;tureldl 6060/0

( > Any

Signature Alarms when an NS record is detected with a domain name

R A3 WiY

Description  greater than 255 and the 1P address is 0.0.0.0,
255.255.255.255 or a multicast of form 224.X.X.X

Alarm Level §

Benign .
Triggers No known triggers.
Signature Type NL. . JORK
£*~qature

£ cture e IM-
Implementation CONTENT

INng Signature DNS infoleak

stﬂ;‘;gtureldl 6061/0

CSID Versions: Any

Signature Alarms when a DNS IQUERY is detected with a record

Description  data Length greater than 4 and Class IN.
Ala  Level 4

Benign .

Triggers No known triggers.

Signature Type NETWORK

Sig  ure
Strucwure ATOMIC

Implementation CONTENT

Affected Software and Programs

Software Versions Program
BIND [PATCH] Any,Any

Affected Services

Name Type Ports RPC

. .. 53/TCP
BIND Application 53/UDP

External

Advisories

Advisory Name Advisory Source
COVERT-2001-01 >>Read NA[ COVERT Labs

~A 2004 09 Mltiple Vulnerabilities i~

IR
General Information
General Information

http://www.cisco.com/cgi-bin/front.x/csec/view.pl?\" " =3186&VV ™™ =5
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F Using Monitoring Center for Security 1.2
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Step 5

Step 6

Step 7

\' wing

Tip

To export the generated report to an HTML file, select the Export to check box.
Then, specify the exact path to the file that is to contain the generated report. The
path should include the filename and the desired extension; for example,
/<dir>[/<dir>/[...]]/<filename>[.<ext>]. No extension is appended to the
filename if you do not specify an extension.

Click the Run Now or Schedule for Later radio button under Schedule Options.
If you select Run Now, skip to Step 7. If you select Schedule for Later, specify the
following options:

a. Specify the date and time that you want the report to run in the Start Time list
boxes. The date is specified by month, day, and year. The time is specified in
hours and minutes. The time zone used to determine the time is to the right
of the Start Time list boxes.

b. To run the report at regular intervals, select an option in the Repeat every list
box. You can schedule the report to run every day, week, weekday, weekend
day, hour, or minute.

To send an e-mail notification to someone when the report runs, select tt Email

port to check box and enter an e-mail address in the adjacent field. Use commas
to separate multiple addresses. Then, click Finish.

If you select Run Now, the report runs and you can view the generated report by
selecting Reports > View. If you select Schedule for Later, you can view the
schedulec _ i _ate  selecting 1 ts hedu

_ports

After you generate a report, you can view it.

To understand how data is sorted in a report, refer to the numbers that appear in
the column headings of the generated report. These numbers represent the sort
keys. For example, data is sorted first based on the data in the column with a (1)
in it, followed by the data in the column with a (2) in it, and so on.

F Using Monitoring Center for Security 1.2
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Related Vuilnerabilities

ID D  riptive Name
2965 11S Unicode F  note Command Execution
Affected

Affected Operating Systems
Operating System Versions

Solaris [PATCH]  2.5.1,2.6,2.5,2.3,2.4,7.0
SunOS [PATCH] 5.5.1,5.6,5.4,5.7,5.5,5.3

Affected Software and Programs

Software VersionsProgram Versions

rpc.admind Any
Affected Services

Name Type RPC
rwall/100008
cmsd/100068
tidbserverd/100083
sprayd/100012
rstatd/100001
amd/300019
ypbind/100007
yppasswd/100009
mountd/100005
RPC  File_sharing 111/CE penfsd/150001
amd/100065
portmapper/100000
rquotad/100011
selection_svc/100015
rexd/100017
YPServ/100004
ypupdated/100028
sadmind/100232
bootparam/100026

Ports

External
CVE Information

C\"ID: 7' *199-0977

Advisories

Advisory Name 4
R iffer Overflow in Sun Solstice AdminSuite Daemon sadmind>>Read
_.+2001-11 sadmind/lIS V >>Read CERT
Solaris sadmind Buffer Overflow Vulnerability>: ___ad BUGTRZA _.

Solaris Solstice AdminSuite (sadmind) daemon buffer overflow>>Read ISS
K-013: Buffer Overflow in Sun Solstice AdminSuite Daemon CIAC
sadmind>>Read =

Links

Fix

General Information

Aliases

Vendor Product Alias

Security Vulnerabilities Solaris sadmind Buffer Overflow
Focus Database Vulnerability

ISS XForce XForce Database  sol-sadmind-amslverify-bo
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Key features for the Cisco 3725 and 3745:

« Two Integrated 10/100 LAN ports

» Two Integrated Advanced Integration Modules (AIM) slots

 Three Integrated WAN Interface Card (1 ) slots

« Two (Cisco _. _J) or four (Cisco 3745) Network Module (NM) slots

= One (Cisco 3725) or two (Cisco 3745) High Density Service Moc -

HDSM)

rslots

* 32MB Compact Flash/ 128MB DRAM (default, single 128MB DIMM/SODIM!
« Both Cisco 3725 and 3745 have a single 128MB SDRAM DIMM module and a single 32MB Compact Flash

module by default

¢ Optional In-Line Power for 16-port EtherSwitch NM, 36-port EtherSwitch HDSM and wireless access points

* Support for all major WAN protocols and media: LL

B3, H_.

1,X.25,.....], fractiona. __.__, T1/E1, xDSL,

« Support for selected NMs, WICs and AIMs from the Cisco 1700, 2600 and 3600 Series
e 2 RU (Cisco 3725) or 3 RU (Cisco 3745) Rack-mountable chassis

e -24V DC power supply

* NEBS Level 3 compliance

Additional Key Features for the Cisco 3745:

e Field-repla
* Passive backplane

ile motherboard, I/O board and fan tray

¢ Optional internal redundant power supplies (RPS — AC, DC and inline power)
* Online Insertion and Removal (OIR) of NMs and RPSs

Table 1 Cisco 3700 Series Key Features and Benefits

Modular platform which
shares interfaces with
co 1700, . 0, ]

Network intertaces are rieid-upgradganie 10 aCCOIMITOOate TUIUTe Lec Nuioges
- Additional services can be added on an “integrate as you grow" basis

- Leverages the large existing portfolio of WICs, VICs, NMs and AlMs to reduce
sparing, training, configuration and installation and maintenance costs

LAN/WAN Connectivity
integrated into chassis

More NM and HDSM slots available to add services in the future

- Combination of AlMs and WICs along with NMs/HDSMs gives greater flexibility to
create new configurations as requirements change

VPN and Security
configurations

Add security intrusion detection (IDS) and VPN connectivity to the router through
Cisco I0S software and optional performance-enhancing data encryption AlMs.

- Provides secure connectivity and perimeter security throughout the network.

Flexible voice gateway and
IP Telephony
configurations

Incremental or full scale migration from legacy infrastructure to IP Telephony

- Supports numerous standards-based analog and digital interfaces to PBXs and the
PSTN

- Sliding scale options for higher density mixed analog and digital voice gateway
configurations

Cisco Systems, Inc.
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Specifications

-

Table 3 Cisco 3700 Series Specifications

Processor Type  Cisco 3725—MiIPS RISC processor
« Cisco 3745—MIPS RISC processor
Performance * Cisco 3725—100kpps

Cisco 3745—225kpps

Flash Memory (Compact Flash)

Internal: 32MB (default), expandable to 128MB
External: 32MB, 64MB,128MB options

Systemn Memory

128MB (SDRAM default)—expandable to 256MB

Onboard AIM (intemal)

2

Console port

1 (up to 115.2 kbps)

Aux port

1 (up to 115.2kbps)

Minimum Cisco 10S Release

Cisco 105 12.2(8) T

Onboard LAN ports

2 10/100 Fast Ethernet ports

ersal DC (24VDC to 60VDC), PWRGE00-AC-RPS External RPS

1al l indant options for AC and Un 24 to

60VDC)

Rack Mounting

Yes, 19’ and 23" options

- 495W Maximum with optional power supply:,-48V@360W) AC to DC power
supply

Cisco 3745—

- 230W Maximum (QAC-DC Power Supply

- 590W Maximum (Per AC Input) with optional power supply -48V@360W)
AC-DC power

Heat Dissipation

Cisco 3725—

- 135W Maximum 460.661 BTU/hour
- 495W Maximum 1689.089 BTU/hour
Cisco 3745—

- 230W Maximum 784.829 BTU/hour
- 590W Maximum 2013.257 BTU/hour

Output

Cisco 3725—
- {optional -48V@7.5A)
Cisco 3745—
- (optional -48V@7.5A)

Cisco Systems, inc.
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_..2Ci 3700 Series Multiservice Access Routers enable flexible and ~ ble deployment of new e-business
applications in anint _  d branch office access platf The Cisco 3700 Series is ideal for sites solutions

requiring the highest levels of integration at the edge for Branch Office IP Telephony, voice gateway, and integrated
flexible routing with low-density switching solutions. In addition, the Cisco 3700 Series provides a consolidated
service infrastructure and high service density in a compact form factor that enables the incremental integration of
branch applications and services.

Service and Support

The award-winning Cisco Service and Support offerings provide presales network audit planning, design consulting,
network implementation, operational support, and network optimization. By including service and support when
purchasing Cisco 3700 products, customers can confidently deploy a converged network architecture using Cisco
exper  experience, and resources.

For More Information on Cisco Products, Contact:
U.S. and Canada: 800 553-NETS (6387)

Europe: 32 2 778 4242

Australia: 612 9935 4107

Other: 408 526-7209
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fionn Cuerruse

Corporate Headquarters European Headquarters Americas Headquarters Asia Pacific Headquarters
Cisco Systems, Inc. Cisco Systems International BV Cisco Systems, Inc. Cisco Systems, Inc.
170 West Tasman Drive Haarlerbergpark 170 West Tasman Drive Capital Tower
San Jose, CA 95134-1706 Haarlerbergweg 13-19 San Jose, CA 95134-1706 168 Robinson Road
USA 1101 CH Amsterdam USA #22-01 to #29-01
www.cisco.com The Netherlands www.cisco.com Singapore 068912
Tel: 408 526-4000 www-europe.cisco.com Tel: 408 526-7660 www.cisco.com

800 553-NETS (6387) Tel: 310 20357 1000 Fax: 408 527-0883 Tel: 4656317 7777
Fax: 408 526-4100 Fax: 310 20357 1100 Fax: +65 6317 7799

Cisco Systems has more than 200 offices in the following countries and regions. Addresses, phone numbers, and fax numbers are listed on the
Cisco Web site at www.cisco.com/go/offices

Argentina ¢ Australia ¢ Austria ¢ Belgium ¢ Brazil ¢ Bulgaria * Canada ¢ Chile « China PRC - Colombia ¢ Costa Rica ¢ Croatia
Czech Republic ¢+ Denmark ¢ Dubai, UAE ¢ Finland « France « Germany ¢ Greece * Hong Kong SAR ¢ Hungary * India  Indonesia ¢ Ireland
Israel « Italy ¢ Japan * Korea ¢ Luxembourg * Malaysia * Mexico ¢ The Netherlands * New Zealand « Norway ° Peru + Philippines * Poland
Portugal * Puerto Rico ¢ Romania * Russia * Saudi Arabia ¢ Scotland < Singapore ¢ Slovakia ¢ Slovenia ¢ South Africa ¢ Spain * Sweden
Switzerland ¢ Taiwan < Thailand ¢ Turkey ¢ Ukraine * United Kingdom ¢ United States °* Venezuela ¢ Vietnam ¢ Zimbabwe












Specifications

Software Support

Table 2 lists the minimum Cisco IOS Software requirements for the Cisco T3/E3 Network Module, and Table 3 gives support

information.

Table 2 Minimum Cisco IOS Software Reauirements for Cisco T3/E3 Network Madule

l T ) UL TPUL VILGISVAGINILVE 107 120 HEAWULR IIUMUIT [P2VISBY) Y l
LISCU 200U HNd J 1AV I
Cisco 2691 1
—ivu suuy 1 -
Cisco 3725 1
Cisco 3745 2 ]

Hardware Specifications

DS3/E3 Specifications
. evel interface with dual female 75-ohm BNC coaxial connectors per port (separate RX and TX)
* Full- and half-duplex connectivity at DS3 rate (44.736 MHz)
 Full- and half-duplex connectivity a _ ate (34.368 MHz)
= Scrambling and subrate support of major DSU vendors
* Line build-out—Programmable for up to 450 feet of 734A or equivalent coaxial cable or up to 225 feet for 728A or
equivalent coaxial cable
» C-bit, or M23 framing for T3, bypass and G.751 framing for E3 (software selectable)
* Binary 3-zero substitution (B3ZS) (T3) or high-density bipolar with three zeros (HDB3) (E3) line coding
* Support for 16- and 32-bit CRC (16-bit default)
» DS3 FEAC channel support
» Twenty-four-hour history maintained for error statistics and failure counts
* DS3 alarm and event detection (once per second polling)
* Alarm indication signal (AIS)
* Out of frame (OOF)
* Line code violation (LCV)
« Excessive zeros (EXZ)
* Far-end receive failure (FERF)
Cisco Systems, Inc.

All contents are Copyright © 1992-2002 Cisco Systems, Inc. All rights reserved. Important Notices and Privacy Stateme
Page 4 of 6



Table 4 LED Port Indicators and Status

v

LalliCl UtleUt (UL 1HULCHLES 10SS OT signat [LuUD))

LP Yellow Loopback mode on

AlS Yellow Port is receiving AIS

FERF Yellow Port is receiving FERF signal

EN Yellow Network module is cnﬁed -
Alarm Yellow Port is receiving OOF errors

Serial Encapsulations
= HDLC
« PPP

* Frame Relay

e ATM Data Exchange Interface (ATM-DXT)

Physical Specifications

* Si :-wide network module, no slot tions
» Dimensions (Hx W x D) 1.55 x 7.10 x 7.2 inches (3.9 x 18.0 x 18.3 centimeters)

Environmental Specifications

» Operating temperature: 32 to 104 F (0 to 40 C)

» Storage temperature: —4 to |

7 (=20 t0 65 C)

. lative humidity: 10 to 90%, noncondensing

Certification

( _ ance

DS3 physical layer

» ANSITI.102, T1.107
E3 physical layer

+ TBR24

» ITU-T G.703 & G.823
+ ACA TSO016

Cisco Systems, Inc.
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Safety * ENS55024:1998, EN50082-1:1997 and EN61000-6-2: 19

. JL1950 3rd Edition/t  « C22.2, No.950) i
. ) 161000-¢

« UK (BS6301, EN60950, EN41003) - Radiated Immunity: EN61000-4-3

* G ny (TUV GS) — Burst Transients: EN6100 4

* 1 ce(EN60950, EN41003, NFC98020) — Surges: EN61000-4-5

— Injected RF: EN61000-4-6
— Dips + Sags: EN61000-4-11
* EN61000-3-2: 1995
+ EN61000-3-3: 1995
¢ AS/NZS 3548 Class A
*  VCCI V-3/2000.04 Class A

e AS/NZS 3260 (Australia/New Zealand)
» EN60950/EN41003 (Europe)
» IEC 950 (national deviations)

EMC
* 47 CFR 15: 2001 Class A (FCC)

¢ [ICES003 Class A

* ENS55022 Class A: 1998 Standards
« EN300386: 2001 * T3/E3 MIB (RFC 1407)
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QoS Features

» Weighted Random Early Detection
 Precedence setting and mapping (802.1p)
¢ Committed Access Rate (CAR)

¢ Access control list (ACL)

* Extended ACLs

¢ Voice and remaining QoS features, per platform and Cisco IOS Software version

Miscellaneous

e Jumbo frame support, up to 16 KB

* Cisco Group Management Protocol (GMP), Internet Group Management Protocol (IGMP) for multicasting
¢ Hot Standby Router Protocol (HSRP)

¢ Online insertion and removal (OIR)—network module OIR supported on Cisco 3660 and Cisco 3745

* Hot insertion and removal for GBICs on all platforms

¢ Media type or GBIC type display—show interface displays GBIC,1 1 type

Gigabit Ethernet Applications

_abit Ethernet inthe anch = e

In a branch office, the Cisco Gigabit Ethernet Network Module can provide a high-speed uplink. Figure 2 shows the
module being used to bridge : routable protocols while simultaneously providing Layer 3 connectivity. The
module is also useful in situations that require inter-VLAN routing with an ISL or IEEE 802.1q trunk, and in any
LAN requiring fiber connectivity.

| 2
(waon Ethernet in LANS

VLAN1 f
Routing Between VLANS \
M. | 4
! )
VLAN 2 Gigabit Ethernet
-— _
Bridging Between VLANS
<«

VLAN 3
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C 0 - Understanding Fast Ethernet LAN/WAN Interface Card Network Modules
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For more information on configuring the WIC—2T card refer to Configuring Serial Interfaces.

Related Information

e 1—- and 2—Port _rial WAN Interface Cards
Overview of Cisco Network Modules
e Technical Support — Cisco Systems

All contents are Copyright © 1992-2003 Cisco Systems, Inc. All rights reserved. Important Notices and Privacy Statement.
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Table 1 : v “ard Applications
VIC-2FXS | Use to connect directly to phones, fax machines, and key systems (generates battery polarity reversal with 10S Plus 12.1.21 and
later and generates Caller ID using [0S Plus 12.1.3T or later).
o key system and to provide off-premise connections
VIC-2E/M Use to connect to PBX or key system trunk lines
VIC-2FX0O-EU Use to connect to PBX or key system and to provide off-premise connections in Europe
VIC-2FX0O-M1 Use to connect to PBX or key system and to provide off-premise connections in the U.S., Canada and other countries. Includes
support for battery polarity reversal detection and Caller ID (requires Cisco IOS Plus 12.1.2T and later and supports Caller [D using
1 Cisco 10S Plus 12.1.3T or later).
to provide off-premise connections in Europe. Includes support for battery polarity
reversal detection and Caller ID (requires Cisco [0S Plus 12.1.2T or later for battery reversal and supports Caller ID using Cisco
10S Plus 12.1.3T or later)
VIC-2FX0-M3 Use to connect to PBX or key system and to provide off-premise connections in Australia

VIC-2BRI-S/T-TE

Use to connect to PBX or key system and to provide off-premise connections (ISDN voice BRI)

VIC-2BRI-NT/TE

VIC-2DID

Use to connect as network side to PBX or key system and to provide off-premise connections (ISDN voice BRI)

Use t

VIC-2CAMA

Use t¢

Cisco Systems, Inc.

All contents are Copyright © 1992-2002 Cisco Systems, Inc. All rights reserved. Important Notices and Privacy Stateme
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Cisco 3725 IP/IPX/AT/FW/IDS PLUS €3 /2>-DIN0SS-IMZ 22VID 1200
Cisco 3725 IP/IPX/AT PLUS ¢3725-bins-mz 32MB 128MB
Cisco 3725 IP/FW/IDS PLL-IS IPSEC 3ES €3725-ik903s-mz 32MB 128MB
Cisco 3725 IP PLUS IPSEC 3DES ¢3725-ik9s-mz 32MB 128MB
Cisco 3725 IP PLUS c3725-is-mz 32MB 125M B
Cisco 3725 ENTERPRISE/FW/IDS PLUS IPSEC 3DES ¢3725-jk903s-mz 32MB 128MB
Cisco 3725 ENTERPRISE PLUS IPSEC 3DES ¢3725-jk9s-mz 32 128MB
Cisco 3725 ENTERPRISE PLUS €3725-js-mz 32MB 128MB
Cisco 3725 ENTERPRISE PLUS/H323 MCM €3725-jsx-mz 32MB T 128MB T

Note that the default Flash is 32MB and default DRAM is 128MB on 3725 series shipments configured with Cisco 10S 12.2(8)T.

The Flash and DRAM requirements above are for the Cisco 10S Plus 12.2(8)T release. The actual requirement may vary depending

onthe

»n of Cisco 10€

and DRAM requirements).

All contents are Copyright © 1992-2002 Cisco Systems, Inc. All rights reserved. Important Notices and Privacy Statemer
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¢ Frame Relay Fragmentation Implementation Agreement—FRF.12
* Frame Relay Forum Implementation Agreement FRE11 for Data Compression

¢ Frame Relay Forum Implementation Agreement FRE. 16 for Multilink Frame Relay

ITU-T/CCITT Standards

More information for each standard may be obtained from: http://www.itu.int/

X.3—ITU-T/CCITT 1993 mandatory
X.25—ITU-T/CCITT 1993
X.28—ITU-T/C 1993

X29— Lo T/IC ... 1993

X.31—X.25 on ISDN

X.12  Addressing scheme

ITU-T H.323 Packet-based multimedia ¢

Y

ITU-T T.37 Procedures for the transfer of facsimile data via store-and-forward on the Internet

ITU-T T.38, Procedures for real-time Group 3 facsimile communication over IP networks
ITU-T T.38, Procedures for real-time Group 3 facsimile cor

__ _-T, Revised Annex B of Recommendation T.38

ITU Standards for Voice CODECs:

g711lalaw G.711 A Law 64000 bps

g 711 u Law 64000 bps
g 723.1 AN. .....-A 5300 bps
ar.. . 31A -A 6300 bps

o —-

£723r53 G.723.1 5300 bps

g723r63 C.. _3.1 6300 bps

g726r16 G.726 16000 bps

g726r24 G.726 24000 bps

8726132 G.726 32000 bps

£728 G.728 16000 bps

g729br8 G.729 ANNEX-B 8000 bps
g729r8 G.729 8000 bps

gsmefr GSMEFR 12200 bps

gsmfr GSMFR 13200 bps

nication over IP n

a0

srks, Amendment 1

ITU-T Q.931 (and related standards)—ISDN user-network interface layer 3 specification for basic call control

Cisco Systems, Inc.
All contents are Copyright ® 1992-2003 Cisco Systems, Inc. All rights reserved. Important Notices and Privacy
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Before you reload the router, you need to check two things: - 4 P‘

¢ The value of the config—register — You can check this using the show version command. The
value is shown in the last line of the show version output. I set  )x2102.

2610#configure terminal
Enter configuration commands, one per line. End with CNTL/Z.
2610 (config) #config-register 0x2102
2610 (config) #+2
¢ The other files on the Flash — If the first file in the Flash is not the Cisco IOS Software image,
but a configuration file or something else, then you need to configure a boot system
statement in order to boot the specified image. Otherwise, the router will try to boot with the
file or the first fi in~ :Flash; this will not work. If there is only one file in the

Flash which is the Cisco IOS Software image, then this step is not necessary.

2610#configure terminal

Enter configuration commands, one per line. End with CNTL/Z.
2610 (config)#no boot system

2610 (config) #boot system flash c¢2600-i-mz.121-14.bin

2610 (config) #+Z

Note: If you type the reload command, the router asks you if you want to save the
configuration. You should be very cautious here. The reason is that if the router is in boot

e forinstan it is a subset of the full Cisco IOS software which is runnii  ind there is
no routing functionality. Therefore, all the routing configuration is gone in the running
configuration and if you save the configuration at this time, then you erase the good
startup—configuration in NVRAM and replace it by the incomplete running—configuration.
Save the configuration only if you are sure that you have the full configuration in the output
of show run. It is not necessary to save the configuration to take into account the new
configuration register if this one has been changed previously. That is done an  natically.

2610#reload

System configuration has been modified. Save? [yes/nol: y
Building configuration...

[OK]

Proceed with reload? [confirm]y

V 'y that the router is running with the proper image. After the reload is complete, the
router should be running the desired Cisco IOS Software image. Use the show version

command to verify.

2610#show version
00:22:25: %$SYS-5-CONFIG_I: Configured from console by console

Cisco Internetwork Operating System Software

I0S (tm) C2600 Software (C2600-I-M), Version 12.1(14), RELEASE SOFTWARE (fcl)
Copyright (¢} 1986-2002 by cisco Systems, Inc.

Compiled Mon 25-Mar-02 20:33 by kellythw

Image text-base: 0x80008088, data-base: 0x80828788

ROM: System Bootstrap, Version 11.3(2)XA4, RELEASE SOFTWARE (fcl)

2610 uptime is 22 minutes
Svstem returned to ROM by reload
)0

Cisco — Software Installation and Upgrade Procedure






A

- i
e an IP address in the same ,, Or : ¢ & .
ea aultga configu —a

To verify this, check the .. address of the TFTP server.

See De 1 _PAd o details.

Copy the new image into the Flash memory card through th TFTP
server

Now that you have IP connectivity and can ping between the computer acting as a TFTP server and the router,
you can copy the image into the right slot.

Note: Before copying, make sure you have started the TFTP server software on your PC and that you have the
filename mentioned in the TFTP server root directory. We recommend that you keep a backup of the
router/access server configuration before upgrading. The upgrade itself does not affect the configuration
(which is stored in nonvolatile RAM -NVRAM). However, this may happen if the right steps are not
followed properly.

For RCP applications, substitute RCP for every occurrence of TFTP. For example, use the copy rep {device:}
command instead of the copy tftp {device:} command.

If necessary, you can copy an image from one device to another.

3600#copy tftp: slotl:

Address or name of remote host []1? 171.68.173.10
Source filename []? ¢3640-i-mz.122-7b.bin

Destination filename [c3640-1-mz.122-7b.bin]?
Accessing tftp://171.68.173.10/¢c3640-i-mz.122-7b.bin. ..
Erase slotl: before copying? [confirmln

I-—-— Here you are specifying "n"

I—-—— because there is enough memory available.

Loading <3640 ;.122-7b.bin £: . 171.68.173.10 (via Ethernetl/0):
|1

L I O O O O O O I O

[OK - 5996844/11993088 bytes]

Verifying checksum... OK (0x13F0)
5996844 bytes copied in 67.708 secs (89505 bytes/sec)
3600#

Use the dir slotl: command to check whether the image has been copied to slotl. Below, you can see that the
new image €3640—i—mz.122—7b.bin has been copied on the PCMCIA slotl:

3600#dir slotl:
Directory of slotl:/

2 -rw- 37 1. 2

Cisco — Software Installation and Upgrade Procedure









Verify that the version 12.2(7b) is ¢

€ ated Information

e How to Choose a Cisco IOS Software Release
re

e PCMCIA Flash Compatibility Matrix and Filesystem Information
e Field Notice: Cisco IOS TFTP Client Cannot Transfer Files Larger than 16MB in Size

¢ Technical Support — Cisco Systems

All contents are Copyright © 1992-2003 Cisco Systems, Inc. All rights reserved. Important Notices and Privacy Statement.
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The metric value specified in the redistribute command supersedes the metric value specified using
the default-metric command

Default redistribution of IGPs or EGP into BGP is not allowed unless the default-information originate
router configuration command is specified.

Examples The following example causes OSPF routes to be redistributed into a BGP domain:

router bgp 109
redistribute ospf

The following example causes Interior Gateway Routing Protocol (IGRP) routes to be redistributed into
an OSPF domain:

router ospf 110
redistribute igrp

The following example causes the specified IGRP process routes to be redistributed into an OSPF
domain. The IGRP-derived metric will be remapped to 100 and RIP routes to 200.

router ospf 109
redistribute igrp 108 metric 100 subnets
redistribute rip metric 200 subnets

The following example configures BGP routes to be redistributed into IS-IS. The link-state cost is
specified as 5, and the metric type will be set to external, indicating that it has lower priority than internal
“ics.

router isis
redistribute bgp 120 metric 5 metric-type external

In the following example, network 172.16.0.0 will appear as an external link-state advertisement (LSA)
in € “7F 1 with a cost of 100 (the cost is preserved):

interface ethernet 0

ip address 172.16.0.1 255.0.0.0

ip ospf cost 100

interface ethernet 1

ip address 10.0.0.1 255.0.0.0

!
router ospf 1

network 10.0.0.0 0.255.255.255 area 0
redistribute ospf 2 subnet
router ospf 2

network 172.16.0.0 0.255.255.255 area 0

Related Commands  Command Description
address-family ipv4 (BGP) Places the router in address family configuration moae for
configuring routing sessions such as BGP, RIP, or static
routing sessions that use standard IPv4 address prefixes.

address-family vpnv4 Places the router in address family configuration mode for
configuring routing sessions such as BGP, RIP, or static
routing sessions that use standard VPNv4 address prefixes.

Cisco 10S IP Command Reference, Volu
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1 distribute (Ilov oo t0 ot )

To redistribute routes from an International Organization for Standardization (ISO) Intermediate
System-to-Intermediate System (IS-IS) routing process into a Border Gateway Protocol (BGP)
autonomous system, use the redistribute command in router configuration mode. To remove the
redistribute command from the configuration file and restore the system to its default condition where
the software does not redistribute routes, use the no form of this command.

redistribute protocol [process-id] [route-type] [route-map map-tag]

no redistribute protoco! [process-id] [route-type] [route-map map-tag|

Syntax De  iption

Defaults

protocol Source protocol from which routes are being redistributed. It can be
one of the following keywords: isis or static.

The isis keyword is used to redistribute dynamic routes.

The static kevword is used to redistribute static routes.

process-id \wopuunary wuwn IS-IS is used as a source protocol, this argument
defines a meaningful name for a routing process. The process-id
argument identifies from which IS-IS routing process routes will be

redistributed.

Routes can be redistributed only from IS-IS routing processes that
involve Level 2 routes, including IS-IS Level 1-2 and Level 2 routing
processes.

The process-id argument is not used when the protocol keyword is
static.

(Optional) The type of route to be redistributed. It can be one of the
following keywords: elns or ip. The default is ip.

route-type

The clns keyword is used to redistribute Connectionless Network
Service (CLNS) routes with network service access point (NSAP)
addresses into BGP.

The ip keyword is used to redistribute IS-IS routes with IP addresses
into BGP.

route-map map-tag (Optional) Identifier of a conugured route map. The route map should
be examined to filter the importation of routes from this source
routing protocol to BGP. If no route map is specified, all routes are
redistributed. If the keyword is specified, but no route map tags are
listed, no routes will be imported.

Route redistribution is disabled.

protocol: No source protocol is defined.

route-type: ip

route-map map-tag: If the route-map argument is not entered, all routes are red
map-tag value is entered, no routes are imported.

Cisco I0S IP Command Reference, Volume 2 of 4: Routing




























































































































938

lo the route map named marks all pathsor” ~  ~ from au
0 metric  tribute of 127 cond nitc s zd so th
matching autonomous system path list 1 will still be sent to neighbor 1.1.1.1.

router bgp 100

neighbor 1.1.1.1 route-map freddy out
!

ip as-path access-list 1 permit ~690_
ip as-path access-list 2 permit .*

!

route-map freddy permit 10

match as-path 1

set metric 127

]

route y freddy permit 20

match as-path 2

The following example shows how you can use route maps to modify redistributed information from the
IP forwarding table:

router bgp 100

redistribute igrp 109 route-map igrp2bgp

1
route-map igrp2bgp

match ip address 1

set local-preference 25

set metric 127

set weight 30000

set next-hop 192.92.68.24

set origin igp

1
access-1list 1 permit 131.108.0.0 0.0.255.255
access-list 1 ) it 160.89.0.0 0.0.255.255
access-list 1 permit 198.112.0.0 0.0.127.255

It is proper behavior to not accept any autonomous system path not matching the match clause of the
route map. This behavior means that you will not set the metric and the Cisco IOS software will not
accept the route. However, you can configure the software to accept autonomous system paths not
matched in the match clause of the route-map router configuration command by using multiple maps
of the same name, some without accompanying set commands.

route-map fnord permit 10
match as-path 1

set local-preference 5

1

route-map fnord permit 20
match as-path 2

The following example shows how you can use route maps in a reverse operation to set the route tag (as
defined by the BGP/OSPF interaction document, RFC 1403) when exporting routes from BGP into the

main [P routing table:

router bgp 100
table-map set_ospf_tag
1
route-map set_ospf_tag
match as-path 1
set automatic-tag
!

ip as-path access-list 1 permit

Ci:
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Added or . aleted Prefix List w.itries . xamples

You can add or delete individual entries in a prefix list if a prefix list has the following initial
configuration:

ip prefix-1 0.0.0.0/0 1le 7

ip prefix-list abc deny 0.0.0.0/0 ge 25

ip prefix-1list abc permit 35.0.0.0/8
ip prefix-list abc permit 204.70.0.0/15

The following example shows how to delete an entry from the prefix list so that 204.70.0.0 is not
permitted, and add a new entry that permits 198.0.0.0/8:

no ip prefix-list abc permit 204.70.0.0/15
ip prefix-1 . abc | nit 198.0.0.0/8

The new configuration is as follows:

ip prefix-list abc deny 0.0.0.0/0 1le 7
ip prefix-list abc deny 0.0.0.0/0 ge 25
ip prefix-list abc permit 35.0.0.0/8
ip prefix-list abc permit 198.0.0.0/8

BGP Soft Reset Examples

The following examples show two ways to reset the connection for BGP peer 131.108.1.1.

Dynamic Inbound Soft Reset Example

The following examples shows the clear ip bgp 131.108.1.1 soft in EXEC command used to initiate a
dynamic soft reco ration in the BGP peer 131.108.1.1. This command requires that the peer support
the route refresh capability.

clear ip bgp 131.108.1.1 soft in

Inbound Soft Reset Using Stored Information Example

The following ex s how ble inbound soft reconfiguration for the neighbor 131.108.1.1.
All the updates received from this neighbor will be stored unmodified, regardless of the inbound policy.
When inbound soft reconfiguration is performed later, the stored information will be used to generate a

new set of inbound updates.
router bgp 100

neighbor 131.108.1.1 remote-as 200
neighbor 131.108.1.1 soft-reconfiguration inbound

The following example clears the session with the neighbor 131.108.1.1.

clear ip bgp 131.108.1.1 soft in

Cisco 10S IP Configuration Guide
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TC [ D5 Authenticationfor GP xam~ |

The following example specifies that the router and its BGP peer at 145.2.2.2 invoke MD5 authentication
on the TCP connection between them:

router bgp 109
neighbor 145.2.2.2 password v6lnelgkel33&
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IP Telephony Phased Migration

The Cisco 2600/3600/3700 Voice Gateway Router enables users to immediately deploy an end-to-end IP telephony
network architecture or gradually shift voice traffic from traditional circuit-switched networks to a single
infrastructure carrying data, voice, and video over packet networks. Initially, customers can use the Cisco 2600/3600/
3700 Voice Gateway Routers to interconnect legacy PBXs over the packet infrastructure and still maintain PSTN
(off-net) connectivity via their circuit-switched PBXs. Later, customers can migrate PSTN (off-net) connectivity to
the Voice Gateway Routers and start to incorporate IP phones at larger sites (Figure 1). After all sites are running IP
telephony, users can begin deploying IP-based applications such as IP unified messaging, personal assistants, and
extension mobility. The Cisco 2600/3600/3700 Voice Gateway Router is an ideal solution for circuit-switched PBX
and PSTN access within a Cisco CallManager IP telephony architecture.

Figure 1
IP Telephony Phased Migration—Migrate Circuit-Switched PSTN and PBX Connectivity to Voice Gateway Routers
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As companies seek to deploy IP telephony solutions across the entire enterprise—converging voice, video, and data
across potentially thousands of sites—they require a feature-rich IP telephony solution that offers simple
administration, virtually unlimited scalability and high availability. The Cisco 2600/3600/3700 MGCP Voice
Gateway Routers work in concert with the Cisco CallManager, deployed in either a distributed or centralized

call-processing model, to provide the IP telephony solutions that enterprises require.

Cisco Systems, inc.
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Before WOI'K"Ig on equUIPpmMENt INAt IS CUNnecleu w puwer nnedy, icimvve joWeIry (inciuaing rings,
necklaces, and watches). Metal objects will heat up when connected to power and ground and
can cause serious burns or weld the metal object to the terminals. To see transiations of the
warnings that appear in this publication, refer to the Regulatory Compliance and Safety
Information document that accompanied this device.

=

Follow these guidelines when working on equipment powered by electricity:

+ Locate the room’s emergency power-off switch. Then, if an electrical accident occurs, you can
quickly shut the power off.

» Before working on the system, turn off the power and unplug the power cord.
» Disconnect all power before doing the following:

= Working on or near power supplies

- Installing or removing a router chassis or network processor module

= Performing most hardware upgrades
+ Do not work alone if potentially hazardous conditions exist.

» Look carefully for possible hazards in your work area, such as moist floors, ungrounded power
extension cables, and missing safety grounds.

« Never assume that power is disconnected from a circuit. Always ch
+ If an electrical accident occurs, proceed as follows:

- Use caution, and do not become a victim yourself.

= Turn off power to the system.

- If possible, send another person to get medical aid. Otherwise, determine the condition of the
victim and then call for help.

= De line if the person needs rescue breathing or external cardiac compressions; then take
appropriate action.

. Preventing E :trostatic Discharge Dan je

Electrostatic discharge (ESD) can damage equipment and impair electrical circuitry. It occurs when
electronic printed circuit cards are improperly handled and can result in complete or intermittent
failures. Always follow ESD prevention procedures when removing and replacing cards. Ensure that the
router chassis is electrically connected to earth ground. Wear an ESD-preventive wrist strap, ensuring
that it makes good skin contact. Connect the clip to an unpainted surface of the chassis frame to safely
channel unwanted ESD voltages to ground. To properly guard against ESD damage and shocks, the wrist
strap and cord must operate effectively. If no wrist strap is available, ground yourself by touching the
metal part of the chassis.

A

Caution  For safety, periodically check the resistance value of the antistatic strap, which should be between 1
and 10 megohms (Mohms).

Installing AC Pow¢
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Before calling, please check with your network operations center to determine the level of Cisco support
services ¥ com y is entitled; for e: “:, SMARTnet, SMA____et Onsite, or Network

Supportea Accounts (NSA). In addition, please havc available your service agreementt =~ and r
product serial number.

Installing AC Power Supplies in Cisc:
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Preparing ol stall 2R uter

This chapter describes site requirements and equipment needed to install your Cisco 3700 series router.
It includes the following sections:

Safety Recommendations, page 2-1

General Site Requirements, page 2-3

Int  lat  Checklist, pa; -5

Creating a Site Log, page 2-6

Inspecting the Rou  page 2-6

Requi Tool: 1 Equipment for Installation and Maintenancce, page 2-7
Console and Auxiliary Port Considerations, page 2-8

Preparing to Connect to a Network, page 2-9

After you have completed this chapter, proceed to Chapter 3, “Iustalling the Router” for installation
instructions.

'ecommendations

Follow these guidelines to ensure general safety:

Keep the chassis area clear and dust-free during and after installation.
If you remove the chassis cover, put it in slace.
Keep tools and chassis components away from walk areas.

Do not wear loose clothing that could get caught in the chassis. Fasten your tie or scarf and roll up
your sleeves.

Wear safety glasses when working under conditions that might be hazardous to your eyes.

Do not perform any action that creates a hazard to people or makes the equipment unsafe.
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Cisco 3700 series routers can be placed on a desktop or installed in a rack. The location of your router
and the layout of your equipment rack or wiring room are extremely important considerations for proper
operation. Equipment placed too close together, inadequate ventilation, and inaccessible panels can
cau nalfunctions and shutdowns, and can make maintenance difficult. Plan for access to both front and
rear panels of the router.

When planning your site layout and equipment locations, remember the precautions described in the next
section “Site Configuration” to help avoid equipment failures and reduce the possibility of

in :ntally caused shutdowns. If you are currently experiencing shutdowns or an unusually h

number of errors with your existing equipment, these precautions may help you isolate the cause of the
failures and prevent future problems.

- Site Configuration

The following precautions will help you plan an acceptable operating environment for your router and
will help you avoid environmentally caused equipment failures:

Ensure that the room where your router operates has adequate circulation. Electrical equipment
generates heat. Without adequate circulation, ambient air temperature may not cool equipment to
acceptable operating temperatures.

Always follow ESD-prevention procedures described in the “Preventing Electrostatic Discharge
image” section on page 2-2 to avoidd  1ge to equipment. Damage from static discharge can
cause immediate or intermittent equipment failure.

Engnre that the chassis cover or mainboard tray and module rear panels are secure. All empty

net lle slots, interface card slots, and power supply bays must have filler panels installed.
The chassis is designed to allow cooling air to flow within it, through specially designed cooling
slots. A chassis with uncovered openings will create air leaks, which may interrupt and reduce the
flow of air across internal components.

Equipmer Racks

Cza

Cisco 3700 series routers include brackets for use with a 19-inch rack or, if specified in your order,
optional larger brackets for use with a 23-inch rack.

The following information will help you plan your equipment rack configuration:

Allow clearance around the rack for maintenance.

Enclosed racks must have adequate ventilation. Ensure that the rack is not congested, because each
router generates heat. An enclosed rack should have louvered sides and a fan to provide cooling air.
Heat generated by equipment near the bottom of the rack can be drawn upward into the intake ports
of the equipment above.

When mounting a chassis in an open rack, ensure that the rack frame does not block the intake ports
or exhaust ports. If the chassis is installed on slides, check the position of the chassis when it is
seated into the rack.

Baffles can help to isolate exhaust air from intake air, which also helps to draw cooling air through
the chassis. The best placement of the baffles depends on the airflow patterns in the rack, which can
be found by experimenting with different configurations.

jeries iware Installation Guide
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! tand Port Numbering

The Cisco 2600 series router chassis contains one slot in which you can install a
network module. This slot is always numbered 1. Both WAN interface card slots
built into the chassis, W0 and W1, are always numbered slot 0.

Port numbers identify the interfaces on the modules and WAN interface cards
installed in the router. Port numbers begin at 0 for each slot, and continue from
right to left and (if necessary) from bottom to top. Modules and WAN interface
cards are identified by interface type, slot number, a forward slash (/), and the port
number, for example Ethernet 0/0.

Figure 1-1 shows a router with a 2E 2-slot module in slot 1. . .;0 serial WAN
interface cards are installed in the module.

Figure 1-1  Cisco 2600 and 2600XM Senries Port Numbers

Serial /1 Serial /0

1 1 ]
Serial 172 Serial 1/0 Eth(%"et Auxiliz:ry
Ethemet 0/1 po
Console
port

. .gure 1-1 shows the following interface numbers:

« First Ethernet interface—Ethernet 0/0

~

Note Cisco 2600XM series routers substitute Fast Ethernet interfaces for
the Ethernet interfaces used in Cisco 2600 series routers. For more
information about interfaces available on your chassis, refer to the
Cisco 2600 Series Hardware Installation Guide.

Cisco Network Module Hardware Installation Guide
I.> ni_2aas.0p |
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Each network interface on a Cisco 3600 series router is identified by a slot number

and a port number.

Numbering

A Cisco 3600 series router chassis contains two, four, or six slots in which you
can install modules. You can install any module into any available slot in the

chassis.

For the Cisco 3620 router, shown in Figure 1-2, the slots are n

“ered as follows:

< Slot 0 is at the bottom right (as viewed from the rear of the chassis), near the

power supply.
« Slot 1 is at the bottom left.

The Cisco 3640 router, shown in Figure 1-3, has the following additional slots:

+ Slot 2 is at the top right, above slot 0.
» Slot 3 is at the top left, above slot 1.

The Cisco. ) router, shown in Figure 1-4, uses a different numbering system:

« Slot 0 contains fixed Fast Ethernet] 3 and is located at t]
chassis.

>f the

+ Slot 1 is at the bottom right (as viewed from the rear of the chassis), near the

power supply.
» Slot 2 is at the bottom left.
< Slot 3 is at the right, above slot 1.
= Slot 4 is at the left, above slot 2.
- Slot 5 is at the right, above slot 3.
« Slot 6 is at the left, above slot 4.

| Cisco Network Module Hardware Installation Guide

OL-2485-08 |
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« Slot 1, Ethernet interface 1—Ethernet 1/1
= Slot 1, serial interface ! 1/0

« Slot 1, BRI interface 0—BRI 1/0

The 2-Ethernet 2-slot module described in this example provides both an

attachment unit interface (AUI) and a 10BASE-T connector for port 0. Only
one of these connectors can be used at a time.

Voice Interface Numbering in Cisco 3600 Series Routers

2-WAN

Voice interfaces are numbered d....rently from WAN interfaces. Voice interfaces
are numbered as follows:
interface-type chassis-slot/voice module slot/voice port
If you have a 4-channel voice network module installed in slot 1 of your router,
the voice interfaces are:

= Slot 1, voice network module slot 0, voice port | Joice 1/0/0 (closest to

chassis slot 0)
« Slot 1, voice network dule slot 0, voice port 1—Voice 1/0/1
« Slot 1, voice network module slot 1, voice port 0—" "¢ 1/1/0

e Slot 1, voice network module slot 1, voice port 1—Voice 1/1/1 (farthest from
chassis slot 0)

(_dM_wv kN lule

The 2-WAN interface card (WIC) network module, Cisco part number NM-2W,
provides two slots for optional WAN interface cards (see Figure 1-7). These
modules have no network connectors. WAN interface cards installed in the
network module provide the connection to the network. WAN interface cards are
described in the Cisco Interface Cards Installation Guide.

Cisco Network Module Hardware Installation Guide
| m. 0l .2485-08 |
























C 'L/AC

£ AO
) 050/2003

l LO_A_AODE
. EQUIPAMT™N.OS |
| DE INFORMATICA
| INCLUINDO

ASSISTENCIA
II TECNICA E

| TREINAMENTO
y
i C A
TECNOLOGIA -
MANUAL

! VOLUME 13

2003
PASTA 41






















Compaq HP , 72.8 GB (286714-B22) Hard Drive Specs - DealTime Pagina 2 de 2
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Discount Compaq Solutions
Same Adav chipments, 286713-B22 memory, cpu, drives, servers & more

www.C Isu tgroup.com

Hot Swap/Plug Specialists
Hot Plug Hot Swap Disk Drives for HP Proliant and Netservers

www.ed4ServicesInc.com

Caompaq Parts
For old and new Proliant Servers and storage contact us for any part

www.us2lcomputers.com

S

http://sudhian.dealtime.com/xPF-Compaq HP_72_8 GB 286714 ~72 19/07/03
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http://www.google.com.br/search?q=cache:e WF3JLuKd9cJ:www.blackbox.com/faxbac...

Also available for you are:
UPDATED FAXBACKS  ,request 18021 . The newest information about our products.

UPDATED MANUALS  ,request 18014 . The newest information for our products.
PRICE CHANGES ,request 17989 . Our competitive prices  t fit your bu’™ t.
OLDL_._ __JDUCTS ,request 18007 . Discontinued products and recommenaed replacements.

FREE Expert Technical Support-24 Hours a Day!

Our expert staff is available with the  wers you need, around the cloc!
Call 724-746-5500 to speak with a Technician.
Or faxy rquestions to 1-800-321-0746.

Fast, Reliable Delivery!
Next-day, second-day, or ground freight « iverya lable.
Black Box can even arrange same-day delivery.
Just call Customer Service, 877-877-BBOX (2269) , to select th
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hp CRT monitor s7500 - North America/U.S. QuickSpecs Pagina 2de 2~

Approvals/
Certifications

A F o
Speed
Power Supply

Maximum Power Rating
Low Power Sleep Mode
Signal Cable

Din isions (H x Wx D)

Weight

Operating Temperature
(non-condt  ing)

~perati  Humidity
non-conuensing)

Compatibility
Warranty

%%

o
Degauss Yes WD b
Factorv Yes \}
..=se...zcall s .
it_splay Yes

UL _J5A..JL Approval Yes

1809241-3, -7, -8 VDT Yes
Guidelines Approval

MPR-If Compliant Yes, select models
TCO “99 Yi actn e
FCC Approval Yes

Microsoft WHQL Yes

Certified

Energy Star Compliant Yes

CE Yes

110 MHz

Universal; 100 to 240V, 50 + 3Hz and 60 * 3Hz

= 100 watts

< 5 watts

15-pin miniature D-sub, attached, 4.9 feet (1.5 meters)

Unpacked 17x16.6 x17.5in (43.2 x 41 x44.5 cm)
Packaged 18.9x20.3x22.1in (48 x51.6 x 56.1 cm)
Unpacked 38 1b (17.23 kg)

Packaged 46.2 Ib (20.9 kg)

50° to 95° F (10° to 35° C)
20% to 80%

Compaq Evo PCs and Thin Clients and Compaq D315 Business PC

Limited three-year parts and repair labor, one-year Service Provider
labor and one-year on-site service warranty. 48 hour advanced
exchange service available during warranty period. Certain restrictions
and exclusions apply. For details, contact HP Customer Support.

©2003 Hewlett-Packard Development Company, L.P. The information in this document is subject
to change without notice and is provided "as is" without warranty of any kind. The warranties for
HP products are set forth in the express limited warranty statements accompanying such
products. Nothing herein should be construed as constituting an additional warranty. HP shail not
be liable for technical or editorial errors or omissions contained herein.

DA-11017 - U.S. - Version 2 - May 1, 2003

http://h18004.www1.hp.com/products/quickspecs/11017_na/11017_na. HTML 21/07/03
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PRO 399, __)J3
SISTAB NO BREAKS
15 ANOS
CONDICIONANDO
ENERGIA
1988 - 2003
A

COBRA ‘EM£ A
Estrada dos Bandeirantes, 7966 - Jacarepagua
..ode mnei -RJI

TRAN! )RMADOR ISOLADOR COM CAIXA - 14 unidades
Modelo: ..afo Isolador L.OJ W ¢ caixa
Poténcia de Utilizagdo: 600 W
Configuragdo: Monofasica
Tet 1 de Entrada: 110 V
) de Saida : 220 V

Freqiiéncia: 60 Hz

A Ul com
O PROGRAMA DE
REC )
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HARDWARE ADICIO AL

>w=~VIDOR

MONITC ¢ D DE EDE

NOTEBOOKS

COBRA Tecnologia S.*
Estrada dos Bandeirantes '
CEP 22783-110 Rio de Janeiro RJ









NOTE: Please see the following URL for additional information regarding USB support:

Interfc s
Pointing Device (Mouse) 1
Graphics 1
Keyboard 1
External | (VHDCI) 1
Network RJ-45 3 (1 forilQ)
USB 2
hitp:/www.compag.com/products/servers/plattorms/usb-support.himl
NOTE: This Web site is available in English only.
Graphics Integrated ATI Rage XL Video Controller with 8-MB SDRAM Video Memory

.orm Factor

Rack (2U), (3.5-inch)
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® Prolia
[
Standard ' “ures

HP Factory Express gives you the flexibility to choose from a full menu of factory capabilities all in one manufacturing
facility, in one process, with one touch giving you full control and access to HP's World closs manufacturing facility
anytime. This approach provides you the speed to deploy your IT needs, with total quality assurance, reliability, and
predictability to lower your total cost of ownership by letting HP install, rack, and customize your software and hardware

HP Factory E ess
Capabilities

options for you.
NOTE: Factory Express Engineered Solution Level 6 is a custom solutions available through Foctory Express. Please

contact a your local reseller or Account Manager.

HP Services provides a three-year, limited warranty, including Pre-Failure Warranty (coverage of hard drives, memory and
processors) fully supported by a worldwide network of resellers and service providers. HP technical assistance is ovailable
7x24, toll free in the United States and Canada. Telephone support services may be covered under warranty or available for

Service and Support

an additional fee.
NOTE: Limited Warranty includes 3 year Parts, 3 year Labor, 3-year on-site support.
A full range of Care Pack packaged hardware and software services:

® (nstallation and start up

® Extended coverage hours and enhanced response fimes
@ Systen management and performance services

® Availability and recovery services

NOTE: For more information, customer/resellers can contact: hitp://www.hp.com/services/carepack

Please see the following URL regarding Warranty Information For Your HP Products:
hitp://www.compag.com/support/warranty_upgrodes/web_stotements/176738.hml.

For additional information regarding Worldwide Limited Warranty and Technical Support, please see the following URL:
ttp://#tp.compeq.com/pub/supporinformation/ejourney/ 1 76738 pdl.

NOTE: T Neb sites woilable in English only.

NQOTE: Cerlain restrictions and exclusions apply. Consult the HP Customer Support Center at

1-800-345-1518 for details

(ﬁ] DA- 11473  Worldwide — Versian 23 — July 14, 2003 Pcyz/7
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Options

Memory 512MB of Advanced ECC PC2100 DDR SDRAM DIMM Memory Kit (2 x 256 MB) 300678-B21
1024MB of Advanced ECC PC2100 DDR SDRAM DIMM Memory Kit (2 x 512 MB) 300679-B21
2048-MB of Advanced ECC PC2100 DDR SDRAM DIMM Memory Kit (2x1024 MB) 300680-B21
4096MB of Advanced ECC PC2100 DDR SDRAM DIMM Memory Kit (2x 2048 MB) 300682-B21
NOTE: The 4096MB of Advanced ECC PC2100 DDR Memory kit (300682-B21) can only be used in
3.06GHz and faster models.

Optical Drives Slimline DVD-ROM (8x24x) Option Kit {Servers) 264007-B21
Slimline CD-RW/DVD-ROM Combo Option Kit 331903-B21

Hard Drives Ultra 320 SCSI — Universal Hot Plug
36.4GB 10,000 rpm, U320 Universal Hard Drive, 1" 286713-B22
72.8GB 10,000 rpm, U320 Universal Hard Drive, 1" 286714-B22
146.8GB 10,000 rpm, U320 Universal Hard Drive, 1" 286716-B22
18.2GB 15,000 rpm, U320 Universal Hard Drive, 1" 286775-B22
36.4GB 15,000 rpm, U320 Universal Hard Drive, 1* 286776-B22

286778-822

72.8GB 15,000 rpm, U320 Universal Hard Drive, 1"

NOTE: All U320 Universal Hord Drives are backward compatible to U2 or U3 speeds. U320 drives
require an optional U320 Smart Array Controller or U320 SCSI HBA to support U320 transfer rates.

NOTE: Please see th  ird Drive QuickSpecs for Technical Specifications such as capacity, height,
width, interface, transfer rate, seek time, physical configuration, and operatingte  rature:

U320 Hard Drive QiS:

L/t owB compag.com/products/quickspecs/11537_div/11531_div.HTML (Worldwide)

e fen it tniebeanre UTRRT wn/TTAAT na.HTML (North Americo)

w’
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wptions
MSA1000 MSA1000 201723-B22
MSA1000 Controller 218231-B22
MSA Fibre Channel I/O Module 218960-B21
MSA1000 Fabric Switch 218232-B21
MSA1000 Fibre Channel Adapter (FCA) 2101 245299-821
HP StorageWorks msa hub 2/3 286763-B21
NOTE: Please see the StorageWorks by Compaq Modular SAN Array 1000 QuickSpecs for
additional options ond configuration information at:
hitp:/fwww. compog.com/products/quickspecs/ 11033 na/1 1033 na HTML (North America)
hitp:/ fwvee5.compag.com/producis/quickspecs/ 11033 div/11033_ div.HTML (Worldwide)
Network Storage Router M2402 2FCX 4SCSI LVD Network Storage Router 262653-B21
M2402 2FCX 4SCSI HVD Network Storage Router 262654-B21
M2402 4 channel LVD SCSI Module 262659-B21
M2402 4 chonnel HVD SCSI Module 262660-821
M2402 2 channel FC Madule 262661-821
MSL5000 Embedded Router Fibre Option Kit - Grophite 262672-821
MSL5026 Embedded Router Fibre Option Kit - Opal 286694-B21
StorageWorks Modular EMA12000 D14 60Hz 17 -B21
Array 8000/Enterprise EMA12000 D14 50H: 175990-B22
Modular Array 12000 EMA12000 S14 60Hz 175991-821
EMA12000 S14 50Hz 175991-B22
MAB000 60Hz 175992-B21
MA80Q0 50Hz 175992-822
EMA12000 Blue 60Hz 175993-B21
EMAT2000 Blue 50Hz 175993-B22
NOTE: Options include controller, solution kits, ACS. MABOOO/EMA12000 includes controller shelf,
drive shelves and cobinel. Pockaging upgrade to RABO00/ESA12000.
NOTE: Please see the StorageWorks MABOOO/EMA12000 QuickSpecs for FC Hubs, FC switches,
platform software, host adopters, disks and options for complete solutions at:
hitp:/fwwwi.compaq.com/products/quickspecs/ 1774 1a/1C7 7 HTML {North America)
hiip://www5.compag.com/producis/quickspecs/' v m,'dn 10wy HTML (Worldwide)
StorageWorks EMA16000 D14 50Hz (opal) 238792-B22
Enterprise Modular EMA16000 D14 60Hz (opal) 238792-B21
Array 16000 FC EMA16000 S14 50Hz (opal) 238791-822
238791-B21

EMA16000 S14 60Hz (opal)

NOTE: Models include: Dual HSG80 controllers in each Model 2200 enclosure (2 pairs per single
bus configuration, 4 pairs per dual bus configuration) with 1GB cache per controller pair, and 12 14-
bay drive enclosures with redundant power supplies. Configure-to-Order (CTO) builds are available.
Options include ACS, plotform kits and software by HP.

NOTE: Pleose see the StorogeWorks EMA16000 QuickSpecs for FC swilches, platform software, host
odop‘rers, disks and options for complete solutions at:

bitpe/fwww S compad.comdproducts/quick /10812 ne/10812 na HTML (North America)
hitp:/ AwawS . compag.com/products/quicks

/10812 div/10812_div.HTML (Worldwidel
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HP . oliant . .3& - cneration o (33)
| | | |
Options
USB Easy / ss Keyboard Dash # Description Dash # Description
(Carbonite) Country Key  aopm ICELAND ABT HE
Code
ABO TAWA ABU UK
AB1 KOR ABV ARA
AB2 PRC ABX FIN
AB6 FRA ABY DEN
AB7 GRK ABZ ITL
AB8 TURK ACO BEL
AB? PORT AC4 BRZ
ABA us ACB RUSS
ABB EURO AKB CZE
ABC FCAN AKC HUNG
ABD GR AKD POL
ABE SP AKL Al
ABF AKN BHCSY
ABH NL AKR SLOV
ABJ Japan ARK ICELAND
ABM LA B15 KAZ
ABN NOR uuz SWISS
ABS SW
Rack Builder Please see the Rack Builder for configuratian assistance at hifp:/Awww.compag.com/rackbuiider/

(F] DA-11473  Worldwide — Version 23 luly 14, 2003 Pog%
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Options

7000, 2000 and 10000

Series

Ballast Option Kit

Rack Rail Adapter Kit (25" depth)

100 kg Sliding Shelf

Monitor/Utility Shelf - Graphite

Depth Adjustoble Fixed Roil

Cable Management D-Rings Kit

Console Management Controller (CMC) Option Kit
Console Manogement Controller (CMC) Sensors Option Kit
Console Management Controller (CMC] Locking Option Kit
Console Management Controller (CMC) Smoke Sensors Option Kit
Server Console Switch 1 x 2 port {100-230 VAC)

Server Console Switch 1 x 2 port (100-230 VAC) (Int'l)
Server Console Switch 1 x 2 port (100-230 VAC) (lapan)
Server Console Switch 1 x 4 port (100-230 VAC)

Server Console Switch 1 x 4 port (100-230 VAC) {Int'l)
Server Console Switch 1 x 4 port {(100-230 VAC) (Jopon)
Server Console Switch 1 x 8 port {100-230 VAC)

Server Console Switch 1 x 8 port (100-230 VAC) (Int'l)
Server Console Switch 1 x 8 port (100-230 VAC) (Japan)
Server Console Switch 2 x 8 port (100-230 VAC)

Server Console Switch 2 x 8 port (100-230 VAC]) (Int'l)
Server Console Switch 2 x 8 port {100-230 VAC) {Japan)
Server Console Switch 2 x 8 port (48VDC)

IP Console Switch Box, 1x1x16

IP Console Switch Box, 3x1x16

IP Console Interface Adapter, 8 pack

| nsole Interface Adapter, T pack

iPC xpansion Module

KVM 9 PIN Adapter {4 Pack)

CPU to Server Console Cable, 12°

CPU to Server Console Cable, 20’

CPU to Server Console Cable, 40’

CPU to Server Console Cable, 3

CPU to Server Console Cable, 7’

CPU ta Server Console Cable (Plenum Rated) 20’

CPU to Server Console Cable (Plenum Rated) 40°

IP CATS Cable 37, 4 pack

IP CAT5 Cable ', 8 pock

IP CAT5 Cable 12, 8 pack

1P CAT5 Cable 20, 4 pack

IP CAT5 Caoble 40’, 1 pack

Switch Box Connector Kit (115V)

Switch Box Connector Kit (230V)

Switch Box Connector Kit (high voltage) (Intl)

TFT5600 Rack Keyboard Monitor

Country Code Key (for TFT5600 RKM Rack Keyboard Monitor (PN 22154

Q]
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120672-B21
120675-821
234672-B21
253449-21
332558-821
168233-821
203039-821
203039-822
203039-B23
203039-B24
17 6-001
120206-B31
120206-291
400336-001
400336-B31
400336-291
400337-001
400337-B31
400337-291
400338-001
400338831
400338-291
400542-B21
262585-B21
262586-B21
262587-821
262588-B21
262589-821
149361-B21
110936-B21
110936-822
110936-823
110936-B24
110936-B25
149363-821
149364-821
263474-821
263474-822
263474-823
263474-B24
263474825
144007-001
144007-002
144007-B33
221546-xx1

b

Jge/SB/

H

.












CuickSpecs

O]

invent

HP Proliant DL380 Gene
] |

Manday - Friday RAM - 5PM ol time, 2-hr response after hours for Windows NT, Windows 2000,
or Advanced Server Operating System, Technical Account Manager, Techr |
ity , v the per year (6-3 Part

nNumper 1or U.J./

24 x 7 HW, 4-hr response, Named HW engineer; 24 x 7 Silver Subsequent System Support for
Windows NT, Windows 2000, Professional, Server or Advanced Server Operating System (6-3 Part

Number for U.S.)

24 x 7 HW, 4-hr response, Named HW engineer; 24 x 7 Silver Software Support, 1-hr response,
Monday - Friday, 8AM - 5PM local time, 2-hr response after hours for Novell NetWare Operating
System, Technical Account Manager, Technical Newsletter, SW activity review (6-3 Part Number for

u.s.)
24 x 7 HW, 4-hr response, Named HW engineer; 24 x 7 Silver Subsequent System Support for Novell

NetWare Operating System (6-3 Part Number for U.S.)
NOTE: For more information, customer/resellers can contact hitp:/7www. hp.com/services/carepock

DA-11473  Worldwide — Version 23 — July 14, 2003

239935-002

239973-002

239975-002
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Ji HP P 153
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Memory
4 automatically configures the last populated back as the spare memory. If only banks A and B are
an i ti red thr RBSU.
Following are memory options available from HP:
® 2048-MB of Advanced ECC PC2100 DDR SDRAM DIMM Memory Kit {2x1024MB) 300680-B21
® 1024-MB of Advanced ECC PC2100 DDR SDRAM DIMM Memory Kit 2 x 512MB) 300679-B21
® 512-MB of Advanced ECC PC2100 DDR SDRAM DIMM Memory Kit (2 x 256MB) 300678-B21
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Rend/Write Capacity
pe ikette
{high/mid/low density)

Drive Supported
Drive Height
Drive Rotation

Transfer Rate

(high/mid/low)
Bytes/Sector

Sectors/Track
(high/mid/low)

Tracks/Side (high/low}

Access Times

Cylinders (high/low)
Read/Write Heads

n

Green

1.44 MB/1.2 MB/720 K8
fe fted

Ore

0.50in (1.27 cm)

300/360/300 rpm
500/500/250 KB/s

512
18/15/9

80/80

Track-to-Track 3/3/6 ms
(highmid//low)

Average

(high/mid/low)
Settling Time
Latency Average

174/94/94 ms

15 ms
100 ms /83.3 ms /100 ms

80/80

Two

(a3
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http://h18000.www1.hp.com/products/quickspecs/11455_na/11455_na.HTML 21/07/03
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Graphics

Display (External)

Display (Internal)

Operating System

Software

System Recovery

Security

http://h18000.www1.hp.com/products/quickspecs/11455 na/11455 na. HTML

. mm e — ~ . _

LA

Port R« or

He hone out
CTF ver

RJ-11 (modem)
RJ-45 (NIC)
Infrared Port

1 (4 Mb/s support)

(IrDA 4 MB compliant. IR performance will
vary depending on performance of IR
peripherals and application used.)

USB Port 2
LED status indicators 6

ATl Radeon IGP 340M Integrated UMA architecture ATI 4X AC 3D
accelerator with 32-MB DDR shared video memory for increased color
depth and graphics performance

Up to 32-bit per pixel color depth

T ppc T 10x 480, 800 x 600, 1024 x 768, 1280 x 1024, 1400 x 1050,
1000 x 1204, or 2048 x 1536 resolutions up to 160-Hz refresh rate,
dependent upon monitor capability, resolution and color depth settings

14.1-inch color TFT XGA with 1024 x 768 resolution (up to 16.7M colors
internal)

15-inch color TFT XGA with 1024 x 768 resolution (up to 16.7M colors
internal)

Microsoft Windows XP Pro, or Microsoft Windows XP Home preinstalled

Diagnostics for Microsoft Windows
DVD Playback Software
~m seurity Man~~~ment
ffety and Comfort Guide
Acrobat Reader
Reference Guide
Compagq Easy Access Button Software

Each unit is shipped with a CD kit for quick recovery (erases hard disk
and restores manufacturer installed image) and software recovery
(installs only selected standard software)

Configuration Control Hardware
Memory Change Alert
Ownership Tag

f
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Release Notes

Release 2 (9.2.0.1.0) for HP 9000 Series | .. UX (64-bit)

June 2002
Part No. A97350-02

ORACLE

Copyright © 2002, Oracle Corporation
All rights reserved.

This document accompanies Oracle9i release 2 (9.2.0.1.0) for HP 9000 Series
HP-UX (64-bit). Its contents supplement or supersede information in the
in.  latii _ ideforthisre se,or ‘heOrac idocum ation library.

Topics:

a  System Requirements
»  Documentation

s Installation Issues

= Product-Related Issues
= Post-Installation Issues

= Known Bugs

“‘/stem Requirements

Except as noted here, system requirements are in the installation _ ide for
this release, and are current as of the release date.

Hard "sk Space Rec ‘rements

The space requirements listed on the Available Products window apply to
installations that include a database. If you  ect the Software ~ 1ly
cor guration type, then you will require 3 GB.

Additional Software Patch Requirements

If you are installing Oracle Real Application Clusters on HP-UX 11.0, and if
you are using the HMP protocol, then you must download the following
patch from HP in addition to the patches listed in the installation guide.

Oracle is a registered trademark, and Oracle7, Oracle8i, Oracle9i, OracleMetalink, Oracle Names, Oracle Transparent
Gateway, PL/SQL, Pro*C, Pro*COBOL, Pro*FORTRAN and SQL*Plus are trademarks or registered trademarks of Oracle
Corporation. Other names may be trademarks of their respective owners.



= PHNE_26551

If you are installing Oracle Real Application Clusters on HP-UX version 11i
(11.11), and if you are using the HMP protocol, then you must download
T satch from HP in addition to thej :hes listed in the

 ide.
. 27114

If you are installing HP-UX version 11{ (11.11), then you must download the
following OS patches:

a  GOLDQPKI11li (includes both GOLDAPPS11i and GOLDBASE11i)
= PHKL 25506
= PHSS_26263
= PHSS_24638

= JDK1.3.1.02

If you are using ServiceGuard OPS Edition version 11.13 for HP-UX 1li, then
you must install the following patch:

« PHSS 26674

Note: In the near future, ServiceGuard OPS Edition will be replaced
with ServiceGuard Extension for RAC.

Updated Requirements
Oracle Corporation updates these release notes online at the following site:

http://docs.oracle.com

If you need assistance with navigating the Oracle documentation site, refer
to the following site:

http://docs.oracle.com/instructions.html

Refer also to the Certify Web Pages on OracleMetaLink, which provide
certified configuration information for Oracle and non-Oracle products. ..

access Certify:
1. Register or log in to OracleMetaLink at the following Web address:

http://metalink.oracle.com

2. Select Product Lifecycle from the OracleMetalink navigation bar.

3. Select Certifications in the Product Lifecycle window navigation bar.



Oracle Universal Installer Version Update

-1 © 7 71.1.0), whict © provided with ) esO ‘e
Universal Installer 2.2.0.12.0. This version number superseaes e version
listed in the installation guide.

wocumentation

Additional product README files are located in their respective product
directories under the SORACLE HOME directory and in the
$ORACLE_HOME/relnotes directory.

Documentation Errata

The following is a list of errors in the documentation for this release.

PL/SQL Gateway

In Appendix A, "Oracle9i Components," in Oracle9i Installation Guide Release
2 (9.2.0.1.0) for UNIX Systems, PL/SQL Gateway is listed as a supported
product. It has been desupported for this release.

Pre-Installation Requirements

Under "Random Access Memory" on page 2-3 in Chapter 2,

“Pr nstallation Requirements, in Oracle9i Installation Guide Release 2
(9.2.0.1.0) for UNIX Systems, the Linux and HP commands are reversed. The
correct conr  inds are the following:

Linux

$ grep MemTotal /proc/meminfo
HP

$ /usr/sbin/dmesg | grep "Physical:"

....tallation Issue .

This section provides information about the following topics:
= 32-bit O/S Support
s Multiple CD-ROM Installation

=« runlnstaller Script

= Installing Databases with Database Configuration Assistant

= Database Migration



o
0 =
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= Installing with Response Files

32-bit O/S Support

Do not run Oracle9i on a 32-bit operating system. Oracle9i release 2
(9.2.0.1.0) is offered in a 64-bit version only. If you try to run any 64-bit
executables on a 32-bit operating system, then they will fail. If you run
Oracle9irelease 2 (9.2.0.1.0) on a 32-bit system, then you will see the
following error message:

./oracle: Exec format error. Wrong Architecture.

Multiple CD-ROM Installation

During the installation of Oracle9i release 2 (9.2.0.1.0), you will be
prompted to insert additional CD-ROMs from the set that make up Oracle9i
release 2 (9.2.0.1.0). When prompted to mount the next CD-ROM, use the
following procedure:

1. On the window where you have started the Installer, | Enter to go
to the UNIX prompt, and then change the directory  your system’s
root directory. Log in as the root user by using the tollowing
commands:

§cd/

$ su root

2. Unmount and remove the CD-ROM from the CD-ROM drive with the
following command:

# /usr/sbin/pfs_umount/SD_CDROM

3. Insert the required CD-ROM into the CD-ROM drive and mount it by
using the following command:

# /usr/sbin/pfs mount/SD CDROM

4. Click OK to continue.

runinstaller Script

Because it is necessary to insert and eject more than one CD-ROM during
installation, you must not launch Oracle Universal Installer by running the
runInstaller script from a shell where the current working directory is
the CD-ROM mount point, or by clicking on the script in the File Manager
window. In an X Window environment, it is possible to launch the Installer
this way, but then the installation will fail because you will not be able to
eject a software CD-ROM until you end the installation session.
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Review the following information before runnir  Jatabase Configuration
Assis it

SYS and ‘M Password Change Requirement

If you use Database Configuration Assistant to create a database, be aware
that you will be required to change the SYS and SYSTEM passwords at the
end of the configuration process. This is a new security procedure designed
to protect access to your data.

Database Migration

If you are upgrading from release 8.0.6 to release 9.2.0.1.0 and you have
Oracle interMedia installed on your system, then you cannot use Database
Migration Assistant. You must migrate the database manually. For
information on manual database migration, refer to Oracle9i Database

Migration Release 2 (9.2).

Installing with Response Files

For installation with a response file, the path to the response file must be
the full path on the system. The Oracle Universal Installer does not handle

relative paths properly.

Unzip Utility for Downloading and Installing Oracle Patches

An unzip utility is provided with Oracle9i release 2 (9.2.0.1.0) for
uncompressing  racle patches downloaded from OracleMetaLink. The
utility is locatea 1n the following directory:

$ORACLE_HOME/bin/

Product-Related Issues

This section provides information on the following topics:
« Character Sets

» Demo Schema

« JavaData e ctivity | ser

»  Oracle Advanced Security

»  Oracle Internet Directory (OID)

a  Oracle Real Application Clusters
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Character s

O : NCHAR Datatypes

In Oracle9i release 2 (9.2.0.1.0), the SQL NCHAR datatypes are limited to
the Unicode character set encoding (UTF8 and AL16UTF16). Alternative
character sets such as the fixed-width Asian character set JA16SJISFIXED in
Oracle8i are no longer supported.

To migrate existing NCHAR, NVARCHAR, and NCLOB columns, export
and import NCHAR columns, complete the following steps:

1. Export all SQL NCHAR columns from Oracle8i.
2. Drop the SQL NCHAR columns.
3. Migrate the database to Oracle9i.
4. Import the SQL NCHAR columns in to Oracle9i.

AL24UTFFSS Character Set

Oracle9i release 2 (9.2.0.1.0) does not support the Unicode character set
AL24UTEESS introduced in Oracle?. This character set was based on the
Unicode standard 1.1, which is now obsolete.

Oracle9irelease 2 (9.2.0.1.0) supports the Unicode database character sets
AL32UTF8 and UTFS8. These database charac  sets lude the Uz de
enhancements based on the Unicode standard 3.0.

To migrate the existing ALZ4UTFFSS database, upgrade your database
character set to UTF8 before upgrading to Oracle9i. Oracle Corporation
recommends that you use the Character Set Scanner for data analysis before
attempting to migrate your existing database character set.

Character Set Scanner

Set the LI " IBRARY_PATH variable to include the $ORACL™ "IOME/1lib
directory betore running the Character {  Scanner {(csscan) from the
$ORACLE_HOME directory. If you do not correctly set the
LD_LIBRARY_PATH variable, then the csscan utility will fail.

Demo Schema

If you select a multibyte character set or UTF as the national character set in
Oracle9i release 2 (9.2.0.1.0), then you must recreate the demo schema and

the database installation.
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Open the script
Find SORACLE HOME/jsp/lib/servlet.jar
wurrectittor 1SORACLE ..uME/lib/servlet.jar

Save the script

Error Installing OLAP CWMLITE Tablespace

During installation, if you select Online Analvtic Processing (OLAP)
services, perform multiple installationsont sz system, and create new
databases during these installations, then CWMLite may have an invalid
OLAP CWMLITE tablespace registry. Oracle Corporation has assigned bug
identification number 2359208 to track this problem.

To work around this problem, use the following procedure after you have
completed installation:

1.
2,

Ensure that the database and the listener are running.

Using the following command, start SQL*Plus as the administrative
user SYS:

sqglplus "/ as sysdba"

Using the following command, enable the display of text within the
PL/SQL block:

SQL> set serveroutput 1

Using the following command, verify whether the OLAP CWMLITE
tablespace is valid:

SQL> execute
dbms_output.put_line(sys.dbms_registry.i alid('AMD’));

If the preceding command returns 0, then the OLAP CWMLITE
tablespace is invalid. Go to step 5.

If the precedii :ommand returns 1, then the - _AP CWML.._
tablespace is valid, and no further testing needs to be done.

If the OLAP CWMLITE tablespace is invalid, turn on echoing with the
following command:

SQL> execute cwm2_olap_manager.Set_Echo_on;

Validate the OLAP CMWLITE tablespace with the following command:

SQL> execute cwm2_olap_installer.Validate CWM2_Install;
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INTRODUCTION

Oracle9i Database Release 2 is available in three editions, each suitable for
different development and deployment scenarios. Oracle also offers several
additional optional database products t ance the bilities of Oracle9i
Database for specific application requirements. The following are the three
available editions of Oracle9i Database Release 2:

e  Oracle9i Database Standard Edition delivers unprecedented ease-of-use,
power, and price/performance for workgroup, department-level, and
internet/intranet applications. Oracle9i Database Standard Edition includes
a fully integrated set of easy-to-use management tools, full distributed,
replication, and web features. From single-server environments for small
businesses to highly distributed branch environments, Oracle9; Database
Standard Edition includes all the facilities necessary to build business-
critica _ _lications. (  :1e9i Database Standard lition can only be
licensed on servers that have a maximum capacity of 4 processors.

e Oracle9i Database Enterprise Edition provides efficient, reliable, secure
dat:  nagement for high-end applications such as high volume on-line
transaction processing (OLTP) environments, query-intensive data
warehouses, and demanding Internet applications. Oracle9i Database
Enterprise Edition provides the tools and functionality to meet the
availability and scalability requirements of today’s mission-critical
applications for the enterprise.

e Oracle9i Database Personal Edition supports single user development and
deployment that require full compatibility with Oracle9; Standard Edition
and Oracle9i Enterprise Edition. By bringing the award-winni
functionality of Oracle9i Database to the personal workstation, Oracle
offers a database that combines the power of the world’s most popular
database with the ease of use and simplicity you would expect in a desktop

product.

Oracle9i Personal Edition, Oracle9i Standard Edition and Oracle9i Enterprise
Edition include a common set of application development features including
SQL object-relational capabilities and PL/SQL and Java programmatic
interfaces for writing stored procedures and triggers. Applications written for






view of the data. Ra , hash, composite (range combined with hash), and list
partitioning methods are supported. e -

on = rov

standard encryption and integrity algorithms as well as supporting several
external authentication services. The product provides robus ~ rise U
Security where organizations have a choice of implementing end-to-end
security by authenticating users using digital certificates or passwords, reducing
the total cost of deploying security.

Oracle Label Security

Oracle Label Security provides sophisticated and flexible security based on row
labels for fine-grained access control. Oracle Label Security employs labeling
concepts used by government, defense and commercial organizations to protect
sensitive information and provide data separation and includes a powerful tool
to manage policies, labels, and user label authorizations.

Oracle OLAP

Fully integrated in the database, Oracle OLAP provides a complete set of
analytical functions. Predictive analysis can be used to forecast market trends,
predict product manufacturing requirements, and build enterprise budgeting and
financial analysis systems, for example. Using complex, multidimensional
queri nd calculations, information such as market shares and net present
value can be derived. The Java OLAP API provides «....ient object-orientation
for building applications that require complex analytical queries.

Oracle Data Mining

Oracle Data Mining allows companies to build advanced business intelligence
applications that mine corporate databases, discover new insights, and integrate
that information into business applications. Oracle Data Mini  :mbeds data
mining functionality for making classifications, predictions, and associations.
All model-building and scoring functions are accessible through a Java-based
APL.

Oracle Spatial

Oracle Spatial allows users and application developers to seamlessly integrate
their spatial data into enterprise applications. Oracle Spatial facilitates analysis
based on the spatial relationships of associated data, like the proximity of store
locations to customers within a given distance and sales revenue per territory.
Oracle Spatial manages spatial data in an industry-standard database, resulting
in application integration that takes place at the data server. This enables



Oracle Enterprise Manager Packs

In addition to Oracle Enterprise Manager, Oracle provides an advanced
integrated package of tools for perfc  nce tuning, di: _ Hstics, and change
management:

Oracle Tuning Pack - Oracle Tuning Pack provides database administrators
with expert performance management for the Oracle environment, including
SQL tuning and storage optimization.

Oracle Diagnostics Pack - Oracle Diagnostics Pack enables database
administrators to perform advanced monitoring, diagnosis, and planning for
the Oracle environment.

Oracle Change Manag:  nt Pack - Orac  Change Man~~~n  t Pack
eliminates errors and loss of data when upgrading databases to support new
applications. The pack analyzes the impact and complex dependencies
associated with application change and automatically performs database

upgrades.

Oracle Management Pack for SAP R/3 - Oracle Mar  :ment Pack for SAP
R/3 offers real time monitoring for SAP R/3 systems, capacity planning for
historical analysis and future planning purposes, event integration, and a
single point of administration of the host, database, and application.

Oracle Programmer

Oracle Programmer is a product that provides a rich set of interfaces for
developers who build enterprise applications that access and manipulate
Oracle9i database.

Oracle Programmer is a family of products consisting of:

Three embedded SQL-style interfaces: Precompilers, SQL*Module, and
N |

Four call level interfaces: Oracle Call Interface (OCI), Oracle C++ Call
Interface (OCCI), ODBC, and JDBC

[

Two COM data access interfaces: Oracle Objects for OLE and Oracle
Provider for OLE DB

Microsoft .Net support: Oracle Data Provider for NET (ODP.NET), OLE
DB .NET, and ODBC .NET

Two utilities to generate host-language bindings from database schemas:
Object Type Translator and JPub
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Appendix 34: HP’s Partner Technology Access Center High Availability Implementationand _ _ri  ation
Services Process and Methodology

Implementation and Certification Onsite Process Participants:

Hewlett-Packard: Walt Saiko (Partner Technology Access Center)
JD Edwards: Roger Miller (Server Technology)

OneWorld Xe and MC/ServiceGuard
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Page 8 of 88
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Assign the dynamic IP address of the package.
Edit control.sh file to include dynamic IP address
cmbhaltpkg owpkg
cmrunpkg —v owpkg
cmviewcl —v # Check package has started and dynamic IP
# address is pingable

Enable the OneWorld Xe application to switch to a second node by editing the package control file

edit owpkg.ascii #addNCT™ N "7 v Tl
cmapplyconf —v —C /etc/cmcluster/cmclconfig.ascii —F owpkg.ascu
cmhaltcl —f —v

cmruncl —v

Test package switching to stxhpcl2
cmhaltpkg owpkg # Halt package

cmmodpkg —e owpkg # Enable package switching

cmrunpkg -n stxhpcl2 owpkg

Add in OneWorld Xe startup/shutdown details to package control script (control.sh) and check successful

package activation.
Edit control.sh file to include Oneworld Xe startup/shutdown

cmrunpkg —v owpkg
iev -y # Check package has started on node stxhpcll

# and OneWorld Xe binary is running

Test package switching to stxhpcl2

cmhaltpkg owpkg # Activate owpkg on stxhpcl2
cmmodpkg — owpkg # verify OneWorld Xet r
cmrunpkg —n stxhpcl2 owpkg # Enable package switching

OneWorld Xe and MC/ServiceGuard
November 15,2000
Page 10 of 88
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Mokt A RNl T mto— a5 of OneWorld Xe

Configuring the Cluster

Create the ASCII cluster template file
cmquerycl —v —C /etc/cmcluster/cmclconfig.ascii —n stxhpcll —n stxhpel2

Modify the template (clusterl.ascii) to reflect the environment and to verify the cluster configuration.
cmcheckconf —v —C /etc/cmceluster/cmclconfig.ascii

Create the cluster by applying the configuration file. This will create the binary file “cmclconfig” and
automatically distribute it among the nodes defined in the cluster.
cmapplyconf —v —C /etc/cmcluster/cmclconfig.ascii

Start the cluster and check the cluster status. Test the cluster halt also.
cmruncl —v —n stxhpell —n stxhpel2
cmviewcl —v
cmbhaltcl —f —v
cmruncl —n stxhpcll —n stxhpcl2

Configuring a ServiceGuard Package on Each Node.

Create the package configuration files and tailor to the test envirc  nt. Donot  lude the second node at this

stage.
cd /etc/cmcluster

mkdir owpkgl
cmmakepkg —p owpkg.ascii #Edit o1 | gl.ascii
mkdir owpkg2
cmmakepkg -p owpkg2.ascii # Edit owpkg?2.ascii

Create package control scripts and tailor to the test environment. Do not include application startup/shutdown,
service monitoring, or relocatable IP address at this stage.

cd owpkgl

cmmakepkg —s control.sh

cd ..Jowpkg2
cmmakepkg —s control.sh

Shu - luster, verify and distribute the binary configuration files
altel -f—v
cmapplyconf —v —C /etc/cmceluster/cmclconfig.ascii —P owpkgl.ascii -P owpkg2.ascii

Test cluster and package startup. Unmount all logical volumes on shared volume group and deactivate the
volume groups

cmruncl # Start cluster and packages

cmviewcl ~v # Check that packages have started

Add knowledge of the appropriate Secondary Node to the packages
edit owpkgl .ascii
edit owpkg2.ascii

Shut down cluster, verify and distribute the binary configuration files

cmhaltcl —f —v
cmapplyconf —v —C /etc/cmcluster/cmclconfig.ascii —P owpkgl.ascii -P owpkg2.ascii

OneWorld Xe and MC/ServiceGuard
November 15, 2000
Page 11 of 88
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Output of cmviewc with the two ser

instance con” ration.

CLUSTER STATUS
hpcluster up

NODE STATUS STATE
stxhpcll up running
Network Parameters:
INTERFACE STATUS PATH
PRIMARY up 10/12/6
PACKAGE STATUS STATE
owpkgl up running

Policy Parameters:

POLICY NAME CONFIGURED VALUE
Failover configured node
Failback manual

Script_Parameters:

ITEM STATUS
Service up 0
Subnet up

Resource up

Node_Switching Parameters:

NODR TYPE STATUS SWITCHING
up enabled
te up enabled
NODE STATUS STATE
stxhpcl2 up running
Network Parameters:
INTERFACE STATUS PATH
PRIMARY up 10/12/6
PACKAGE STATUS STATE
owpkg2 up running

Policy Parameters:

POLIC™™ "™~ ME CONFIGURED VALUE
configured node
Failbaun manual

Script Parameters:

ITEM STATUS

Service up 0
Subnet up

Node Switching Parameters:
NODE_TYPE STATUS SWITCHING
Primary up enabled
Alternate up enabled

MAX RESTARTS RESTARTS

MAX RESTARTS RESTARTS

NAME
lano

PKG_SWITCH
enabled

NAME

G

5, stxhpell and stxhpcl2, up and running. This is the multif

NODE
stxhpcll

0 owmonitor
10.225.69.0
/system/filesystem/availMb/tmp

NAME
stxhpcl1l
stxhpcl2

NAME
lano

PKG_SWITCH
enabled

NAME

(current)

NODE
stxhpcl2

0 owmonitor2
10.225.69.0

NAME
stxhpel2
stxhpcll

(current)

OneWorld Xe and MC/ServiceGuard

November 15, 2000
Page 13 of 88









-
1() B

T b imvent

9
lestpac lo  w! boththe: ry and standby LAN fail.
W: theowpkglp con T lconditions  d under a typical workload,
disconnect the Primary y LAN

Verify that the ServiceGuard Cluster Manager daemon recognizes loss of the data path. The cluster should
with one healthy member, the Secondary node The primary node should free leftover holds on shared

ret
tly on its Secon: _ node.

Vo : group(s). ...2 owpkgl package should start up

Note: When the Primary node is reconnected, it will automatically rejoins the cluster, but is not enabled for
package switching. No package switchback will occur at this time.

November 15, 2000
Page 16 of 88






# For example:
# 1 uUP
# VULUME_GROUP

vuLuMn anuvuE

/dev/ latabase.
/dev/.yu2.

fUEV/ VYLl

OneWorld Xe and MC/ServiceGuard
November 15, 2000
Page 18 of 88
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# The default for NODE FAIL_F
# in the event of a failure,

' ENABLED is NO. If t to YES,
the cluster software will halt the node

# on which the package is running. Adjust as nece ry.

NODE_FAIL FAST_ENABLED NO

.. orlc.._andN Servic. _ iard
November 15, 2000
Page 22 of 88
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#DTC_NAME [0] =

# START OF CUSTOMER DEFINED FUNCTIONS

# This function is a place holder for customer define functions.
# You should define all actions you want to happen here, before the service is
# started. You can create as many functions as you need.

function customer defined run cmds

{

# ADD customer defined run commands.
# do nothing instruction, because a function must contain some command.

. oneworld <<EOF1
/u03/oneworld/b733 spl4/system/bini2/owenv
/u03/o  >rld/b733 4 stem/bin32/RunOneWorld. sh

EOF1

test_return 51

}

# This function is a place holder for customer define functions.
# You should define all actions you want to happen here, before the service is

# halted.
function customer_defined halt_cmds

# ADD customer defined halt commands.
# do nothing instruction, because a function must contain some command.

su oneworld <<EOF2
/103 /oneworld/b733_spl4/system/bin32/o
/u03/oneworld/b73" :pl4/system/bin32/EndOneWorld.sh now

EOF2

}

# ] OF DE CTIONS

test_return 52

# START OF RUN FUNCTIONS

function activate volume_group

for I in ${vGlel}

do
if [[ "${VGCHANGE}" = "vgchange -a y" 1]
then
orint "$(date '+%b %e %X') - Node \"$(hostname)\": Activating volume group $I
with non-excl ‘e option."
else
print "$(date '+%b %e %X') - \"$(hostname)\": Activating volume grc with
exclusive option."
fi
$VGCHANGE $I
test return 1
# If the -s option has been specified, then we perform
# the resynchronization as a background task
#
if [[ ${VGCHANGE#*-s} != ${VGCHANGE} 1]
then
if /sbin/vgsync $I
then
print "$(date '+%b %e %X') - Node \"$(hostname)\": Resynchroni
group $I"

else
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print "$(date '+%b %e %X') - Node \"$(hostname)\": Resynchronization of
volt group $I "
L.
} &
fi
done
}

# For each {file system/logical volume} pair, fsck the file system
# and mount it. If the file system is busy, mounting of the file
# system will fail, the control script will exit with an error.

function check_and_mount
{

integer R=0

for I in ${1Lviel}

do
if [[ $(mount -p I awk |$1 J— ur$I|"|) = " 1]
then
RLV[$RI="${T1%/*}/rs{Th#t*/}"
if [ -x /usr/sbin/fstyp ]
then
fstype($R]=$(fstyp $I)
fi
({R=$%R + 1))
fi
done
# Verify t there at one file rstem to check and what type.
if [[ ${rRuviel} 1= " |]
then
print -n "$(date '+%b %e %X') - Node \"$(hostname)\": "
print "Checking filesystems:"
print ${wviel} | tr ' ' *\012' | sed -e 's/*/ /t

# If there is more than one filesystem type being checked
# then each filesystem is check individually.

#
R=$ (print ${fstypel*]} | tr ' ' '\012' | sort -u | wc -1)
if (( R > 1))
then
R=0
while (( R < ${#RLV([*]1} ))
do

case ${fstypel$R]} in

hfs) ck -F hfs -P ${RLV[$R]}
tes’ eturn 2

i

vxfs) fsck -F vxfs -y ${RLV[$R]}
test_return 2

i

unk*) fsck ${RLVIS$R]}
test_return 2

i

*) if [{ ${fStype[$R]} = wn 1]
then
fsck ${RLVI$R]}
else
fsck -F ${fstypel[$R]} ${RLVI$R]}
fi
test return 2
esac Y
((R=R + 1))
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# Tf there is nnlv one filesystem tvpbe beina checked. then

# ions of fsck can a All
# the com 1 e to k inwv
#

else

case ${fstype} in

hfs) fsck -F hfs -P ${RLV[@]}
test_return 2

i

vxfs) fsck -F vxfs -y ${Ruv[e]}
test_return 2

i

unk*) fsck ${RLV[e]}
test_return 2

I

*) if [[ ${fstype} = " ]1]
then
fsck ${RLV[e]}
else
fsck -F ${fstype} ${RrRLVI[@]}
fi
test_return 2

ii

invent

esac
fi
£i
# Check € va. (set any proceeding fsck calls failed)
if (( $exit_val == 1))
t
deactivate_volume group
print "\n\t########### Node \"$(hostname)\": Package start failed at $(date)
#H#HHE
exit 1
fi

integer F=0
for I in ${LVv }

File system

do
if [[ $(mount | grep -e $I" ") = "n ]]
t
print "$(date '+%b %e %X') - Node \"$(hostname)\": Mounting $I at ${FS[$F]}"
mount ${FS_MOUNT OPT[$F]} $I ${FS[$F]}
test_return 3
else
print "$(date '+%b %e %X') - Node \"$(hostname)\": WARNING:
\"${FS[$F] }\" was already mounted."
fi
(( F=8%F+ 1))
done

}

# For each {IP address/subnet} pair, add the IP address to the subnet
# using cmmodnet (1m) .

function add_ip_address

{
integer S=0
integer error=0

for I in ${1P[e]}
do

print "$(date '+%b %e %X') - Node \"$(hostname)\": Adding IP addres

${SUBNET[$S] }"
XX=$( cmmodnet -a -i $I ${SUBNET[$S]} 2>&1 )
OneWorld Xe and MC/ServiceGuard
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if (( $? t=0))
then
if [[ o (| grep "heartb Ip") 1= """ 1]
then
# TD hae he-—- --—-ff—--ed as a heartbeat IP address.
]
\\ error = 1))
else
YY=$( netstat -in | awk '$4 == "r${1}rm1)
if [[ -z $YY 1]
then

print "$XX" >> $0.log

print "\tERROR: Failed to add IP $I to subnet ${SUBNET[$S]}"

(( error = 1))

else
print "\tWARNING: IP $I is already configured on the subnet
${SUBNET[$S] }"
fi
fi
fi
({ s=8%5+1))
done
if (( error != 0 ))
then
¥ " 0~ $? 1. n rn

# requires yv TO De Sert TO L1 1I 1T nas to print error message.
0

test_return 4

}

# Own and reset the DTC connections
function get ownership dtc

for I in ${DTC_NAME[e@]}
do

print "$(date '+%b %e %X') - Node \"$(hostname)\": Assigning Ownership of the DTC $I"

dtcmodifyconfs -o $I
test_return 5

for J in ${IP[e]}
do
print "$(date '+%b %e %X') - Node \"$(hostname)\": Resetting the DTC

connections to IP address $J"
dtcdiag -Q $J -g -f $I
test_return 6
done
do

# For each {service name/service command string} pair, start the
# service command string at the service name using cmrunserv(lm) .

function start services

{

integer C=0
for I in ${SERVICE NAME[@]}

do
print "$(date '+%b %¥e %X') - Node \"$(hostname)\": Starting service $I using"

print " \"${SERVICE CMD[$C]}\""

# Check if cmrunserv should be called the old
# way without a restart count.

#
if [[ "${SERVICE RESTART[$C]}" = "" ]]
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# using modnet (1m) .

function remove ip address

{
integer S=0
integer e r=0

for I in ${1P[@]}
do

print "$(date '+%b %e %X') - Node \"$(hostname)\": Remove IP address $I from subnet
${SUBNET[$S] } "

XX=$( cmmodnet -r -i $I ${SUBNET[$S]} 2>&1 )

if (( $? 1= 0 ))

then
echo $XX | grep "is not configured on the subnet"
if (( $? 1= 0 ))
then
print "SXX" >> $0.log
(( e =1))
fi
fi

((8=5%5+11})
¢
if ({ Serror != 0 ))
then

# “let 07 is used to set the value of $? to 1. The function test_return
# requires $? to be set to 1 if it has to print error message.

let 0
test return 12
£i

}

# Unmount each logical volume.

function umount fs

{
integer UM_ ${F x -1}
if [[ $UM CNT < 1 ]]
then
UM_CNT=1
fi

2 {#1v[*]}
wnite (\ L > 0 ))

do

((L=1L-1))

T=5{Tv[$11}

nt | -e $I" v > /dev/null 2>&1
if (( $? == 0 ))
then
print "$(date '+%b %e %¥X') - Node \"$(hostname)\": Unmounting filesystem on
Ill

; print "\tWARNING: Running fuser to remove anyone using the file system
directly."

UM_COUNT=$UM_CNT
while (( $UM COUNT > 0 ))

do
fuser -ku $I
umount $I
if (( 8?2 == 0))
then
(( UM_COUNT = 0 ))
else
if (( $UM_COUNT == 1 ))
then
let ©
test_return 13
fi
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deactivate_volume_group
exit 1

ii

6)
print "\tERROR: Function get_ ownership dtc"
print "\tERROR: Failed to switch $1I"
disown_dtc
we_ip address
umount_fs
deactivate volume group
exit 1

i

8)

print "\tERROR: Function start_services"

print "\tERROR: Failed to start service ${SERVICE NAME[$C]}"
halt_services

customer defined_halt_ cmds

disown dtc

remove ip_ address

umount_fs

deactivate_volume_group

exit 1

ii

9)
print "\tFunction halt_services"
print "\tWARNING: Failed to halt service $I"

ii

11)

print "\tERROR: Function disown dtc*

nrint "\+ERROR: Failed to disown $I from ${SUBNET[$S]}"
1

ii

12)

print "\tERROR: Function remove_ip_address"
print "\tERROR: Failed to remove $I"

exit value=1

ii

13)
print "\tERROR: Function
print "\tERROR: Failed to unmount $I"
exit value=l
14)
:int "\tERROR: Function deactivate_volume group"
print "\tERROR: PFailed to deactivate $I"
exit value=1l

ii

15)

print "\tERROR: Function start_resources"
print "\tERROR: Failed to start resource $I"
stop_resources

halt_services

customer_defined halt_cmds

disown_dtc

remove ip address

umount_fs

deactivate_volume_group

exit 1

il

16)
print "\tERROR: Function stop resources"
print "\tERROR: Failed to stop resource $I"
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it_va: 1

i

51)

print "\tERROR: Function customer_defined run_cmds"
print "\tERROR: Failed to RUN customer commands"
halt_services

customer_defined halt_cmds

disown_dtc

remove_ip address

umount_fs

deactivate_volume group

exit 1

i

52)

print "\tERROR: Function customer_defined halt_ cmds"
print "\tERROR: Failed to HALT customer commands"
exit_value=1

ii

*)
"\tERROR: Failed, swn error."

esac

# END OF FUNCTIONS COMMON TO BOTH RUN AND HALT

# FUNCTION STARTUP SECTION.

typeset MIN VERSION="A.10.03" # Minimum version this control script works on

integer exit_value=0
typeset CUR_VERSION

#
# Check t ' s control script being run on a A.10.03 or later re

# of MC/ServiceGuard or ServiceGuard OPS Edition. The control scripts are rorward
# compatible but are not backward compatible because newer control
# ripts use commands and option not available on older :

CUR_VERSION="$(/usr/bin/what /usr/lbin/cmcld | /usr/bin/grep "Date" | \
/usr/bin/egrep '[AB]\...\...|NTT\...\..." | \
cut -f2 -gn yn

if [[ "${CUR VERSION}" = " 11 || \
[[ "${CUR_VERSION#*.}" < "${MIN VERSION#+.}" 1]

then
print "ERROR: Mismatched control script version ($MIN VERSION). You camnnot run”
print "\ta version ${MIN VERSION} control_ script on a node running pre"
print "\t${MIN VERSION} MC/ServiceGuard or ServiceGuard OPS Edition software"
exit 1

fi

# Test to see if we are being called to run the package, or halt the package.

if [[ $1 = "start" ]]

then
print "\n\t########### Node \"$ (hostname)\": Starting package at $(date)

#HuananiHann

activate volume group
check_and_mount
add ip address
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customer_define” un_cmds
start_services

s ‘esour 3

# Check exit value

if (( $exit_value == 1 ))
then
print "\n\t########### Node \"$(hostname)\": Package start failed at
$(date) ####H#HHH#E"
exit 1
else
print "\n\t########### Node \"$ (hostname)\": Package start completed

at $(date) ####HHH#E"

exit 0
fi
elif [[ $1 = "stop" 1]
then
print "\n\t########### Node \"$(hostname)\": Halting package at $(date)
HHE

stop_resources

£ i
custome ‘efined_hal® mds
disown_dtc
remove_ip address
umount_fs
deactivate volume_group

# Check exit value
if (( $exit_value == 1))
then
print "\n\t######EHE Node \"$ (hostname)\": Package halt failed at

S(date) ###dHiiHHHE"
exit 1
else
print "\n\t########### Node \"$(hostname)\": Package halt completed at

${date) ###fdiiHinn
exit 0
fi

fi
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# referenced by the logical volume definitions below are included in
# volume group definitions above.

#

wvio]l=/ /vgecl2/1vol

FS[0]=/u02

FS_MOUNT_OPT[0]=""

# FILESYSTEM UNMOUNT COUNT

# Specify the number of unmount attempts for each filesystem during package
# shutdown. The default is set to 1.

FS_UMOUNT_COUNT=1

Ip . .

Speciry tne IP and Subnet address pairs which are used by this package.
Uncomment IP[0]="" and SUBNET[0}="" and £ill in th= name of your first
IP and subnet address. You must begin with IP[0] . SUBNET [0] and

inc ent the list in sequence.

For example, if this package uses an IP of 192.10.25.12 and a subnet of
192.10.25.0 enter:

IP[0]1=192.10.25.12

SUBNET[0]=192.10.25.0 # (netmask=255.255.255.0)

Hint: Run "netstat -i" to see the available subnets in the Network field.

IP/Subnet address pairs for each IP address you want to add to a subnet
interface card. Must be set in pairs, even for IP addresses on the same

subnet.

R T T o N L

IP[0]=10.225.69.23
SUBNET[0]=10.225.69.0

SERVICE NAMES AND COMMANDS.

Specify t. vice name, command, and tart paras ers which are
used by this package. Uncomment SERVICE NAME[O]="", SERVI CcMD [0]="",
SERVICE _RESTART[0]="" and fill in the name of the first service, command,

and restart parameters. You must begin with SERVICE NAME[0], SERVICE CMD[0],
and SERVICE RESTART[0] and increment the list in sequence.

For example:
SERVICE_ NAME [0] =pkgla
SERVICE CMD[0]="/usr/bin/X11/xclock -display 192.10.25.54:0"
SERVICE_RESTART[0]="" # Will not restart the service.

SERVICE_NAME[1] =pkglb
SERVTMR CMD[1]="/usr/bin/X11/xload -display 192.10.25.54:0"
r _RESTART[1]="-r 2" # Will restart the service twice.

SERVICE N2 =t

SERVICE CMu s ="/uscLy sbin/ping "

SERVICE_RESTART [2] ="-R" # Will restart the service an infinite
number of times.

Note: No environmental variables will be passed to the command, this
includes the PATH variable. Absolute path names are required for the

#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
# service command definition. Default shell is /usr/bin/sh.

3=

SERVICE_NAME [0] =owmonitor2

SERVICE CMD[0]="/etc/cmcluster/owpkg2/monitor.sh"
SERVICE_RESTART[O]:"-I on

#SERVICE_CMD[O]:"“

#SERVICE_RESTART[O]:""

# DEFERRED_RESOURCE NAME
# Specify the full path name of the 'DEFERRED' resources configured for

# this package. Uncomment DEFERRED_RESOURCE NAME[0]="" and fill in the
# full path name of the resource.
#

#DEFERRED RESOURCE_NAME [0]=""

# DTC manager information for each DTC.
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# Example: DTC[0]=dtc_20
#DTC_NAME [0

# ST. OF . NED FUNCTIONS

# This function is a place holder for customer define fun ns.
# You should define all actions you want to happen here, werore the service is
# started. You can create as many functions as you need.

function o def run_cm

# ADD customer defined run commands.
# do nothing instruction, because a function must contain some command.

su owuserl <<EOF1

. /u02/oneworld/b733 spl4/s em/bin32/owenv

/u02/oneworld/b733 spl4/system/bin32/RunOneWorld.sh
EOF1

test_return 51

}

# This function is a place holder for customer define functions.
# You should define all actions you want to happen here, before the service is
# halted.

function customer defined halt_cmds

{

# ADD cus r defined halt commands.
# do nothing instruction, because a function must contain some command.

su owuserl <<EQF2
/u02/oneworld/b733_spl4/system/bin32/owenv
/u02/oneworld/b733_sple/system/bin32/EndOneWorld. sh now

EOF2

test_return

}

# END OF CUSTOMER DEFINED FUNCTIONS
# START OF RUN FUN NS

function activate volume_group

for I in ${vGie]}
do
if [[ "${VGCHANGE}" = "vgchange -a y" 1]

then
print "$(date '+%b %e %X') - Node \"$(hostname)\": Activating volume group $I

with non-exclusive option."

else
print "$(date '+%b %e $X') - \"$(hostname)\": Activating volume group $I with

exclusive option."
fi

$VGCHANGE $I
test_return 1

# If the -s option has been specified, then we perform
# the resynchronization as a background task

#
if [[ ${VGCHANGE#+*-s} != ${VGCHANGE} 1}
then

{
if /sbin/vgsync $I
then
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done

# If there only one filesystem type being checked, then

gt invent

# multiple invocations of fsck can be avoided. All filesystems
# are cified on the command line to one fsck invocation.

#
else
case ${fstype} in

hfs) fsck -F hfs -P ${RLV[@]}
test_return 2

ii

vxfs) fsck -F vxfs -y ${RLvV[el}
test_return 2

i

unk*) fsck ${RLV[e]}
test return 2

i

*) if [[ ${fstype} = "t 1]

then
fsck ${RLV[@]}

else
fsck -F ${fstype} ${RLV[@]}

fi

test_return 2

esac v
fi
fi

# Check it value (set if any proceeding fsck calls failed)
if (( $exit_value == 1 ))

then
deactivate volume_group

print w\n\CEAHEHHEREES Node \"$(hostname)\": Package start failed at $(date)

HHHHHHEHH A
exit 1
fi

integer F=0
for I in ${Lvie]}

do
if [T $(mount ' g -e $Iv ") = "n ]
nt " X'} - NeA= \"$§(hostname)\":
mount § $F1} 81 ¢ [$F]}

test_return 3
else

print "$(date '+%b %e %X') - Node \"$ (hostname)\":

\"${FS[$F]}\" was already mounted."
fi
(( F=§F + 1))

done

}

Mounting

WARNING:

# For each {IP address/subnet} pair, add the IP address to the subnet

# using cmmodnet (1m) .
function add_ip_ address

integer S=0
integer error=0

for I in ${1P[@]}
do
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# way without restart count.
#
if [[ "${¢ 'ICE RESTART[$CI}" = "» 1]
then
cmrunserv $I ">> $0.log 2>&1 ${SERVIC~ "MD[$C]}"
else
cmrunserv ${: "ICE_RESTART[$C]} $I ">> $0.log 2>&1 ${SERV: scl)e
fi

test_return 8
((C=3%C+1))
done

# For each {deferred resource name}, start resource monitoring for this
# urce using cms  tres(lm).

function start_resources

for I in ${DEFERRED RESOURCE NAME[@]}

do
print "$(date '+%b %e %X') - Node \"$(hostname)\": Starting resource monitoring for
$I"
cmstartres -u -p $PACKAGE $I >> $0.log 2>&1
test_return 15
done
}

# END OF RUN FUNCTIONS.

#

# For each {deferred resource name}, stop resource monitoring for this
# resource using cmstopres(lm).

f op. ources
{
b ${ RCE Nz @]}
ao
print "$(date '+%b %e ¥X') - Node \"$(hostname)\": Stopping resource monitoring for
$I 1t

cmstopres -p $PACKAGE $I >> $0.log 2>&l
test_return 16
done

# Halt each service using cmhaltserv(lim).
funct halt_services

for I in ${SERVICE NAME[@]}

do
print "$(date '+%b %e %X') - Node \"$(hostname)\": Halting service $I"
cmhaltserv $I
test _return 9

done

}

# Disown the DTC.
function disown_dtc

for I in ${DTC_NAME[e]}

do
print "$(date '+%b %e %X') - Node \"$ (hostname) \": Disowning the DTC $I"

dtcmodifyconfs -d $I
test_return 11
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function remove ip address

{

integer S=0
integer error=0

for I in ${1IP[e@]}

do

print "$(date '+%b %e %¥X') - Node \"$(hostname)\": Remove IP address $I from subnet
${SUBNET[$S]}"

¥ crimod -r -i 81 § BNET[$S1} 2>&1 )
it (( 82?2 1=0))

then
echo $XX | grep "is not configured on the subnet"

if ({ $2? 1=0))

then
print "$XX" >> $0.log
({ error = 1 ))
fi
fi
(( 8 =88+ 1))
done
if (( $error !'= 0 ))
then

# “let 0~ is used to set the value of $? to 1. The function test_return
# requires $? to be set to 1 if it has to print error message.

fi

}

let 0O
_return 12

# Unmount each logical volume.

func

{

n umount_fs

integer UM_CNT=${FS UMOUNT_ COUNT: -1}

if [[ $UM_CNT < 1 1]

then

UM_CNT=1

fi

intearr L=${#LV[*]}

((L > 0))

((L =L -1))

1=3{LvI[sL]}
mount | grep -e $I" " > /dev/null 2>&1
if (( $? == 0))
then
print "$(date '+%b %e %X') - Node \"$(hostname)\": Unmounting filesystem on
$I"
print "\tWARNING: Running fuser to remove anyone using the file system
directly."

UM_COUNT=$UM_CNT
while (( $UM_COUNT > 0 ))
do
fuser -ku $I
umount $I
if (( $2 == 0 ))
then
({ UM _COUNT = 0 ))
else
if (( $UM COUNT == 1 ))
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let 0
return 13
f-:
( ' = - 1))
s
i _!OUNT > 0 ))
then
print "\t$(date '+%b %e %¥X')
£i
fi
done

done

function dear vate volume_group

for I in ${vGie]}

do
print "$(date '+%b %e %X') - Node \"$(hostname)\":
vgchange -a n $I
test_return 14

done

}

# END OF HALT FUNCTI

# FUNCTIONS COMMON TO BOTH RUN AND HALT.

serv b

imvent

- Unmount failed, trying again."

Deactivating volume group $I"

# Tes value of functions and exit with NO RESTART if bad.
# Ret 2 of 0 - 50 are res ed for use by Hewlett-Packard.
# Sys 1istrators can use uubers above 50 f val

runceron test_return

if (( 8?2 =0 ))

t

case $1 in
1)
print "\tERROR:
print "\tERROR:
deactivate volume group
exit 1

ii

2)

print "\tERROR:
print "\tERROR:
exit_value=1

i

3)

print "\tERROR:
print "\tERROR:
umount_f£fs
deactivate volume_group
exit 1

s

4)

print "\tERROR:
print "\tERROR:
remove_ip address
umount_£s
deactivate volume_ group
exit 1

i

5)
print "\tERROR:
to

Function activate volume_group”
Failed to activate $1"

Function check_ and mount™"
Failed to fsck one of the logical volu "

Function check and_mount"
Failed to mount $I to ${FS[$F]}"

Function add ip_address"
Failed to add IP address to subnet'

Function get_ ownership dtc"
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customer_defined run_cmds
start_services

start_resources

# Check exit value

if (( $exit value == 1))
then

print "\n\t#####444### Node \"$ (hostname)\":

$(date) ######H#HH#E"
exit 1
else

print "\n\t##########4# Node \"$ (hostname)\":

at $(date) ####HHHAR#Y"

invent

Package start failed at

Package start completed

exit 0
fi
elif [[ $1 = "stop" 11
then
print "\n\t########### Node \"$(hostname)\": Halting package at $(date)
HHEHRGHH R

stop_resources
halt_services
customer « ‘ined halt_cmds
disown_dtc
remove_ip_ address
umount_fs
't
# Check exit value

if (( $exit_value == 1))
then

print "\n\t######4#### Node \"$ (hostname)\":

$(date) #u##H###ERRS"
exit 1
e

print "\n\t#######4### Node \"$ (hostname)\":

$(date) #####H#H##H#H"
exit 0

fi
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Package halt failed at

Package halt completed at
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Appendix 6: On. .. orld Xe Monitor Script (monitor.sh) (same script for each package)

#!/bin/ksh

t_n jdequeue"
trap "exit" 15

while true

do
for i in $CHECKFOR
do
print nn
print "checking for process $i"
ps -ef | grep $i | grep $USER | grep -v grep > /dev/null 2>&l1
if [ $? -ne 0 1]
then
print "\n"
print "exiting monitor script - process $i not found”
exit 1
fi
done
sleep 15
done
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Append 7:Ou _ 1t of DN N

Filesystem kb a M
/dev/vg00/1vol3 l4s30u Zo3ve 10783v z1s [/
/dev/vg00/1voll 83733 27523 47836 37% /stand
/ /vg00/1vols 512000 304403 195643 61% /var
/dev/vg00/1vol? 512000 381535 122314 76% /usr
/dev/vg00/1vola 65536 1130 60384 2% /tmp
/dev/vg00/1vole 348160 63771 266678 19% /opt
/dev/vgo0/1vols 20480 1351 17988 7% /home
/dev/vg0o1/1vol 4096000 1238276 2679117  32% /u0l
/dev/vgcll/1v0l 16384000 2111310 13826718 13% /u03

Appendix 8: Output of <bdf> on node stxhpcl2

Filesystem kbytes used avail %used Mounted on
/1 /VgOO/lV 143360 67656 71009 49% /
/aev/vgoo/1lvoll 83733 27523 47836 37% /stand
/dev/vgoo/1vols 512000 306623 193514 61% /var
/dev/vg00/1vol7 512000 381550 122299 76% /usr
/dev/vg00/1lvola 65536 1272 60314 2% /tmp
/dev/vg00/1lvolég 348160 170584 166492 51% /opt
/dev/vg00/1vols 20480 1348 17991 7% e
/dev/vg01/1v01l 4096000 447897 3420097 12% suuL

/dev/vgecl2/1vol 16384000 2903542 13059198 18% /u02
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Appen ™ 9: "t} “of-
CLUSTER STATUS
hpcluster up
NODE STATUS
stxhpcll up
Network Parameters:
INTERFACE STATUS
PRIMARY up
PACKAGE STATUS
owpkgl up

Policy Parameters:
POLICY NAME
Failover

Failback manual

Script_Parameters:

ITEM STATUS
Service up
Subnet up
Resource up
Node_Switching Paramet
NODE_TYPE STATUS
Primary up
Alternate up
NODE STATUS
| 12 up
Network_Parameters:
INTERFACE STATUS
PRIMARY up
PACKAGE STATUS
owpkg2 up
Policy Parameters:
POLICY NAME CONFIG
Failover config
Failback manual

—aramatarg,

iev T -v>

STATE
running

PATH
10/12/6

STATE
running

CONFIGURED VALUE
configured node

MAX RESTARTS RESTARTS

0

ers:
SWITCHING
enabled
enabled

STATE
running
{
10/712/6
STATE

running

URED_VALUE
ured_node

| MAX RESTARTS R

Subnet up

Node Switching Paramet

NODE_TYPE STATUS
Primary up
Alternate up

0

ers:
SWITCHING
enabled
enabled

NAME
lan0

PKG_SWITCH
enabled

NAME

R

i'Mvent

NODE
stxhpcll

0 owmonitor
10.225.69.0
/system/filesystem/availMb/tmp

NAME
stxhpcll
stxhpcl2

lanv

PKG_SWITCH
enabled

ARTS

NAME
0 owl

(current)

NODE
stxhpcl2

tor2

10.225.69.0

NAME
stxhpcl2
stxhpcll

(current)
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Appendix 10: Contents of /etc/fstab on node stxhpcll

#

#

/dev/vg00/1vol3
/dev/vg00/1lvoll
/dev/vg00/1vols
/dev/vg00/1vols
/dev/vg00/1lvole
/dev/vg00/1vol?
/dev/vg00/1vols
#/dev/vgcl/1v0ol
#/dev/vgcl/1v02
#/dev/vgcl/1vo3
#/dev/vgcl/1v04

1

/ vxfs delayiog v L

/stand hfs defau 0 1

/tmp vxfs delaylog 0 2

/home vxfs delaylog 0 2

/opt vxfs delaylog 0 2

/usr vxfs delaylog 0 2

/var vxfs delaylog 0 2

/u0l vxfs rw,suid,nolargefiles,delaylog,datainlog 0 2
/u02 vxfs rw,suid,nolargefiles,delaylog,datainlog 0 2
/u03 vxfs rw,suid,nolargefiles,delaylog,datainlog 0 2
/u04 vxfs rw,suid,nolargefiles,delaylog,datainlog 0 2

/dev/vg01/1v0l /u0l vxfs rw,suid,nolargefiles,delaylog,datainlog 0 2

/dev/vgecll/1vol

/u03 vxfs rw,suid,nolargefiles,delaylog,datainlog 0 2

Appendix 11: Contents of /etc/fstab on node stxhpcl2

# System /etc/fstab file. Static information about the file systems

# See fstab(4) and sam(1M) for further details on configuring devices.

/dev/vg00/1vol3
/dev/vg00/1lvoll
/dev/va00/1volsa
/ 0/1vols
/ 0/ 6
/dev/vg00/1vol?
/dev/vg00/1vols
#/dev/vgcl/1v0l
#/dev/vgcl/1vo2
#/dev/vgel/1vo3
#/dev/vgcl/1vo4

/ vxfs delaylog 0 1
/stand hfs defaults 0 1
/tmp vxfs delaylog 0 2
/hnma wvfa delaylog 0 2
delaylog 0 2
/usr vxfs delaylog 0 2
/var vxfs delaylog 0 2
/u0l vxfs rw,suid,nolargefiles,delaylog,datainlog 0 2
/u02 vxfs rw,suid,nolargefiles,delaylog,datainlog 0 2
/u03 vxfs rw,suid,nolargefiles,delaylog,datainlog 0 2
/u04 vxfs rw,suid,nolargefiles,delaylog,datainlog 0 2

/dev/vg01/1v01 /u0l vxfs rw,suid,nolargefiles,delaylog,datainlog 0 2

/dev/vgcl2/1v01

/u02 vxfs rw,suid,nolargefiles,delaylog,datainlog 0 2
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Api 12: ( of /i’ "ho -

@(#)hosts $Revision: 1.9.214.1 $ $Date: 96/10/08 13:20:01 $

The form for each entry is:
<internet address> <official hostname> <aliases>

For ple:
192.1.2.34 hpfcrm loghost

See the hosts(4) manual page for more information.
Note: The entries cannot be preceded by a space.

The original Berkeley manual page contains an error in
the format description.

Feodk o e Sk e ok 3 3 3 3k 3

10.225.69.20 stxhpcll
127.0.0.1 localhost loopback

10.225.69.21 stxhpcl2

10.225.69.22 hpcluster
10.225.69.23 hpcluster2

10.0.40.73 corowsnl
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The format described in this file is the correct format.
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tnvent






TR invent

Appendix 14: Output of <lanscan>

Crd Hdw Net-Interface NM M HP-DLPI DLPI
raciu AuuLcoo In# State NamePPA ID Type Support Mj r#
10/12/6 O0x0060B032AA2F 0 UP lan® snap0 1 ETHER Yes 119
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£ 16: Ou _ ‘ wun' on stxl

/ on /dev/vg00/1vol3 log on Mon Oct 9 15:57:01 2000

/stand on /dev/vg00/lvoll defaults on Mon Oct 9 15:57:04 2000

/var on /dev/vg00/1vols8 delaylog,nodatainlog on Mon Oct 9 15:57:18 2000
/usr on /dev/vg00/1lvol7 delaylog,nodatainlog on Mon Oct 9 15:57:18 2000
/tmp on /Aav/vg00/lvol4 Aalaylog,nodatainlog on Mon Oct 9 15:57:18 2000
) . on w/vg00/1lvolé laylog,nodatainlog on Mon Oct 9 15:57:19 2000
/home on /dev/vg00/1lvols delaylog,nodatainlog on Mon Oct 9 15:57:19 2000
/u0l on /dev/vg01/1v0l delaylog,nodatainlog on Tue Oct 10 09:58:45 2000
/u03 on /dev/vgcll/1lv0l log,nodatainlog on Wed Oct 11 14:40:29 2000

Appendix 17: Output of </etc/mount> on stxhpcl2

/ on /dev/vg00/lvol3 log on Mon Oct 9 15:52:35 2000

/stand on /dev/vg00/lvoll defaults on Oct 9 15:52:37 2000

/var on /dev/vg00/1lvol8 delaylog,nodatainlog on Mon Oct 9 15:52:51 2000
/usr on /dev/vg00/lvol7 delaylog,nodatainlog on Mon Oct 9 15:52:52 2000
/tmp on /dev/vg00/1vol4 delaylog,nodatainlog on Mon Oct 9 15:52:52 2000
/opt on /dev/vg00/lvolé delaylog,nodatainlog on Mon Oct 9 15:52:52 2000
/home on /dev/vg00/1vols delaylog,nodatainlog on Mon Oct 9 15:52:52 2000
/u0l on /dev/vg01l/1v0l delaylog,nodatainlog on Tue Oct 10 10:24:35 2000
/u02 on /dev/vgcl2/lv0l log,nodatainlog on Wed Oct 11 13:32:12 2000
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o

ROUTE DESTINATION{O]="default"

‘{ol="10.2: .20"
]=||0"
ROUTE_ARGS [0]=""

# Dynamic routing daemon configuration. See gated(lm)

#
¥ GATED: Set to 1 to start gated daemon.

# GATED ARGS: Arguments to the gated daemon.

GATED=0
GATED_ARGS=""

#
# Router Discover Protocol daemon configuration. . rdpd (1m)

#
# RDPD: Set to 1 to start rdpd daemon

#
RDF

#
# Reverse ARP daemon configuration. See rarpd(lm)

#
# RARP: Set to 1 to start rarpd daemon

#

RARP=0

OneWorld Xe and MC/ServiceGuard
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# will assign the default network mask as t

# subnet mask.

#

# TE

#

# et mmmn e e e va Ak sALaalEUD GMUVE \LIUD LIS UL
# decimal-dot notation). If loopback interface, i.e.,
# 127.0.0.1, the ROUTE_COUNT must be set to zero.

#

# ROUTE_COUNT: An integer that indicates whether the gate is a
# remote interface (one) or the local interf... (zero)
# or loopback interface (e.g., 127.%).

#

# ROUT. RGS: Route command arguments and options. This variable
# may contain a combination of the following arguments:
# u_fu’ v_n" and " PJ

#

# For e dit

# below, cnangin, ... .ccace oo L1y 4 141 ©u voioia.

#

# IMPORTANT: for 9.x-to-10.0 transition, do not put blank lines between
# the next set of statements

invent









AT

Rou - tab
Dest/nNet k
127.0.0.1
10.225 69.20
10.2 69.22
10.22».69.0
10.225.69.0
127.0.0.0
default

Appendix 21: Output of <netstat -nr> on stxhpcl2

Routing tables
Dest/Netmask
127 o n_ 1

10.. 69.21
10.225.69.23
10.225.69.0
10.225.69.0
127.0.0.0
default

* of -

Gateway
127.0.0.1

10.225.69.
10.225.69.
10.225.69.

10.225.69
127.0.0.1
10.225.69

Gateway

127.0.0.1
10.225.69
10.225.69
10.225.69
10.225.69
127.0.0.1
10.225.69

20
22
20
.22

.20

.21
.23
.21
.23

.21
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Flags

agadaaq g g g

Flags
UH

aadcda

Refs

OO WwWWwoo

Refs

0

OO WWwWoo

Use
95871
18413

O o000 oo

Use
73359
11695

O ooo

Interface
lo0

lano
lano:1
lan0
lan0:1
100

lano

Interface
100

lano
lano0:1
lano
lano:1
lo0

lano

Pmtu
4136
4136
4136
1500
1500
4136
1500

Pmtu
4136

36
4136
1500
1500
4136
1500



Appendix 22: Contents of /etc/passwd on stxhpcll

root:/. kIyd.u98c:0:3::/:/sbin/sh
daemon:*:1:5::/:/sbin/sh

bin:*:2:2::/usr/bin:/sbin/sh

sys:*:3:3::/:

adm:*:4:4::/var/adm:/sbin/sh
uucp:*:5:3::/var/spool /uucppublic: /usr/lbin/uucp/uucico
1p:*:9:7::/var/spool/lp:/sbin/sh
nuucp:*:11:11:: /var/spool /uucppublic: /usr/lbin/uucp/uucico
hpdb:*:27:1:ALLBASE: /: /sbin/sh

nobody:*:-2:-2::/:

WWW:*:30:1::/:
oracle:fdOR4rxfx4GVs:101:101:,,, : /home/oracle: /usr/bin/ksh
oneworld:M9r.tGLRzhIW0:102:102:,,, : /home/oneworld: /usr/bin/ksh
owuserl:0g/e8hg5y5ge0:103:102:,,, : /home/owuserl: /usr/bin/ksh

Appendix 23: Contents of /etc/passwd on stxhpcl2

root :8fdfhLf20HIJWk:0:3::/:/sbin/sh
daemon:*:1:5::/:/sbin/sh

bin:*:2:2::/usr/bin:/sbin/sh

Sys:*:3:3::/:

adm:*:4:4::/var/adm:/sbin/sh
uucp:*:5:3::/var/spool/uucppublic: /usr/lbin/uucp/uucico
1p:*:9:7::/var/spool/lp:/sbin/sh
nuucp:*:11:11::/var/spool/uucppublic: /usr/1bin/uucp/uucico
hpdb:*:27:1:ALLBASE:/:/sbin/sh

nobody:*:-2:-2::/:

www:*:30:1::/:

oracle:R6bu57ElPaWbk:101:101:,,, : /home/oracle:, n/
oneworld:mkE94UlgpB6.k:102:102:,,, : /home/oneworia: usr/L.../ksh
owuserl:HFioCPzs0f0yw:103:102:,,, : /home/owuserl: /usr/bin/ksh
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pdclientd 6874/tcp

invent

# MLU/OYySLelm BIVIIONMENT monitor
# MC/System Environment console multiplexor
# ACT Call Processing Server

# Kerberos 5 kdc

Kerberos
Kerberos
Kerberos
Kerberos
Kerberos
Kerberos
Kerberos
Kerberos
Kerberos

pdeventd 6875/tco
mcsemon PP
console 10000/tcp
actcp 31766/!
#
# Kerberos (Project Athena/MIT) services
#
kerbeross ‘udp kdc
klogin sa3/tcp
kshell 544/tcp kremd
ekshell 545/tcp krcmd
750/udo  kdc
750/ kdc
master 751/tcp kadmin
: 760/tcp kreg
kpasswd 761/tcp kpwd
eklogin 2105/tcp

o 3 o 3 3k ok 3 3

rlogin -kfall

remote shell -kfall

encrypted remote shell -kfall
(server) udp -kfall

(server) tcp -kfall

kadmin

registration -kfall

"passwd" -kfall

encrypted rlogin -kfall

# The X10_LI server for each display listens on ports 5800 + display number.

The X11 font server listens on port 7000.

o o3 3 3

Refer to the X documentation for details.

hpoms-ci-lstn 5403/tcp #SAP spooler support
hpoms-dps-1lstn 5404/tcp #SAP spooler support

Do NOT associate other services with these ports.

The X10 _MI server for each display listens on ports 5900 + display number.
The X11 server for each display listens on ports 6000 + display number.

samd 3275/tcp # sam daemon

dtspc 6112/tcp #sub cess control

rl¢

Cc
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nstrpty
nstrtel
nswapdev
semmap

=1 1{{1IFQV}

semume

semvmx

shmmax

shmmni

shmseg
swapmem_on
timeslice
unlockable mem

60
(MAXUSE

25
(SEMMNI+2)

(NPROC-4)

128

32768
0X40000000
512

32

0

1
(MAXUSERS*10)
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Apper x 27: Output

VG Name
VG Write Access

e gy
iRy
Open LV
Max PV
Cur PV
Act PV
Max PE per PV
VGDA
PE Size (Mbytes)
TC . PE
Alloc PE
Free PE
Total PVG
Total Spare PVs
Total Spare PVs in use

--- Logical volumes ---
LV Name

LV Status

LV Size (Mbytes)
Current LE

Allncated PE

1 i pv

~--- Physical volumes ---
PV Name

PV Status

Total PE

Free PE

PV Name
PV Status
T¢ PE
Free PE

PV Name
PV Status
Total PE
h2H PE

PV Name
PV Status
Total PE
Free PE

‘gdisplay -v> on node stxhpcll

/dev/vgcll
read/urita

151
Zb5

/dev/vgecll/1vol
available/syncd
16000

4000

4000

4

/dev/dsk/c0t1d0
available

1023

0

/dev/dsk/c0tedo
available

1023

Q

/dev/dsk/c0t10d0
a 1

1

0

/dev/dsk/c0t11d0
available

1023

92
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Appendix 28: Output of <vgdisplay -v> or

--- Volume grou -
VG Name
VG Write Access
VG Status
Max LV
Cur LV
Open LV
Max PV
Cur PV
Act PV
Max PE per PV
VGDA
Size (Mbytes)
cotal PE
Alloc PE
Free PE
Total PVG
Total Spare PVs
Total Spare PVs in use

--- Logical volumes ---~

LV Name

LV Status

LV Size (Mbytes)
Current LE
Allocated PE
Used PV

--~- Physical volumes ---

PV Name

PV Status

Total PE
: PE

PV Name
PV Status
Total PE
Free PE

PV Name
PV Stat
Total P
Free PE

PV Name
PV Status
Total PE
Free PE

/dev/vgcl2
read/write
available, exclusive
255
1
1
16
4
4
1024
8
4
4092
4000
92
0
0
0
/dev/vgcl2/1v0l
available/syncd
16000
4000
4000
4
/dev/dsk/c0t0do
available
1023
0
/dev/dsk/cot12d0
available
1023
0
/dev/dsk/cot13d0
available
1023
0
/dev/dsk/c0t14d0
available
10
92
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Appendix 29: OneWorld Xe IEQ.ini file on noc stxhpcll

; R .Time initialization file INI(IEO)
[IEO]
RegisteredEvents=

[SAMPLE EVENT]
DS1=DXXXXXXXX
DS2=DYYYYYYYY
DS3=DZZZZZZZZ

spendix 30: OneWorld Xe IEQ.ini file on node stxhpcl2

RealTime initialization file INI(IEO)

i

[IEO]
RegisteredEvents=

[SAMPLE_EVENT]
DS1=DXXXXXXXX
DS2=DYYYYYYYY

=DZZZZZZ2Z
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netTrace=0

[

k KERNEL

d ..sl
dispatchDLLFunction=JDENET DispatchMessage
maxNumberOfProcesses=1
numberOfAutoStartProci =0

[JDENET_KERNEL_DEF2]

krnlName=UBE KERNEL
dispatchDLLName=1ibjdeknet.sl
dispatchDLLFunction=JDEK DispatchUBEMessage
maxNumberOf Processes=1
numberOfAutoStartProcesses=0

[JDENET_KERNEL_DEF3]
krnlName=REPLICATION KERNEL
dispatchDLLName=1ibjderepl.sl
dispatchDLLFunction=DispatchRepMessage
maxNumberOf Processes=1
numberOfAutoStartProcesses=0

[JDENET_KERNEL_DEF4]

krnlName=SECURITY KERNEL
dispatchDLLName=1ibjdeknet.sl
dispatchDLLFunction=JDEK DispatchSecurity
maxNumberOfProcesses=1
numberOfAutoStartProcesses=0

[JDENET_KERNEL_DEFS]

krnlName=LOCK MANAGER KERNEL

dispatchDLLName=1ibtransmon.sl

di spatchDLLFunction=TM DispatchTransactionManager
NumhavNfPr se

numbex ltoStartProcesses=0

[JDENET_KERNEL_DEF6]

krnlName=CALL OBJECT KERNEL
dispatchDLLName=1ibjdeknet.sl
dispatchDLLFunction=JDEK DispatchCallObjectMessage
maxNimherOfProcesses=1

numb fAutoStartProcesses=1

[JDENET_KERNRL NEF7]
krnlName=JDB] ERNEL

patchDLLN: .ibjdeknet.sl
aispatchDLLFunction=JDEK DispatchJDBNETMessage
maxNu~r~~OfProcecceag=1
numbe utoStar ocesses=0

[JDENET_KERNEL_DEF8]
krnlName=PACKAGE INSTALL KERNEL
dispatchDLLName=1libjdeknet.sl
dispatchDLLFunction=JDEK DispatchPkgInstallMessage
maxNumberOfProcesses=1
numberOfAutoStartProcesses=0

[JDENET_KERNEL_ DEF9]
krnlName=SAW KERNEL
dispatchDLLName=1ibjdesaw.sl
dispatchDLLFunction=JDEK DispatchSAWMessage
maxNumberOfProcesses=1
numberOfAutoStartProcesses=0

[JDENET_KERNEL_DEFlO]

krnlName=SCHEDULER KERNEL
dispatchDLLName=libjdeschr.sl
dispatchDLLFunction=JDEK DispatchScheduler
maxNumberOfProcesses=1
numberOfAutoStartProcesses=0
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[JDENET KERNEL DEF11]

krnlName=PACKAGE BUILD KERNEL
dispatchDLLName=1ibjde it.sl
dispatchDLLFunction=JDEK DispatchPkgBuildMessage
maxNumberOfProcesses=1
numberOfAutoStartProcesses=0

[JDENET_KERNEL_DEF12]

krnlName=UBE SUBSYSTEM KERNEL
dispatchDLLName=1ibjdeknet. sl
dispatchDLLFunction=JDEK DispatchUBESBSMessage
maxNumberOf es=1
numberOfAutoStartProcesses=0

[JDENET_KERNEL_DEF13]

krnlName=WORK FLOW KERNEL
dispatchDLLName=1ibworkflow.sl
dispatchDLLFunction=JDEK_DispatchWFServerProcess
maxNumberOfProcesses=1
numberOfAutoStartProcesses=0

[JDENET_KERNEL_DEF19]

krnlName=EVN KERNEL
dispatchDLLName=libjdeie.sl
dispatchDLLFunction=JDEK_DispatchITMessage
maxNumberOfProcesses=1
numberOfAutoStartProcesses=0

[JDENET _KERNEL DEF20]
krnlName=IEO KERNEL
dispatchDLLName=libjdeieo.sl
dispatchDLLFunction=JDEK_DispatchIEOMessage
maxNumberOfProcesses=1
numberOfAutoStartProcesses=0

[NETWORK QUEUE SETTINGS]
UBE Semaphore Key=3600
DefaultPrinterQUTQ=devprné
JDENETTimeout=60

[ BUILD]
BuildArea=/usr/oneworld/BDEV/b733 /packages

OptimizationFlags=+01

DebugFlags=-g -y -D_DEBUG -. iDEBUG

InliningFlags=

DefineF1ans=-DKERNEL -DPRODUCTION_ VERSION -DNATURAL ALIGNMENT -D_HPUX SOURCE
Compile ags=-Aa +wWl +z -C

OSReleaseLevel=+DAportable

LinkF1l " -z -B symbolic -L/usr/oneworld/BDEV/b733/system/lib -ljdesaw
LinkLi =

multanecussuil
[UBE]

UBEDebugLevel=0

[DB SYSTEM SETTINGS]
Version=43

Default User=JDESVR
Default Pwd=

Default Env=XDEVHPO2
Default PathCode=PROD
Base Datasource=ORACLE SVR
Object Owner=JDESVR
Server=corowsnl
Database=owsnldevl

Load Library=libora73.sl
Decimal Shift=Y

Julian Dates=Y

Use Owner=Y

Secured=Y
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[LOCK JER]
Server=hpcluster
AvailableService=TS
RequestedService=NONE

[SERVER ENVIRONMENT MAP]
ADEVASD1=ADEVHPO1
ADEVASD2=ADEVHPO2
ADEVNAOl1=ADEVHPO1l
ADEVNAQO2=ADEVHPO2
ADEVNAS1=ADEVHPO1
ADEVNAS2=ADEVHPO2
ADEVNIS1=ADEVHPOl
ADEVNIS2=ADEVHPO2
ADEVRSO1=ADEVHPO1
ADEVRS02=ADEVHPO2
ADEVCLA1=ADEVHPO1
ADEVCLA2=ADEVHPO2
PDEVASD1=PDEVHPO1
PDEVASD2=XDEVHPO2
PDEVNAO1=PDEVHPO1
PDEVNAO2=XDEVHPO2
PDEVNAS1=PDEVHPO1
PDEVNAS2=XDEVHPO2
PDEVNIS1=PDEVHPO1
PDEVNIS2=XDEVHPO2
PNFLGQ] =pnTUyYpOl
P 02=X iPO2
PDEVCLA1=PDEVHPO1
PDEVCLA2=XDEVHPO2
PDEVHPO2=XDEVHPO2

[ 'URITY]
User=JDESVR
sword=

veraultEnvironment=XDEVHPQ2
DataSource=0RACLE PVC B733
SecurityServer=hpcluster
ServerPswdFile=FALSE
History=0

J t]
PrimaryNode=hpcluster

[JDEITDRV1

sl
v.sl
Drv3=JDENET:1libjdetrdrv.sl

[Interoperability]
RealTimeEvents=*ALL
SaveDoc=0
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sibrary=JDBTR
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server=hpciuscer2

AvailableService=TS
RequestedService=NONE

[SERVER ENVIRONMENT MAP]

ADEVASD1=ADEVHPO1
ADEVASD2=ADEVHPO2
ADEVNAO1=ADEVHPO1
ADEVNAO2=ADEVHPO2
ADEVNAS1=ADEVHPO1
ADEVNAS DEVHPO2
ADEVNIS1=ADEVHPO1
ADEVNIS2=ADEVHPO2
ADEVRSO1=ADEVHPO1
ADEVRSO2=ADEVHPO2

VCLA1=ADEVHPO1l
AVLKVCLA2=ADEVHPO2
PDEVASD1=PDEVHPO1
PDEVASD2=XDEVHPO2
PDEVNAO1=PDEVHPO1
PDEVNAO2=XDEVHPO2
PDEVNAS1=PDEVHPO1
PDEVNAS2=XDEVHPO2
PDEVNIS1=PDEVHPO1l
PDEVNIS2=XDEVHPO2
PDEVRSO1=PDEVHPO1
PDEVRSO2=XDEVHPO2
PDEVCLA1=PDEVHPO1
PDEVCLA2=XDEVHPO2
PDEVHPO2=XDEVHPO2

!
User=JDESVR
Password=JDESVR

1 11t Environment=XDEVHPO2
DataSourc RACLE PVC B733
SecurityServer=hpcluster2
ServerPswdFile=TRUE

History=0

[CLUSTER]

PrimaryNode=hpcluster2

rInETmnqv]
=3
vrvi=z:1ibzdrv.sl

Drv2=RT:librtdrv.sl
Drv3=JDENET:libjdetrdrv.sl

[Interoperabilityl

RealTimeEvents=*ALL

SaveDoc=0
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Additiona”™ "z PT: _ offersaF" ' Availability Implement "1 1 1 /s
who wish ify their Windows . . . applications with Microsoft _. s

Contact the Partner Technology Access Center for more information about these and additional services.

HP Partner Technology Access Center
W 120 C  ury Road

Paramus, NJ 07653

USA

Tel: (1) 516-753-3406
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Notes:
e _..isis an example scenario. Timing and process progression will be different __r each ISV.
o | 7 wisl n to his application, the ISV must supplyt : t «chi TI

~ =2~ :23b Wi proviae ro aispray monitors and PC keyboards.
e The ISV must provide all non-HP-UX material on 4mm DAT tape or CD-ROM. The PTAC HA Lab servers
are on a private subnet, and cannot contact machines outside of the PTAC HA Lab.

r More Information...
To receive the PTAC HA Certification Services Package, leave your name and Telnet at 1/516-753-3406, along
with the name of your ISV.
Once vou have received and examined the PTAC HA Certification Services Package, you will want to schedule
thel ..\C lab, as well as a PTAC High Availability engineer. To do so, please leave your name, Telnet, ISV
name and timeframe desired, on 1/516-753-3406.

Questions about this process and the PTAC HA Certification Service may be directed to:

Hewlett-Packard Company

Walt Saiko

Partner Technology Access Center
W 120 Century Road

Paramus, NJ 07653

USA

Tel: (1) 301-258-5974
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Integrations with Other Applications
In This Chapter

In This Chapter

This chapter gives detailed inf tion on how to int« _  te the following
applications with Data Protector:

“Cluster Integrations with Data Protector” on page 613

“Microsoft Cluster Server Integration” on page 617
“MC/ServiceGuard Integration” on page 627

“Veritas Cluster Integration” on page 640

“Data Source Integration (DSI)” on page 644

“Application Response Measurement (ARM) Integration” on page 646
“ManageX Integration” on page 648

“Access Points for System and Management Applications” on
page 649

Forinfc  tion on integrations with other applications, such as
Microsott SQL, Oracle8, and many more, refer to the HP OpenView
Sto tor In on Guide. ] f supported
integrauons, see tne Data Protector documentation overview in the
preface of this manual.

S :functionality is subject to specific Data Protector licenses. See the
HP OpenView Storage Data Protector Installation and Licensing Guide
for details.
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Cluster Integrations with Data Protector

In MSCS environment, Cluster Service components (for example,
Database Manager) maintain a coherent image of the central cluster
database, which stores information regarding changes in the status of a
node, resource, or group. Cluster database must be stored on the cluster’s
shared disk volume.

Cluster-Aware Databases and Applications

Data Protector integrates with cluster-aware applications that have
already been installed on the cluster as virtual servers, by using the
application’s virtual server configuration.

To back up the cluster-aware application, use its virtual server name
when configuring the backup specification.
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Microsoft Cluster Server Integration

Cell Manager on Microsoft Cluster Server

The Data Protector Cell Manager can be installed on the 32-bit Microsoft
Cluster Server. This enables an automatic migration of the Data
Protector services from one cluster node to another in case of failover.

See the HP OpenView Storage Data Protector Installation and Licensing
Guide for more information on how to install Data Protectorc er C ™
Manager.

After setup finishes, the Data Protector cluster cell has the following
systems automatically added:

¢ Al cluster nodes

e All cluster virtual servers

Clients on Microsoft Cluster Server

Data Protector can back up a full cluster (local and shared disks) and
applications running in a cluster environment.

To back up a cluster-aware application the Data Protector chient software
must be installed locally on all the cluster nodes. See th¢ "™ OpenView
Storage Data Protector Installation and Licensi. Guide tor information
on how to install a cluster-aware client.

After the installation, virtual server hostname of the client must be
imported to the = "a Protectorcell ~ etheF ire 13-2onpa; 319 and
the HP OpenView Storage Data Protector Installation and Licensing
Guide for instructions.

II . want an application backup to be cluster-aware, that is, access it
through its virtual server, also this application integration module has to
be installed on each application preferred owners (nodes). Only this way
the Data Protector integration agents can start on cluster nodes where
the application currently resides.
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Figure 13-2 Importing Cluster Virtual Server Hostnames to a Cell on
Microsoft Cluster Server

Backing Up Data Cluste (M -

When backi: ap data that reside on cluster node ¢ you need to
distinguish betw:

e Local cluster node disks
e Shared cluster node disks

In the Data Protector GUI, you can see only local disks listed for each
clusten  de. On the other hand, you can see cluster virtual server items
that contain only shared disks for the group in which they are defined.
This prevents creation of a backup specification for backing up shared
disks. Such backup would fail in case the shared disks are not available
on a specific cluster node.
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To distinguish between local cluster node disks and shared cluster node
disks, Data Protector queries the MSCS database for a list of physical
cluster disk resources. All cluster disks presented as proprietary cluster
disk resources (e.g. NetRAID 4 disk type) are treated as local cluster
node disks.

However, when creating a backup specification, you can see three or
more systems that can be backed up:

¢ Primary node (selected when backing up local disks)
¢ Secondary node(s) (selected when backing up local disks)
¢ Virtual server(s) (selected when backing up shared disks)

Backing Up Local Disks
To back up cluster local disks, proceed as follows:

1. Install and configure the Data Protector Disk Agent and cluster
component on each cluster node that has the local disks you want to
back up.

2. Configure a backup snecification for specific cluster node and select
which of its local dis  you want to back up.

acking Up Shared Disks

To back up cluster shared disks, proceed as follows:

1. Install (local™™ the Data Protectar ¢ lient software on each
cluster node. .2 the ... Jpe  __w Data Protector
Installation and Licensing Guide for instruct .

2. Import virtual server hostname ("~ rosoft Clu:~ ~ rver
Data Protector cell. See the HP OUpenVi  Stor ita Protector
Installation and Licensing Guide for instructions.

3. Configure a backup specification for the virtual server and select the
shared disks you want to back up.

Managing Cluster-Aware Backups

In the Data Protector cluster Cell Manager, the backup session is
cluster-aware. You can set options that define backup behavior if a
failover of Data Protector or other cluster-aware applications occurs.
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Failover of Data Protector

If a failover of the cluster-aware Data Protector occurs during backup, all
running and pending backup sessions fail. In the Data Protector GUI
and in the backup specification, you can set one of the options that define

automatic backup session restart at failo  f Data Protector. See
F ‘onpa, 3
Automating Restart of Failed Sessions Tom« =~ ab

specification, either filesystem or integration, so that the running
backup sessions are automatically restarted at failover of the Cell
Manager, perform the following steps:

1. Inthe HP OpenView Storage Data Protector Manager, switch
to the Backup context, expand the Backup Specifications item,
and select the backup specification that you would like to modify.

2. Inthe Results Area, click Options.
3. Under the Backup Specification Options, click Advanced.

4. Inthe Backup Options window, click Clustering and select one of
the Automatic session restart options.
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Figure 13-3

Do not Restart
Backups At
| over

Restart Rackup of
. ~ilec _jects

Restart Backups
of All Objects

Integrations with Other Applications
Microsoft Cluster Server Integration

Advanced Backup Specification Options-Clustering

When the Do not restart backups at failover option is selected,
sessions that failed are not restarted. This is the default option.

The Restart backup of failed objects option is only valid for a

filesystem backup specification and specifies that completed ¢ «cts

within the filesystem backup specification will not be restarted. Only

objects that failed nding  the of tl will

be restarted. This can minimize the backup time in case failover occurs
ter some backup objects have been completed.

The Restart backups of all objects option is valid for both
filesystem and integration backup specifications. When this option is
selected, the entire session will be restarted after failover, including the
objects that have been completed.
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Failover of Application Other Than Data Protector

As the Data Protector cluster Cell Manager is a storage application
within a cluster environment, it has to be aware of other applications
that might be running within the cluster. If they are running on a node
other than Data Protector and if some application fails over to the node
where Data Protector is running, this will result in a high load on this
node. The node that previously managed only backupop  ‘ons has now
to handle critical application requests as well. Data Protector allows you
to define what should happen in such a situation so that the critical
application data is protected and the load is balanced again. You can:

¢ Abort all running backup sessions
¢ Abort specific running backup sessions

¢ TInhibit the Data Protector cluster Cell Manager for a specific time
frame

Aborting All Running Sessions If the backup is less important than
the application, Data Protector can automatically abort all running
sessions to balance the load after failover of the application.

To define this option use the omniclus ¢ ". This s

as part of a script that is run when a failover ot the appncation occurs.

You need to create this script in advance and define it as a new resource
_ rin the applica~ group.

To create the script that will abort all running sessions at failover of the
application other than Data Protector, perform the following steps:

1. Inthe <Data Protecto Tome>\bin directory create a batch file
with the following commana line:

ol -cl Proi  tor virt . ve
- bortsess

The * wild card represents all sessions. It can be replaced with the name
of a specific backup specification in order to abort only this specific
backup session.

2. Open the Windows Cluster Administrator and add a new resource to
the application group. For Rescurce type select Generic
Application. For Possible owners select the node on which this
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script will be run. This is the node where Data Protector is running.
In the Generic Application | mete: window, entertl »ath
name of batch file (for example,
c:\program files\omnibark\hin\clus.bat) and directory of the
omniclus command. This X

‘ta_Protector home>\bin direciory.

To abort all running sessions on the server obsv.company.com use the
following command line:

omniclus.exe -clus obvs.company.com -session * -abortsess

To abort only session from a backup specification backup_1 on the server
obsv. company . com use the following command line:

omniclus.exe -clus obvs.company.com ~-session backup 1
-abortsess

Aborting Running Sessions Based on a Logical ID If a specific

rumi g ba  _ session is more important than the application, Data
Protector can continue this session. To balance the loac ~er a failover,
you can abort all backup sessions except an important one using its abort
" You define this option by using the Data Protector GUI and scripting.

Proceed as follows:

Data Protector GUl 1. In the Data Protector GUI, modify the backup specification with the

Command Line

following steps:

a. Inthe HP OpenView Storage Data Protector Manager,
switch to the Rackin rontaxt, expand the Backup
Ei ud select the backup specification that
you would not like to be aborted at failover of the application.

b. Inthe ..sults Area, click Options.
¢. Under Backup Specification Options, click Advanced.

d. Inthe Backup Options window, click Clustering. Select Check
against abort ID and enter a backup specification ID that will
represent this specification and will be used in the command line.

2. In the batch file, modify the omniclus command as follows:

omniclus.exe -clus <Data Protector virtual servers
-session <backup specification> -abortsess -abortid
<logical operator ID>
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In the Data Protector GUI you have configured a backup specification
with abort ID = 10. Use the following command line to abort all backup
sessions except one with abort ID = 10 on the server obsv.company. com:

omniclus.exe -clus obvs.company.com -session * -abortsess
-abortid != 10

Aborting Sessions Based on Elapsed Session Time To balance the
load after a failover you can abort backup sessions based on how long
they have already been running. If a specific running backup session is
just ending, Data Protector can continue the session. If * 2 backup
session has just started and if it is not important, Data Protector can
abort the session. You define this option by using the Data Protector GUI
and scripting.

Proceed as follows:

Data Protector GUI 1. In the Data Protector GUI, modify the backup specification with the

Comr

id Line

following steps:

-

a. the HP OpenView Storage ta Protector Manager,
switch to the Backup context, expand the Backup
Specifications item, and select the backup specification that
you would like to be aborted based on elapsed session time.

b. In the Results Area, click Options.
c. Under Backup Specification Options, click Advanced.

d. Inthe Backup Options window, click Clusterir Select Abort
if less thanorAbort if more than and enter the mii es
that will represent this specification. It will be aborted if the
specified condition is fulfilled when a failover occurs.

2. In the batch file, modify the omniclus command as follows:

omniclus.exe -clus <Data Protector virtual server>
-session * -abortsess
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When the con  ind is run, the elapsedt  : for each backup
specification is checked and the session is aborted if the specified
conditions are met. For example, in the Data Protector GUI specify that
the backup specification is aborted if it has been running for less than 30
minutes. When the failover occurs and when the omniclus command is
started, the session is aborted if it has been running for lesst! 30
minutes, otherwise it continues.

Temporarily D7 “ling Backup Sessions To balance the load after
a failover, you can aiso disable the Cell Manager for some time. All
running session are continuing but you cannot start new backups until
the Cell Man.  ris enabled again. You define this only by using
scripting.
In the batch file, modify the omniclus command as follows:

1iclus.exe -clus <Data Protector virtual server> -inhibit
minutes
To disable new backups on the server obvs . company . com for 20 minutes,
use the following command line:
omiclus.exe -clus obvs.company.com -inhibit 20

To disable new backups until the Cell Manager is enabled again, use the
following command line:

omniclus e -clus ob com 1y.com -inhibit
To enable backups again, run the following command line in CLI:

otector home>\bin niclus -clus obvs.company.com
0]
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MC/ServiceGuard Integration
As part of its high-availability st~ rt, Data Protector provides a full

integration of the Data Protector Cell Manager with MC/ServiceGuard
on HP-UX systems. For details on supported operating system versions,
supported conf _ -afions, and level of cluster support, refer to the HP

OpenView Storage Data Protector Software Release Notes.

This section provides specific information for integration of Data
Protector and MC/ServiceGuard.

It is assumed that you are familiar with clustering concepts and concepts
related to MC/ServiceGuard.

Refer to the following manuals for more information:

* Managing MC/ServiceGuard for more information on
MC/ServiceGuard.

e HP OpenView Storage Data Protector Installation and Licensing
Guide for more information on how to install Data Protector.

» HP OpenView Storage Data Protector Software Release Notes for last
minute information on the current Data Protector release.

When you purchase a license for the = ta Protector Cell Manager, note
that the license will be bound to the cluster package and will work
regardless of which physical node inside an MC/ServiceGuard cluster

ns the Data Protector Cell Manager, so 1 the package is running
ononeof = nodes.

Cell Manager on MC/ServiceGuard

¢ In an MC/ServiceGuard cluster environment, a Data Protector Cell
Manager should have its own package. Before installing Data
Protector Cell Manager on MC/ServiceGuard, you need to get the
following information from your network administrator:

— Package name or virtual hostname
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2. Create a logical volume for that group (for example,
/dev/vg_ob2cm/1v_ob2cm), with the following steps:

a.

Create a new logical volume:
lvcreate -L 100 -n lv_ob2cm /dev/vg  ‘cm

The number 100 presents the size of the partition in MB. The
etc/opt/omni and var/opt/omni Data Protector directories will
be located there.

Create a journaled filesystem on the logical volume:

newfs -F vxfs /dev/vg ob2cm/rlv_ob2cm

If you want to mirror the new logical volume, refer to the HP-UX LVM
documentation on the confitr t  steps.

3. Set volume group properties according to the cluster documentation,
with the followi steps:

a.

Deactivate the volume group from regular mode:
vgchange -a n /dev/vg_ob2cm
Mark the volume group for the cluster use:

vgchange -c y /dev/vg_ob2cm

If this is a cluster lock disk and you are using a later version of
M__. ServiceGuard like 11.09, this is done automatically.

C.

Use the volume group in the exclusive mode:

vgchange -a e /dev/vg_ob2cm

4. Mount the logical volume to a directory (for example, /omni_shared),
with the following steps:

a. Create a mount point directory:

b.

mkdir /omni_shared

Mount the filesystem to the mount point directory:
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mount /dev/vg_ob2cm/lv_ob2cm /omni_shared

5. Modify the /etc/opt/omni/sg/sg.conf template file.

IMPORTANT The SHARED DISK ROOT variable must contain the .me of the mc
point directory (for example, SHARED DISK ROOT=/omni_shared).

The Cs_SERVICE HOSTNAME variable must contain the name of the
virtual Cell Manager, as it is known to the network. Ea * jackage in the
cluster requires its own virtual IP address and its network name (for
example, CS_SERVICE HOSTNAME=ob2cl.company.com).

6. Configure the Primary Cell Manager. Make sure not to be positioned
in the /etc/opt/omni/ or /var/opt/omni/ directory or their
subdirectories when running the geript. Make also sure to have no
mounted subdirector  in the .¢/opt/omni/ or /var/opt/omni/.
Run: '

/opt/omni/sbin/install/omniforsg.ksh -primary

Note that after running this script, the Data Protector services are
stopped and will be restarted later on.

. Unmount the mount point directory (Data Protector shared
directory):

umount /omni_s! -ed
8. Deactivate the volume group you created:
vgchange -a n /dev/vg_ob2cm

9. ...port the volume group you created on the Primary Cell Manager
with the following  eps:

a. From systeml (Primary Cell Manager) export the LVM
configuration information with map file /tmp/lvm map:

vgexport -p -m /tmp/lvm map /dev/vg ob2cm
b. Transfer the map file over to system2 (Secondary Cell Manager):
rcp /tmp/lvm map second system:/tmp/lvm_map

Configuring the To configure the secondary Cell Manager on system2, proceed as follows:

Secondary Cell
Manager
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1. Onsyst !setup the volume group to be imported, with the
following steps:

a. Create a directory for the volume group to be imported:
mkdir /dev/vg_ob2cm

b. List all existing volume groups on the system to look for the next
available minor number:

11 /dev/*/group
c. Create a group file for the volume group:
mknod /dev/vg_ob2cm/group ¢ 64 0x010000
d. Import the vol __ with pfile /i 'lvm_map:

vgimport -m /tmp/lvm map -v /dev/vg_ob2cm
/dev/dsk/c0t1d0 /dev/dsk/c1t2d0

2. Set volume group properties according to the cluster documentation,
with the following steps:

a. Mark the volume group for the cluster use:

vgchar -¢ y /dev/vg_ob2cm

NOTE If this is a cluster lock disk and you are using a later version of
MC/ServiceGuard like 11.09, this is done automatically.

b. Use the volume group in the exclusive mode:
vgchange -a e /dev/vg_ob2cm

3. Mount the logical volume to the mount point directory, with the
following steps:

a. Create the same mount point directory as you have created on the
Primary Cell Manager (/omni shared):

wkdir /omni_shared
b. Mount the filesystem to the mount point directory:
mount /dev/vg _ob2cm/lv_ob2cm /omni shared

4. Configure the Secondary Cell Manager:
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. Create the directory in the /etc/cmcluster directory that will hold

the Data Protector package:
mkdir /etc/cmcluster/ocb2cl

. Change to the /etc/cmcluster/ob2cl directory:

cd /ete/cmcluster/ob2cl

. Create a package configuration file in the Data Protector package

directory:
cmmakepkg -p /etc/cmcluster/ob2cl/ob2cl.conf

. Create a package control file in the Data Protector package directory:

cmmakepkg -s /etc/cmcluster/ob2cl/ob2cl.cntl

. Modify the Data Protector package configuration file (for example,

/ete/cmeluster/ob2cl/ob2cl. conf). Refer to the example of this
file in “Example of the Package Configuration File” on page A-28.

In this file, modify the following fields:

* DACKAGE NAME
Enter the Data Protector cluster package name. For example:
PACKAGE NAME ob2cl

¢ NODE NAME

“aterther  esoftl nodes. First enter the name of the primary
(original) node, then the name(s) ~the secor © node(s). For
example:

NODE NAME partizan
NODE_NAME lyon

* RUN SCRIPT, RUN SCRIPT TIMEOUT, HAL™ "CRIPT,
HALT SCRIPT TIMEOUT

Enter the name of the Data Protector package control file (script)
and adjust the timeout for the execution of the script. By default,
there is no timeout. For example:

RUN_SCRIPT /etc/cmcluster/ob2cl/ob2cl.cntl/
RUN SCRIPT TIMEOUT NO TIMEOUT
HALT SCRIPT /etc/cmcluster/ob2cl/ob2cl.cntl/

HALT SCRIPT TIMEOUT NO TIMEOUT
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SERVICE NAME, SERVICE FAIL, FAST ENABI
SERVICE HALT TIMEOUT

Enter the service information. For the service name, you can enter
any name but note that you will use the same name in the control
file afterwards. For example:

SERVICE NAME omni_sv

SEVICE FATL FAST ENABLED NO
SERVICE HALT TIMEOUT 300

SUBNET

Enter the subnet of the cluster. For example:

SUBNET 10.17.0.0

8. Modify the Data Protector package control file (for example,
/etc/em~luster/ob2cl/ob2cl J.Re othe Ole of this
file in __ample of the Package Control File” on page A-38.

In this file, modify the following fieh

Modifyina the o
Contro. . .le

VG [n]

Specify the volume group used by this package. For example:
VG [0] = /dev/vg_ob2cm

LV [n], FS [n], FS_MOUNT OPT [n]

Specify the logical volume and filesystem mount information:
v [0] = /dev/vg ob2cm/1v_ob2cm

FS [0] = /omni_shared

FS MOUNT OPT[0]=" *

1P, SUBNET

Specify the IP and the subnet information used by this package.
For example:

IP [0] = 10.17.3.230
SUBNET [0] = 10.17.0.0
SERVICE_NAME, SERVICE_CMD, SERVICE RESTART

Specify the service name, command, and restart parameters.
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When using the Data Protector GUI, import each cluster package as a
client. See Figure 13-4 on page 638 and the HP OpenView Storage Data
Pro I allation and Licensing Guide fori  ructic

Importing an Application Cluster Package to a Cell on
MC/ServiceGuard

Backing Up Data in a Cluster (MC/SG)

- -.is section provides an overview of how to back up specific data in a
cluster environment. For additional information on backing up data in a
cluster, see “Backing Up Data in a Cluster (MSCS)” on page 619.
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When backing up a virtual host, the object ownership will acquire the
ownership of the stationary host on which the cluster package is
running. Therefore, when a failover occurs, the same object backup is
showing a different ownership. To avoid this, set the ownership in the
backup specification to the virtual host.

Backing Up Local Disks
To back up cluster local disks, proceed as follows:

1. Install and configure the Data Protector Disk Agent component on
each cluster node that has the local disk(s) you want to back up.

2. Configure a backup specification for specific cluster node
physical node name and select which of its local disks you want to
back up.

Backing Up __ared Disks
To back up cluster shared disks, proceed as follows:

1. Install (locally) and configure the Data Protector cluster client
software on all the cluster nodes. See the HP OpenView Storage Data
Protector Installation and Licensing Guide for instructions.

2. Import cluster package to the Data Protector cell.

3. Config 1 backup specification and select the virtual host. Define
the shared disks you want to back up.

About Backing Up Database Applications

ion in this section is valid for backiy 1p ase

in tl et Zell Manager. kup or tne
appucanon fails 1t 1t runs on a ditterent node than the Cell Manager. It is
highly recommended to configure the application and the Cell Manager
in the same package.
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1. Install the Data Protector Disk Agent on each system with the local
disk you want to back up.

2. Configure a backup of the local system in the cluster and define the
local disks you want to back up.

I <ing Up Shared Disks

A shared disk can only be backed up as a local disk, as described above.
It can however be backed up from any of the cluster nodes between which
it is shared.

For ¢ e, to back up ¢ &7 ed b wo nodes:
1. Install the Data Protector Disk Agent on each system that shares the
disk.

2. Define a backup specification for the disk as a “local disk” on each
system.
3. Ifyou want to safeguard the backup of the shared disk further, you

could create a post-exec within each backup specification that checks
for errors and starts a backup on the other system, if the first fails.
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2. Configure a backup of the local system in the cluster and define the
local disks you want to back up.

Backing Up Shared Cluster - vols

A cluster shared pool can only be backed up via the virtual server. When
the virtual s zris selected for backup, only cluster shared pools are
displayed as available pools for backup.

example, to back up a pool shared between two nodes:
1. Install the Data Protector Disk Agent on each system that shares the
pools.
2. Import the cluster virtual server into the cell.

3. Create a backup specification that includes all pools on the virtual
server 8 the backup.
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Data Source Integration (DSI)

The Data Source Integration (DSI) allows you to use the HP OpenView
Performance Agent to log data, define alarms, and access metrics from
sources of data other than the metrics logged by the HP OpenView
Performance Agent scopeux collector. Data Protector provides a sample
script and configuration file that show you how to use the Data Protector
reporting command-line interface with Data Source Integration to log
data about the Data Protector environment, and backup and restore
sessions.

~ me ples of what can be measured using the DSI integration are:

Database size
e Media usage

Media status

N1 er of syst

Amount of data per system

Full and incremental backup 1 ires.

In order to use DSI, you have to:

e Identify what data you want to log
e Write a script to query data from Data Protector

Set up a class specification file

Compile the class specification file

Start the logging process.

Data Protector provides a sample Korn shell (ksh) script and class
specification file that, by default, log two metrics: the number of clients
in cell and the size of IDB size. The script and class specification file can
be easily modified for collecting other information from Data Protector.
The scripts are supported on UNIX systems.

To configure the Data Protector DSI integration, follow these steps:

1. Write a script to collect data.
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First select which data you want to log. Data Protector provides a
reporting command omnirpt located in the /opt/omni/bin/
directory. This command can be used to gather various information
about the Data Protector environment. See the omnirpt manpage for
more information on the command. Secondly, write a script that in an
infinite loop queries for the selected data and writes it to standard
output.

2. Create the class specification file.

The class specification file defines what data you want to log and how
you want it to be logged. Data Protector provides a sample class
specification file obdsi.spec in the /etc/opt/omni/dsi directory.
Refer to the DSI manual for the complete s ax of the class
specification file.

3. Compile the class specification file.

Use the sdlcomp command from the /opt/perf/bin directory to
compile the class specification file. In order to compile the Data
Protector sample class specification file, use:

sdlcomp obdsi.spec OmniBack.log OmmiBack
4. Configure perflbd.rc

Before you start modifying perflbd.rc file, you have to stop the
mwa services. You do this using the following command:

/opt/perf/bin/mwa stop

Now you can edit the file /var/opt/perf/perflbd.rc. If you are
configuring Data Protector sample s, add the following line to
the file. Note that this has to be added as a single line:

DATASOURCE=OMNIBACKII
LOGFILE=/etc ./ i/dsi,

5. Start the logging process.

Start the script that collects your data and pipe its output using
dsilog command. In case of Data Protector sample metrics, use the
following command (in one line):

obdsi.ksh | /opt/perf/bin/dsilog OmniBack.log OMNIBACKII
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Application Response Measurement {ARM) Integration

4 ___icatic__ Response Measurement (ARM)

P S Sha

Integration

Data Protector supports the emerging standard for measuring the
response time of transactions in distributed environments, the
Application Response Measurement (ARM) interface. Data provided by
Data Protector can be used in ARM-compliant system management and
monitoring tools, such as HP OpenView Performance Agent. Such tools
can log this information for trend analysis, reporting, or alert-baced
notifications. The collected data can be viewed and analyzed by ...
OpenView PerformanceManageror some other tool.

For the installation, all you need is the ARM 2.0 compatible RPM agent
and the ARM 2.0-compliant library installed on the Cell Manager. It
does not matter whether you install them before or after the  ta
Protector installation.

With a UNIX Cell Manager, you need to replace the dummy library
/ =/omni/lib/arm/libarm.sl (HP-UX) or
Jupc/omni/lib/arm/libarm. so (Solaris) with the appropriate ARM
library that actually logs transactions, or create a link to it. It is
recommended to create a link. For example, in case of HP OpenView

1 a1 Agent on an HP-UX 11.x Cell Ma you need to link the
above mentioned file to the /opt/: */1ib/1 .s1fi Note ~
the /opt/perf/lib/libarm.sl file inks to 1: 0:

Windows Cell Managers require no additional steps for setting up the
ARM Integration.

The following information can be  asured with ~ ARM integration:

® Overall session duration

e Disk Agent read times

¢ Disk Agent network write times

¢ Media Agent network read times

¢ Media Agent data write times

¢ Session Manager write to database time

¢ Database purge duration
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The following table shows the supported ARM transactions:

Table 13-1 ARM Transactions
Transaction Name Additional Transaction
Infi ation De: i
BS-<Backup specificat | Time Duration of a
ion> backup session
RS-<Session ID> Time Duration of a
restore session
BO-<object_names> Time Duration of a
backup of a
specific object
DP Number of purged | Duration of the
re s 1 3
size (MB)
DC IDB size (MB) Duration of the
IDB check
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checking and maintenance mechanism. For more information on Data
Protector checking and maintenance mechanism, refer to “Data
Protector Checking and Maintenance Mechanism” on page 605.

On HP-UX and Solaris, there are two Data Protector files residing on the
Cell Manager, that specify the behavior of Data Protector SNMP traps:

® /etc/opt/omni/snmp/OVdest

This file contains the names of the systems to receive the Data
Protector SNMP traps. It has the following format:

trap st: <hostnamels>

trap-dest: <hostname2>

® /etc/opt/omni/snmp/OViilter

This file contains the severity level of the Data Protector SNMP trap
messages that are to be filtered out (will not be sent by Data
Protector). It has the following format:

<message level>

<message level>

Where <message levels can be any of the following: (normal |
| S | it 1.

On Windov ams, the destination et in the Windows SNMP
s cecon _ ion.

On Windows systems, you need to configure the SNMP service first. For
information on how to configure the Windows SNMP service, refer to
“SNMP Send Method” on page 349.

The SNMP traps sent by Data Protector contain the following
information:

e Enterprise Event ID
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Command-Line Interface, Graphical User Interface and Web
Reporting Interface

The Data Protector CLI provides comparable functionality as it is
provided in Data Protector GUI. Using the Data Protector CLI you can:

e Start the Data Protector GUI and sub-GUIs. For a list of the Data
Protector sub-GUTISs, refer to “Graphical User Interface” on page 6.

e Configure and start Data Protector actions such as backup, restore
and IDB purge. For a list of possible Data Protec”  actions, refer to
Appendix, “Data Protector Commands,” on page A-7.

¢ Configure and start Data Protector renorts using the Data Protector
.CLl L1 tion about reporting, refer
to “Data Protector Reporting” on page 315.

¢ Start the Java user interface to configure and start Data Protector
reports. For more information about web reporting, refer to
“Configuring Reports and Notifications on the Web” on page 353.

You can use Data Protector commands for scripts that provide the input
data to System and Application Management application.

Data Protector Log Files

Some stem and Application Manag applications, such as HP
OpenView Vantage Point Operations, allow you to specify when and
which log files should be monitored for a specific log entry. 3
specified entry is detected in t|  ile, an action can be specitied. In VPO
this is called Log file encapsulation.

You can configure such = Svetem and Appl  ion Manag nt
application to monitol - .t . .otector log files for specific log entries
(Data Protector events) and define an action that is to be executed in
case a particular Data Protector event is detected.

. .r more information on Data . .otector log files refer to “Data Protector
Log Files” on page 550. Note that there is no log files formatting
specification provided. For Data Protector log files exemplary entries,
refer to Appendix, “Data Protector Log Files Example Entries,” on page
A-44,

Windows Application Log

Some System and Application Management applications, such as
ManageX, monitor the Windows Application Log.
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To enable automatic forwarding of all Data Protector messages and
messages about the Data Protector services (if they are stopped) to
Windows Application Log, set the EventLogMessages variable in the
Data Protector global options file to 1. For more infc ition on Data
Protector global options file refer to “Global Options File” on page 523.

1  _ es

Verifying Data Protector Processes

Data Protector provides a means of checking if its required processes are
running by the means of the omnisv -status CLI command.

...e omnisv -status command provides you with the status of the
required Data Protector processes (when the command is started).

To get the status of required Data Protector processes enter the following
command:

omnisv -status

Data Protector Health Check Failed Notification

The User Health Check notification is triggered and sent only if any of
the required processes are not running or if the IDB is not operational.
The Health Check Failec itification  default checks these conditions
every day at 12:00 (Noon) and is (if the conditions are met), by default
sent to Data Protector Event Log. Y ok e’ d
changing the DailyMaintenanceTi ible, using the twenty-rour
hour clock notation, in the Data Protector global options file. For more
information on Data Protector global options file refer to “Global Options
File” on page 523. You can also redirect the notification to be sent, for

e nple an MP tr

Tocl :ev  day at the scheduled time if the required Data Protector
processes are running and if the IDB is operational, and to be notified by
an SNMP trap if any of the processes are not running or if database is
not operational, configure the Health Check Failed notification as
described in the “Data Protector Notifications” on page 342.

To check the conditions of the Health Check Failed notification
interactively, enter the following command:

ocmnihealthcheck
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Refer to the cmnihealthcheck man page for more information on
omnihealthcheck command.

Getting the Results of the Last Night’s Backup

You can get the report on the results of the last night’s backups using the
Data Protector reporting functionality. For more information on Data
Protector reporting functionality refer to “Data Protector Reporting” on
page 315 and to the omnirpt man page - more than 30 different reports,
each having many different options, can be run.

To get the HTML report on the last night’s backup in the file
report .htwml enter the following command:

omnirpt -report list sessions -timef: 1 24 ~log
report.html
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ADIC/GRAU DAS and STK ACS Libraries
In This Chapter

In .ais Chapter

This chapter assumes that you have already physically configured the
ADIC/GRAU or STK library. If you have not done so, refer to the

d at that es with the AD.  GRAU or STK library for
instructions on configuring the library. For a list of supported DAS
software versions, refer to HP OpenView Stora, Data Prot  r Software
Release Notes.

This chapter has been divided into three sections: an overview of general
concepts, the ADIC/GRAU DAS library, and the STK ACS library. The
first section covers concepts common to both libraries, including
diagrams of both library configurations with Data Protector, and media
management basics. Ther “sect” orovi® detailed instruction on
installing and configuring the ADIUn«RAU nibrary, and the last section
provides detailed instruction on installing and configuring the STK ACS
library. The ADIC/GRAU and STK library sections are structured in the
following order:

“ADIC/GRAU DAS and STK ACS Integrations” on page 657.
“The ADIC/GRAU DAS Library Device” on page 662.
.6 STKACS{ ~  rary Device” on page 680.

“Troubleshooting Library Installation and Configuration” on
page 697.

The ADIC/GRAU and STK functionality is subject to specific Data
Protector licenses. See the HP OpenView Storage Data Protector
Installation and Licensing — "¢ = =~
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ADIC/GRAU DAS and STK ACS Integratior

Typically, the Data Protector and ADIC/GRAU DAS or STK ACS
integration is necessary in complex environments where the amount of
backed up data is exceptionally large and, therefore, so is the amount of
media needed to store the data. The ADIC/GRAU and STK libraries are

t only capable of managing large amounts of n " 'a, they are also
capable of managing media used by different applications, not just Data
Protector.

__ta. tec des ls he ADIC/GRAU D/ and tl

STK ACS Library Systems. Since these libraries man media :d by
different applications, you have to configure which media you want to
use with Data Protector, whi~h media you want to track, and which
drives you want to use with _ ata Protector. The lowis lii ms
represent the two library integrations:
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Figure 14-2

ADIC/GRAU DAS and STK ACS Libraries
ADIC/GRAU DAS and STK ACS Integrations
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Initializing Other
Formats

Drive Cleaning
Support

K
ADIC/GRAU DAS and SI1K ACS

hyoucanc  ze the label and exclude the barcode “ier, this
18 not recommended. ILn this case you should manually keep track of the
actual barcode and the medium label you assigned to the medium.

If Data Protector recognizes some other media data format or media that
have been used by another application, it will not initialize these media
unless the Force Operation option is selected. Data Protector
recognizes the following data formats and media used by other
applications: tar, cpio, Fbackup, FileSys, Ansi and OmniStorage.

The ADIC/GRAU DAS and STK ACS libraries can automaticallv clean
their drives after the drive has been used a set number of times. ...is is
nol commended, as lil  y built-in drive cleaning interrupts the
session, causing it to fail. If you want to use the library’s cleaning
functionality, you have to ensure that drive cleaning is performed when
no 210 ns are :

For more information on drive cleaning methods, refer to “Drive
Cleaning” on page 61.

Additional Media Management Tips

Remember the following list of tips when you begin to use Data Protector
with the GRAU DAS or STK ACS device.

e (Create at least one media pool for each media type, for example, one
for 4mm and one for 3480 media type. Depending rour
environment, you mav want to create more media pools, for example,
one for each depar nt. e HP OpenView S ge Data Protector
Concepts ...ide for more information on how to plan your media

ols.

e TUse Data Protector commands to handle media. If you handle media
manually using ADIC/GRAU DAS or STK ACS commands, Data
Protector will not be able to track the changes in location or
information on the media.

¢ Manage the whole library with Data Protector. This provides
single-point administration where you can track Data Protector and
non-Data Protector media in the library.

e Make sure that Data Protector and other applications do not use the
same set of media.
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ADIC/GRAU DAS and STK ACS Libraries
The ADIC/GRAU DAS Library Device

This applies to HP-UX and Windows.

For further questions on the configuration of your GRAU library
please contact your local GRAU support or review your GRAU
documentation.

bk A

Data Protector providee a dedicated ANTC/GRAU library policy used to
configure an ADIC, _.__.U library witk. _ .te . . otector. You have to
install the Data Protector DAS Agent component on every system that
will be physically connected to a drive in the ADIC/GRAU library.

You need special licenses, depending on the number of drives and slots
used in the ADIC/GRAU library. See “Data Protector Licensing” in the
HP OpenView Storage Data Protector Installation and Licensing Guide
for more information.

DAS Agent includes standard Media Agent functionality, thus the Media
Agent must not be installed over an existing DAS Agent.

Installing the Media / 8

The following prerequisites for installation have to be met before
installing DAS Agent on a Windows system:

e The ADIC/GRAU library has to be cor _ured and running. e the
documentation that comes with the ADIC/GRAU library.

e Data Protector has to be installed and configured. See “Installing the
Cell Manager (CM) and Installation Server (IS)” in the HP OpenView
Storage Data Protector Installation and Licensing Guide for more
information.

¢ The following information has to be obtained before you install DAS
Agent:

v A hostname of the DAS Server (an application that runs on OS/2
host).
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The ADIC/GRAU DAS Library Device

You should see the library drives with corresponding device :s
displayed in the list.

For the HP-UX platform, install the ADIC/GRAU library for client
interface:

Copy libaci . sl shared library into the /opt/omni/1ib directory.

Installing the DAS Media Agent on an AIX System

__e following prerequisites for installation have to be met before
installing DAS Agent on an AIX system:

e The ADIC/GRAU library has to be ¢ "gured and running. See the
documentation that con ~ with the AIC/GRAU lil

e Data Protector has to be installed and configured. See “Installing the
Cell Manager (CM) and Installation Server (IS)” in the HP OpenView
Storage Data Protector Installation and Licensing Guide for more
infc  tion.

¢ The following information has to be obt = d before you install DAS
Agent:

v A hostname of the DAS Server (an application that runs on 05/2
host).

v A list of available drives with corresponding DAS name of the

3

If you have defined the _.\S Clients for your ;.. .C. _...\U system,
you can get this list with the following dasadmin commands:

dasadmin listd2 [client] or

dasadmin listd [clientl, where [client] isth¢ AS Client
for which the reserved drives are to be displayed.

Dasadmin command can be called from the C:\DAS\BIN directory
on the OS\2 host, or from the system directory:
/usr/local/aci/bin directory

v/ A list of available Insert/Eject Areas with corresponding format
specifications.
You can get the list of available Insert/Eject Areas in Graphical
configuration of AMS (AML Management Software) on OS\2 host:

1. Start this configuration from the menu Admin ->
Configuration.
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Enter the Device Name and, below, Description.

In the Client text box choose the DAS Media Agent client from the
list that will access ADIC/GRAU robatics.

Choose the GRAU DAS Library in the Device type text box. In the
DAS Server enter the hostname of the DAS Server (obtained
information during installing DAS Agent).

- ' fromthe el - Drive situation.
E. I he d tk D
Protector library is configured for (obtained information during

installing DAS Agent).
Choose ropr’ = Media Type from the list.

Using Data Protector to Configure Drives

(‘reate a . for each type of media that you will use with Data
- -otector. .... .bteps to add a drive to a ADIC/GRAU library are as
follows:

Switch to the Devices & Media context. Choose created 1
right-click Drives, and then Add Drive. Enter the Device N and
Description.

In the client text box enter the hostname where the ADIC/GRAU
media device is connec

InDa Drive enter the SCSI addr  of the device.

In the Drive Name enter the ADIC/GRAU Drive name you
remembered during installing the DAS Agent. Select the appropriate
Media Pool you created for this Drive.

Select Advanced Options to change Concurrency and other settings
as necessary. Note that the Force Direct Library Access option is
not selected by default. Turn this option off when choosing the
indirect library robotics access configuration (for more information,
see the following section, “Indirect Access to the DAS Library:
Installation and Configuration”).

Indirect Access to the DAS Library: Installation and
Configuration

This section focuses on the indirect access configuration.
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3. In the Edit menu, click Find. The Find dial box app

Use the appropriate search method to search for media.

Entering Media

Use this functionality to physically enter media into an ADIC/GRAU
DAS repository and automatically register added media as members of
the library.

1. Inthe HP Openview Storage Data Protector Manager, switch to
the Devices & Media context.

2. In the Scoping - Jne, click Devices. The list of configured devices will
display in the Results Area.

3. In the list of configured devices, click the name of the library, then
expand it to display the Drives and Slots items.

4. Click Slots to display the list of slots © he Result:

5. Right-click the slot where you want to enter the medium, and then
click Enter.

See online Help for further information.

Ejecting Media

Use this functionality to physically move selected media from the
repository into an Insert/Eject area.

1. In the HP OpenView Storage Data Protector Manager, switch to
- ices & | c

2. In the Scoping Pane : i
displayinthe R |

3. In the list of configured devices, click the name of the library, then
expand it to display the Drives and Slots items.

4. Click Slots to display the list of slots in the Results Area.

5. Right-click the slot from which you want to eject the medium, and
then click Eject Medium

See online Help for further information.
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The ADIC/GRAU DAS Library Device

The Medium Size button decides whether Data Protector will
Determine the storage size of the medium, or whether you want to
Specify the storage size of the medium. You can leave the default,
which is Determine. Click Finish.

Follow online Help for infor tion :hefor twi L

=

In the HP Openview Storage Data Protector Manager, switch to
the Devices & Media context.

2. Under Devices, expand the library device that contains the media
that you want to initialize.

3. Expand the Slots item, and then select a range of slots to initialize.

Right-click the selected range of slots, and then select Format. The
For :wizard appears.

4. In the Destination page, in the Media Pool drop-down box, select
the media pool to which the media will be assigned.

5. Click Next. The Medium Name page appears.

6. Under Medium Name, either have Data Protector Automatically
Generate a name for the medium, or click the Specify radio button
and enter a name for the medium in the accompanying text box.

7. In the informational User Location drop-down box, either enter or
select the location of the media’s user.

8. Click N | The tializing Options] :app

9. Optionally, use the Medium ¢ city button to define -
Protector will Determine the swrage size of the medium, or whether
_ 1want to Specify the storage size of the medium. You can leave
the default, which is Determine.

10. Optionally, using the Force Initialization button will
automatically initialize blank media or media in other formats
recognized by Data Protector (tar, cpio, OmniBackI, and so on). You
can leave the default. Data Protector media containing protected data
will not be re-initialized even if this option is set. The Eject option, if
set, will eject a medium from the drive after the initialization
completes.
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Follow online Help for information on specific items in the wizard.

11.Click Finish to confirm and exit the wizard.

Querying the ADIC/GRAU DAS Server

If you want to get information about a repository in the GRAU DAS
library from the Server, you can query the DAS Server. A query responds
with the contents of the media database of the DAS Server, and then
synchronizes the information in the IDB with what is actually in the
repository.

This is especially useful if you were using GRAU Sc 0
manage media, as this results in inconsistencies with the LDB - Data
Protector does not know the latest status of media in the library
repository. Proceed as follows:

1. Inthe Hp Openview Storage Data Protector Manager, switch to
the Devices & Media context.

2. In the list of configured devices, right-click the library you want to
query, then click Query.

See online Help for further information.

This action queries the _ _.S Server for information.

Verifying Media

Use this function to verify media in a media pool. By reading all media
blocks and parsine all the headers, then parsine all Media Agent blocks

[ checking rec s in each block, Data Prc let in 2 ther
the data on the media is valid. If the CRC option was set during backup,
Data Protector recalculates the CRC and compares the values.

You can only verify resident Data Pre nedia.

1. Inthe HP Openview Storage Data Protector Manager, switch to
the Devices & Media context.

2. In the Scoping Pane, click Devices. The list of configured devices will
display in the Results Area.

3. In the list of configured devices, click the name of the library, then
expand it to display the Drives and Slots items.

4. Click Slots to display the list of slots in the Results Area.

5. Select a range of slots to verify.
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6. Change the information that appears in the Results Area.

See online Help for further information.

These modifications are made to the IDB, and not to the tape itself.

Moving Media

Use this function to move media from one media pool to another. When
you move media to another media pool, all the media information such as
condition, type, medium ID, and session information is transferred to the
new media pool.

Getting Information about Media

Use this functior ity to display detailed information about the usage
and condition of an individual selected Data Protector medium. This is a
read-only window.

1. Inthe HP OpenView Storage Data Protector Manager, switch to
the Devices & Media 1

2. In the Scoping Pane, click Devices. The list of configured devices will
display in the Results Area.

3. In the list of configured devices, click the name of the library, then
expand it to display the Driv  and Slots items.

4. Click slots to display the list of slots in the Results Area.
5. Select a slot and its resident medium to view.
6. Information about the media appears in the Results Area.

See online Help for further information.

Recycling Media

Recycling a Data Protector-owned medium removes protection from data
objects contained on the medium. Recycled media can be reused for
backup. Also see “Recycling Media” on page 123 for more information.

1. In the HP OpenvView Storage Data Protector Manager, switch to
the Devices & Media context.

Chapter 14 677



ADIC/GRAU DAS and STK ACS Libraries
The ADIC/GRAU DAS Library Device

2. In the Scoping Pane, click Devices. The list of configured devices will
display in the Results Area.

3. In the list of configured devices, click * n of the lib ) tl
expand it to display the Drives and Slots items.

4. Select and then right-click the slots that you want to recycle.

5. Click Recy
See online Help for further information.

Removing Volsers

This action does not affect volsers in the GRAU DAS library but only
removes specific media from the IDB. Therefore, Data Protector does not
know that these media exist and does not use them.

1. Inthe HP Openview Storage Data Protector Manager, switch to
the Devices & Media context.

2. Un ices, _ ndthe :hat has the media that you want
to remove.

3. Expand the Slots item and select the slots that you want to remove.

4. In the Actions menu, click Delete. The confirmation dialog box
appears for you to confirm that you want to remove the selected
media.

5. Click OK to remove the selected media.

NOTE If the number of media to be removed exceeds more than fourteen in one
go, the media will not be referred to by ID (displayed in the window). You
if you ¥ it e of ~  for

Exporting Media

This functionality enables you to remove information about backup
objects contained on Data Protector media from the IDB. Use it when
media will no longer be used in a Data Protector cell. The media contents
remain unchanged.
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In the HP Openview Storage Data Protector Manager, switch to
the Devices & Media context. The Scoping Pane displays the list of
devices and media configured within your cell when you expand the
respective item.

Expand the Media item and the media pool, and then select the media
you want to export.

Right-click one of your selections, click Export, and then confirm your
decision.

The exported media will disappear from the list.

Importing Media

...s functionality enables you to reread information about media and
their contents back into the IDB. See also “Importing Media” on page 113
for more information.

1.

In the HP Openview Storage Data Protector Manager, switch to
the Devices & Media context.

Under Devices, expand the device that has the media that you want
to import.

3. Expand the Slots item and select the slots that you want to import.

4. In the Actions menu, click Import. The Import wizard appears.

5. Enter the required information, including the media pool that you

want to add the media to, the drive that will be associated with the
media, as well as any options that you want to set.

Chapter 14
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Data Protector has to be installed and configured. See HP OpenView
Storage Data Protector Installation and Licensing Guide.

The following information has to be obtained before you start
installing the ACS Agent software:

v
v

The <hostname> of the host where ACSLS is running.

A list of ACS drive IDs that you want to use with Date _ _otector.
To display the list, login on the host where ACSLS is running and
execute the following command:

rlogin “ACSLS hostname” -1 acssa

You will have to enter the terminal type and wait for the command
prompt. At the ACSSA prompt, enter the following command:

ACSSA> query drive all
The format specification of an ACS drive has to be the following:

Al ] ID:#,#,#,# - (ACS num, LSM , PANEL,
DRIVE) .

Make sure that the drives that will be used for Data Protector are
in the state online. If adriveisnot in ' online state, char
the state with the following command on ACSLS host:

vary drive <drive_id> online

A list of available ACS CAP IDs and ACS CAP format
specification. To display the list, login on the host where ACSLS is
running and execute the following command:

rlogin “ACSLS hostname” -1 acssa

Y " have to ~~*~~theter ° 1type and wait for the command
Pl At the /_____\ prompt, enter the following command:

ACSSA> query cap all
The format specification of an ACS CAP has to be the following:
ACS CAP: ID:#,#,# (ACS num, LSM num, PANEL, DRIVE).

Make sure that the CAPs that will be used for Data Protector are
in the state online and in manual operating mode.

If a CAP is not in the state online, change the state using the
following command:

vary cap <cap_id> online
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If a CAP is not in manual operating mode, change the mode using
the following command:

set cap manual <cap ids>
v/ Alist of SCSI addresses for the drives, for example, scsi4:0:1:0.

For more information on SCSI addresses, see HP OpenView
Storage ~ uta Protector Installation and Licensing Guide.

The installation procedure consists of the steps:

1. Distribute the ACS Agent component to clients using the Data
Protector graphical user interface and Installation Server for
Windows.

2. Physically connect the library drives and the systems where you have
installed ACS Agent.

See http://www.hp.com/go/dataprotector/specification for details about

supported StorageTek devices.
3. To start the ACS ssi daemon

¢  On the Windows ACS client and the Cell Manager, install the
LibAttach service. Make sure that during configuration of
LibAttach service the appropriate ACSLS hostname is entered.
After the successful configuration the LibAttach services are
started automatically and will be started automatically after the
boot as well.

After you have attached the LibaAttach service, check if the
libattach\bin directory has been added to the system path
automatically. If not, add it manually.

e For more information on the service see the documentation that
comes with the StorageTek library.

4. Run the following command to check whether or not the library
drives are properly connected to your system:

¢ On Windows ACS client,

<Data_ Protector home>\bin\devbra -dev
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You should see the library drives with corresponding device
files/SCSI addresses displayed in the list.

Installing the ACS Media Agent on a 32-bit HP-UX System

The following prerequisites for installation have to be met before
installing the ACS Agent on an HP-UX system:

¢ The StorageTek library has to be configured and running. See the
documentation that comes with the StorageTek library.

¢ Data Protector has to be installed and configured. See the HP
OpenView Storage Data Protector Installation and Licensing Guide.

e The following information has to be 0ol © * .ed before you:
installing the ACS Agent software:

v The <hostname> of the host where ACSLS is running.

v A list of ACS drive IDs that you want to use with Data Protec
To display the list, login on the host where ACSLS is running and
ute the following cor  ind:

rlogin “ACSLS hostn: -1 acssa

v ..awill have to enter the terminal type and wait for the command
prompt. At the ACSSA prompt, enter the following command:

ACSSA> gquery drive all
The format specification of an ACS drive has to be the following:

ACS DRIVE: ID:#,#,#,# - (AC num, LSM num, PANEL,
DRIVE) .

v Make sure
inthes ¢
the state W.o.e vecw comnvviian vvsmicas e ce e e

()

vary drive <drive_id> online

v Alist of available ACS CAP IDs and ACS CAP format
specification. To display the list, login on the host where ACSLS is
running and execute the following command:

rlogin “ACSLS hostname” -1 acssa

You will have to enter the terminal type and wait for the command
prompt. At the ACSSA prompt, enter the following command:
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e Follow the same steps for creating drives as in the indirect library
access configuration, but in Advanced Options, make sure to turn off
the Force Direct Library Access feature. By default, this feature

is on.

Using Data Protector to Access the STK ACS Library

Once you have configured your environment and installed the ACS
Media Agent on the systems that will access the library robotics, you are
ready to use the Data Protector GUI to access the media in the STK ACS
library. The following sections provide instructions on using Data
Protector with the STK integration.

Data Protector allows you to connect directly to the ACS Library Server
host and perform some management tasks.

To connect to the ACS Library Server host, choose Actions, Connect
to ACSLM from the Library Management window.

This action performs a remsh command to the ACSLS host and starts
. c. If you want to change the default settines for this action,
change the ACSIMHOST option in the global options .....

Searching for Media

Use this function to locate a specific medium without having to browse
the entire list of media. Data Protector locates media by searching
through Medium Labels, then Medium Locations, and finally Medium
IDs.

1. Inthe HP Openview Storage Data Protector Manager, switch to
the Devices & Media context.

2. To search for media in a media pool, select the Media item.
To search for media in a library, select the Devices item.
3. In the Edit menu, click Find. The Find dialog box appears.

Use the appropriate search method to search for media.
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Adding Media to a Media _ _ol

Adding media to a media pool registers the new media in the IDB as
members of this media pool. It is not necessary for these media to
actually reside in the ACS repository.

To add media to a pool, initialize it first. Initializing media prepares it
for use with Data Protector. See “Initializing Media.” You can also import
it. See “Importing Media.”

Initializing Media

Initializing media prepares media for use with Data Protector by saving
the information about the media (medium ID, description and location)
in the IDB and also writes this information on the medium itself (media
header). When you initialize media, you also spec ;0 which pool
the media belongs.

You need to initi: e media before you use media for backup. If media
are not initialized before backup, Data Protector formats media during
backup. This increases the backup time.

In the HP OpenView Storage Data Protector Manager, switch to
the Devices & Med: :ontext.

2. Expand the Media item, right-click the desired media pool, and then
select Initialize. The Initialize wizard appears.

3. In the Destination page, in the Media Pool drop-down box, select
the media pool to which the media will be assigned. Click Next.

4. Inthe Medium Location drop-down list, select which d' e the
media are in.

5. Click! The! m ] sage ap

6. Under Medium Name, either have Date . ....ctor Automatically
ran 3 for the medium, or click the ecify radio button
and enter a name for the medium in the accompanying text box.

7. In the informational User Location drop-down box, either enter or
select the location of the media’s user.

8. Click Next. The Initializing Options page appears.
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The Medium Capacity button defines whether Data Protector will
Determine the storage size of the medium, or whether you want to
Specify the storage size of the medium. You can leave the default,
which is Determine.

The Force Initialization button will automatically initialize
blank media or media in other formats recognized by Data Protector
(tar, cpio, OmniBackI, and so on). You can leave the default value.
Data Protector media containing protected data will not be
re-initialized even if this option is set. The Eject option, if set, will
eject a medium from the « 2 after the initialization  pletes.

Follow online Help for information on specific items in the L.

9. Click Finish to confirm and exit this wizard.

Initializing Multiple 1. In the HP OpenView Storage Data Protector Manager, switch to
in a Library the & Media context.
""" 2. Under: ices, _ nd' libr e that contail  :he media

that you want to initialize.
3. Expand the Slots item, and then select arar - of slots to initialize.

Right-click the selected range of slots, and then select Initialize.
The Initializev  1appears.

4. In the Destination page, in the Media Pool drop-down box, select
the media pool to which the media will be assigned.

5. Click Next.The loc: )age appears.

6. In the Medium Location drop-down list, select which device the
media are in.

7. Click Next. The Medium Na  >age appears.

8. Under Medium Name, either have Data Protector Automatically
G ; fort o click tl ify radio button
and enter a name for the medium in the accompanying text box.

9. In the informational User Location drop-down box, either enter or
select the location of the media’s user.

10.Click Next. The Initializing Options page appears.
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11. Optionally, use the Medium Capacity button to define whether Data
Protector will Determine the storage size of the medium, or whether
you want to Specify the storage size of the medium. You can leave
the default, which is Determine.

12.0pti ~ ,u the Force Initializat: (butt
automarically initialize blank media or meaia in other tormats
recognized by Data Protector (tar, cpio, OmniBackl, and so on). You
can leave the default value. Data Protector diac¢  aining
protected data will not be re-initialized even 1t this option is set. The
Eject option, if set, will eject a medium from the drive after the
initialization completes.

Follow online Help for information on specific items in the wizard.

13.Click Finish to confirm and exit this wizard.

Verifying Media

Use this function to verify mediaina  dia pool. By reading all media

blocks and parsing all the headers, then parsing all Media Agent blocks
and check _;records in each block, Data Protector determin:  vhether
the data on the media is valid. If the CRC option was set during backup,
Data Protector recalculates the CRC and compares the values.

You can only verify resident Data Protector media.

1. In the HP OpenView Storage Data Protector Manac switch to
the Devices & Media context.

2. In the Scoping Pane, click Devices. The list of configured devices will
"~ plag S

3. In the list of configured devices click the name of the ]
expand it to display the Drives and Slots items.

4. Click Slots to display the list of slots in the Results Area.
5. Select a range of media to verify.
6. Right-click your selected media, and then click verify.

See online Help for further information.

Scanning Media

Use this function to examine the format of selected media. Also see
“Scanning Media in a Device” on page 129 for more information.
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1. In the HP OpenvView Storage Data Protector Manager, switch to
the Devices & Media context.

2. In the Scoping Pane, click Devices. The list of configured devices will
display in the Results Area.

3. In the list of configured devices click the name of the library, then
expand it to display the Drives and Slots items.

4. Click Slots to display the list of volsers in the Results Area.
5. Select a range of media to scan.
6. Right-click your selected media, and then click Scan.
See online Help for further information.
When the scan process has been completed, the Library Management
;i(:ﬁgw is updated with information on the format of the examined

Modifying Media Attributes

Use this function to change the location or label description of a Data
Protector medium. An example of when you might want to change the
location of ar v T wl

1. Inthe HP Openview Storage Data Protector Manager, switch to
the Devices & Media context.

2. IntheS _ ng@ ,click Devices. The list of configu 1
display in the Results Area.

3. In the list of conficured devices click the name of the library, then
expand it tc the Drives !Slots it

4. Click Slots to display the list of media in the }  1lts Area.
5. Select a medium to modify.
6. Change the information that appears in the Results Area.

See online Help for further information.

These modifications are made to the IDB, and not to the tape itself.
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Moving Media

Use this function to move media from one lia pool to another. When
you move media to another media pool, all the media information such as
condition, type, medium ID, and session information is transferred to the
new media pool.

Getting Information about Media

Use this functionality to display detailed information about the usage
and condition of an individual selected Data Protector m« ** mm. This isa
read-only window.

1. In the HP Openview Storage Data Protector Manager, switch to
the Devices & Media context.

2. In the Scoping Pane, click Devices. The list of configured devices will
display in the Results area.

3. In the list of configured devices click the name of the library, then
expand it to display the Drives and Slots items.

4. Click Slots to display the list of slots in the R Its Area.
mto ~ 7
6. Information about the medium appears in the Results Area.

See online Help for further information.

Quer 1gthe STKA( M st

If you want to get info  tion aboul i n the STK]
the server, you can query the ACSLuw1. nust. Querving ACSLM queries
the ACSLS datal e, and then s ‘hronizes the ion theIDB

with what is actually in the repository.

This is especially useful if you were using STK commands to manage
media, as this results in inconsistencies with the IDB - Data Protector
does not know the latest status of media in the library repository.

1. Inthe HP Openview Storage Data Protector Manager, switch to
the Devices & Media context.

2. In the list of configured devices click the name of the library, then
expand it to display the Drives and Slots items.

3. Right-click the device that you want to query, and then click Query.

Chapter 14 693



O

TR ‘\o«
) QO}*

ADIC/GRAU DAS and STK ACS Libraries
The STK ACS Library Device

See online Help for further information.

This action queries the ASCLM host for information.

Recycling Media

Recycling a Data Protector owned media removes protection from data
objects contained on the media. A recycled medium can be reused for
backup. Also see “Recycling Media” on page 123 for more information.

1. In the HP Openview Storage Data Protector Manager, switch to
the Devices & Media context.

2. In the Scoping Pane, click Devices. The list of configured devices will
display in the Results Area.

3. In the list of configured devices click the name of the library, then
expand it to display the Drives and Slots items.

4. Select and then right-click the media that you want to recycle.
5. Click Recycle.
€ He for further information.

Removing Media

This action does not affect media in the STK library but only removes
specific media from IDB. Therefore, Data Protector does not know that
these media exist and does not use them.

" thesn vV r Sto : a : er,swi 0
the Dev Media context.

2. Under Devices, expand the device that has the media that you want
ot

pand the Slotsit  and select the media that you it to

4. In the Actions menu, click Export. -._e confirmation dialog box
appears for you to confirm that you want to export the selected media.

5. Click OK to export the selected media.
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Ifthen  rer of media to be removed at once exceeds fourteen, the
media will not be referred to by ID (displayed in the window). You will be
asked if you wish to remove that amount of media.

Exporting Media

This functionality enables you to remove information about backup
objects contained on a Data Protector medium from the IDB. Use it when
media will no longer be used in a Data Protector cell. The media contents
remain unchanged.

1. In the HP OpenvView Storage Data Protector Manager, switch to
the Devices & Media context. The Scoping Pane displays the list of
devices and media configured within your cell when you expand the
respective item.

2. Expand the Media item and the media pool, and then select the media
you want to export.

3. ™ ~Mt-click one of your selections, click Export, and then confirm your
sion.

The exported media will disappear from the Iist.

It _ rting Media

This functionality enables youtore <
their contents back into an IDB. See also "lmporting Meaia on page 113
for more information.

1. In the HP Openview Storage Data Prol itor Manager, switch to
the Devices & Media context.

2. Under Devices, expand the device that has the media that you want
to import.

3. Expand the Slots item and select the media that you want to import.
4. In the Actions menu, click Import. The Import wizard appears.

5. Enter the required information, including the media pool that you
want to add the media to, the drive that will be associated with at
media, as well as any options that you want to set.

See online Help for a description of the fields and options.
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Observe mess: s generated during the process in the Library
Management window.
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Troubleshooting Library Installation and
Configuration

1

S R L

Install the DAS Media Agent on the system controlling the GRAU
robotics (PC/robot).

Install the DAS Media Agent on the NT PCs where a drive is
connected (PC/drive).

Copy aci.dll + winrpc.dll + ezrpcw32.dll to winnt' €
and <Data_ Protector home>\bin directory.

Create aci directory on PC/robot.

Copy dasadmin.exe to this direct

Copy portmapper and portinst to aci directory.

Start portinst to install portmapper (only on PC/robot).
Install mmd patch on the CM.

The PC needs to be rebooted; then open Windows Control pPanel. Go
to Services (Windows NT) or Administrative Tools, Services
(other Windows systems) and check if portmapper and both rpc
services are running.

10.Gotot! 0S/2 PC within the GRAU library, edit the

/das/etc/ 1fig...e:
cd | s/ete/
execute: "e config"

Withir this conf 1ile you need to add a client called
DATA_. ..JTEC1UR ng the IP addr  »f the PC/robot.

11.Execute the following commands from PC/robot:

dasadmin listd
dasadmin all DLT7000 UP <AMUCLIENT>

dasadmin mount <VOLSER>(then you need to push the UNLOAD button
on the drive)

dasadmin dismount <VOLSER>
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(or: dasadmin dismount -d <DRIVENAME>)
where <AMUCLIENT>=DATA_PROTECTOR
and <VOLSER> for example = 001565

and <DRIVENAME> is for example = DLT7001

and "all" stands for "allocate"

If you are not successful with these commands (communication to DAS
Server (0S/2), try to execute these commands on the OS/2 PC. You can

find the dasadmin command in/das/bin/.

If you execute theses commands from the 0OS/2 PC, use <AMUCLIENT> =

AMUCLIENT.

1. Login to the AMU client. The common login are the following:

user: Administrator pwd: administrator
user: Supervisor pwd: supervisor
2. 7 be neces; to set the media type:
SetACI_MEDIA_TYPESetACI_MEDIA_TYPE:DECDLT
3. To reboot the library, proceed as follows:
Shutdown OS/2 and then switch off robotics.

Restart OS/2 and when 0S/2 is ready, the AMU log will display that

the robotics is not ready. -..en, switch on robotics.

Youcan »ve media fr tc
using the aevice’s robotics. ¥ 18
nands. For example:

import I01
i- ~>rt CAP range: I01-I03
export CAP: EO1

export CAP range: EQ01-E03

The following syntax is used when you use the Data Protector uma utility

to manage the GRAU and STK library drives:
uma -pol 8 -ioctl grauamu

pol 8 for GRAU
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pol 9 for STK
The default media type is DLT.
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Further Information
In This Appendix

In This Appendix

This chapter gives information on the following topics:
“Backing Up and Restoring UNIX Specifics” on page A-3
“Data Protector Commands” on page A-7
“Performance Considerations” on page A-8
“Example of Scheduled Eject of Media” on page A-14

“Examples of Pre-Exec 1 Post-Exec Commands for UNIX” on
page A-20

“Disaster Recovery: Move Kill Links on HP-UX 11.x” on page A-25
“Cr.  ing a libaci.o on AIX” on page A-26
“Example of the Package Configuration File” on page A-28
umple of the Package Control File” on page A-38
“Data Protector Log Files Example Entries” on page A-44

“Windows Manual Disaster Recovery Preparation Template” on
y A-49

“Changing Block Size on Windows Media Agent” on page A-51
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E kin Up and Restoring UNIX " pecifics

This section explains how to backup specific UNIX formats, including
VxFS, Enterprise Filesystems, and Context Dependent Filesystems.

VxF'S Snapshot

VxFS allows you to back up a filesystem while it is being used by some
other application. This is called an online backup and is done by creating
a snapshot of a filesystem and backing up this snapshot.

You create a snapshot of a filesystem when you mount the VxFS
filesystem to a temporary directory. At this point you also specify the
filesystem you want to snap.

A snapshot is a copy of the filesystem at a specific m: rou
mount the VXFS filesystem to a temporary directory.

You can perform normal backups without using the VxFS snapshot
feature by simply configuring a backup as iy other file _ st In
thisc:  you cannot back up files that are in use.

You configure a backup of this temporary directory, which is actually a
mountpoint to the snapshot of the filesystem as it was at the moment of
the mount.

When the backup is finished, you unmount the snapshot filesystem so
1 i 3¢~ other pur

If vo1r want to use the VxF'S online backup functionality, you must
cor...,ure the backup as follows:

1. You have to have an empty or unused partition created on your
system that can be used by VxFS for a snapshot. See yoursy:  n
administrator’s manual for instructions.

The recommended size for the snapshot filesystem is up to 15% of the
snapped filesystem, if the filesystem is used heavily use during the
backup. Normally, the size should be around 5%.

Appendix A A-3






Example A-2

Further Information
Backing Up and Restoring UNIX Specifics

# snapping the same FS will cause the Pre-exec script to
fail and

# a DA to abort

#

# 2) an attempt to mount an already mounted snapshot FS,
# snapping some other FS will cause a warning to be

generated,
# script to fail and a DA to abort
#
3) mchronization with &I P .- ¢ ript 1ould
be also

# provided because the snapshot FS must not be unmounted
while
# there is other DA reading from the FS.

#

'ED_FS=$1
S SHOT FS=$2
M T_POINT=$3

mount -F vxfs -e -o snapof=$SNAPPED FS $SNAPSHOT_FS
$MOUNT_POINT

#
# end SnapMount.sh

#

The template below can be used to unme 3 stem.

Post- exec Script Template

# SnapUnmount.sh

#
# Unmounting snapshot filesystem (Post-exec shell

script)

#

# Script requires 1 parameter:

# - a mount point directory of the snapshot FS

# or
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Data Protector Commands

For a complete list of supported Data Protector commands, refer to the
HP OpenView Storage Data Protector Command Line Interfoce Reference
(CLIReference.pdf) or the omniintro man page on UN__

The HP OpenView Storage Data Protector Command Line Interface
Reference is located in the <Data_ Protector home>\docs\MAN
directory on Windows or in the /opt/omni/doc/C/ directory on UNIX.

The documents are available, if you installed the User Interface
c onent on Windows or the OB2-D0OCS component on UNIX.

On UNIX, use man <command name> for more details about the
command.
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Performance Considerations

This section gives an overview of the most common backup performance
factors. It is not meant to discuss performance. Due to the highr  “er
of variables and permutations, it is not possible to give distinct
recommendations that fit all user requirements and affordable
investment levels. Further discussions can! ‘ound in the HP OpenView
Storage Data Protector Concepts Guide.

The Infrastructure

The infrastructure has a high impact on backup and restore
performance. The most important factors are the parallelism of data
paths and the use of high speed equipment.

Network Versus Local Backups and Restores

Sen  rdata over the network introduces additional overhead as the
network becomes a component to performance consideration. _ . ta
Protector handles the datastream differently for the following cases:

Disk to Memory to Network to Memory to Device

Disk to Memory to Device

In order to maximize the performance, it is recommended to use local
backup configurations for high volume datastreams.

_ Jvices

dev type: °~ 7 " impacts the perf because of the
sustained speed at which a device can write data to a tape (or read data
from it). For example:

¢ DDS/DAT devices typically have a sustained speed of 510 KB/s to
3 MB/s, without compression, depending on the model.

e DLT devices typically have a sustained speed of 1.5 MB/s to 6 MB/s,
without compression, depending on the model.

¢ LTO devices typically have a sustained speed of 10 MB/s to 20MB/s,
without compression, depending on the model.

A-8 Appendix A



Further Information
Performance Considerations

The speed also varies if a device-compression gets used. The achievable
compression ratio depends on the nature of the data being backed up.
For most cases, using high speed devices with device-compression ON
does improve performance. This however is true only if the device(s)
Stream.

Libraries offer additional advantages because of their fast and
automated access to a large number of media. At a backup time loading
new or reusable media is needed and at a restore time the media which
contain the data to be restored need to be accessed quickly.

High Performance Hardware Other Than Devices

The computer systems themselves, that is, reading the disk and writing
to the device, directly impact performance. The systems are loaded
during backup by reading the disk or handling software
(de-)compression.

The disk read data rate and available CPU are important performance
eria for the th elves in addition to the I/O perfi ance
and network types.

__ing __.rdware in Parallel

Using several datapaths in parallel is a fundan  tal and efficient
method to improve performance. This includes the network
infrastructure. Parallelism helps in the following situations:

® Several systems can be backed up locally, that is, with the disk(s) and
the related devices connected on the same system.

e Several systems can be backed up o rk.
ne  Ork traffic routing needs to be such that the datapaths do not
overlap, otherwise the performance will be reduced.

e Several objects (disks) can be backed up to one or several (tape)
devices.

e Several dedicated network links between certain systems can be
used. For example, system_A has 6 objects (disks) to be backed up,
and system_B has 3 fast tape devices. Putting 3 network links
dedicated to backup between system_A and system_B is a solution.
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¢ Load Balancing: This is where Data Protector dynamically
determines which filesystem should be backed up to which device.
Normally, it is best to enable this feature. This is especially true
when a large number of filesystems in a dynamic environment are
being backed up.

Configuring Backups and Restor

Any given infrastructure must be used efficiently in order to maximize
performance. Data Protector offers high flexibility in order to adapt to
the environment.

Device Streaming

To maximize a device’s performance, it must be kept streaming. A device
is streaming if it can feed enough data to the medium to keep it moving
forward continuously. Otherwise, the tape has to be stopped, the device
waits  some redata,rev s the tape a little and resumes to write
to the tape, and so on. In other words, if the data rate written to the tape
isl  orequal the dat: ite which can be delivered to the device by the
computer system, then the device is streaming. In network-focused
backup infrastructures, this deserves attention.

Backups can be setup so that the data from several disk agents is sent to
one Media Agent, which sends the data to the device.

Block Size

The device hardware processes data it receives using a device type
specific block size. Data Protector allows to adjust the size of the block it
sends to the device. The default value is € ™~

Inc  singtl »olock ze 1improvetl erfor1 "
block size should be done before formatting tapes. Fo: ape
written with the default block size cannot be appended to a tape using a
different block size.

Software Compression

Software compression is done by the client CPU when reading the data
from the disk. This reduces the data which gets send over the network,
but it requires significant CPU resources from the client.
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By default, software compression should be disabled. Software
compression should only be used for backup of many systems over a slow
network where the data can be compressed before sending it over the
network. If software compression is used, hardware compression should
be disabled since trying to compress data twice actually expands the
data.

Hardware Compression

Hardware compression is done by a device, which r¢  7es the original
data from the Media Agent client and writes it to the tape in compressed
mode. Hardware compression increases the speed at which a tape drive
can receive data, because less data is written to the tape.

By default, hardware compression should be enabled. On HP-UX and
Solaris, hardware compression should be enabled by selecting a

h compre ond e file. On Win¢ NT and Windows 2000,
hardware compression can be selected during the device configuration.
Using hardware compression or not should be a conscious decision,
because media written in compressed mode cannot be read using the
device in uncompressed mode and vice-versa.

HP Ultrium LTO drives use automatic hardware compression which
cannot be disabled. Ensure that you do not enable Software
compression when you configure an HP Ultrium LTO drive.

Full and Incremental Backups

A basic approach to improve performance is to reduce the amount of

backed-up data. Take full advant- — of time when
plannii  your full and incrementau vackups.
is that tnere isnoneed todo full]  : -3 of uu wie syswews on the same

day, unless necessary. See the HP Upe..view Storage Data Protector
Concepts Guide for more information.
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Image Backup Versus Filesystem

It used to be more efficient to back up images (raw volumes) instead of
backing up filesystems. This can still be true in some cases, such as with
heavily-loaded systems or if the disks contain a large number of
scattered files. The general recommendation is to use the filesystem
backup.

Object Distribution to Media

There are many ways to configure a backup such that the backup data
ends up on the media in just as many different configurati
example:

¢ One object goes to one medium, or

¢ Several objects go to several m¢ ** , each mediumcon =~ =~ . from
each object

Under certain conditions, one distribution may be advantageous
considering the backup performance, however this .y not be the
optimal restore configuration.

The ¢ lenge is to optimize the tup for a backup it  one
frequently) and at the same time have an acceptabl orv dia
situation.

Miscellaneous Performance ...nts

¢ Patches:

'y e ~ d all patche: © ° :the performance on
the network.

¢ On the computers that are Media Agent and Disk Agent clients, set
the IP as shown below:

IP is local "<MA And DA Client nar ' : true
¢ LAN Cards:

If you use a FDDI card, you can move it up on the bus so that it
receives a higher priority. Use ftp to transfer large files between the
MA and DA systems to see how the speed compares to Data Protector
performance. The network cards configured in half-duplex decrease
the performance.

¢ Simulating a high-speed device:
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wsample of ,cheduled Eject of Medi._.

You might want to eject all media that were used for backup during the
night every morning at 6.00 AM. To schedule such an operation pro d
as follows:

S S tC Hrup

1. In the Data Protector GUI, select Reporting.

2. Inthe Scoping Pane expand Reporting and right click Reports.
Select Add Report Group. The Add Report Group wizard is
¢ layed.

3. In the wizard, name your report group and click Next. The Data
Protector Scheduler is displayed.

4. In the Scheduler, select the starting day and click Add. In the
Schedule Report Distribution dialog window, specify the = wr,
and that the report is to be generated daily. Click OK and then
Finish.

The Report Group is now scheduled. Now you can add ort t¢

Add the Report to the Report Group and Conf" ire It

1. In the Add New Report Wizard, select Reports on Media and
Pools.

2. Select the List of Mediai__ :and name the report. Click Next.

11€1AS5 SEL LW UCLaUlLL STULLLILED, Willun INTAL 1UUL LLLLIGT.

4. Select the Relative time and specify 8 for Star: . within last
hours and 8 for Duration hours text boxes respectively. This will
cause only the media that were used for backup in the last eight
hours from the point of starting a report to be listed in the report.
Click Next.

5. In the Format and Send text boxes, select Tab and External,
respectively. In the Script text box, provide the name of the script
(HP-UX and Solaris systems) or the batch file containing the
command that starts the script (Windows systems). The script is
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Sreport =""${OMNIBIN}omnimm" -eject \"$lib\"
Sslots™;

#print "\debug>\nSreport\n<debug\n";

> ($: oort !~/Final report: (\d+) cartridges out of
(\d+) successfully ejected\./) {

print "[Critical] Eject has
failed!\n\nReport:\nSreport\n";

return (1) ;

}

print "$report\n";
($1 ne ) |

print " [Warning] Not all media successfully
ejected!\n";

return (2);

}

print "[Normall Eject from library \"3slib\"
successfully completed.\n";

return (0);

# FUNCTION Eject

AR TS none

# DESCRIPTION Function for each library in $List call
Library Eject

sub Eject {
local ($1lib,$slot, Sresult);
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| ( b, t) = each(%List)) {
$result |=&Library Eject($1lib, $slot);
}
if (Sresult) {
return (1);
} else {

print "[Normal]l All operations successfully
completed.\n";

return (0);

# FUNCTION Omnirpt
#
# ARGUMENTS none
#
#

DESCRIPTION Function get .ots to eject from omnirpt
report

sub Omnirpt {
@lines =<STDIN>;
for ($i=5;$%$i<@lineg;$i++) {
@line =split(/\t/,$lines[$1]);
if ($line (2] =~/"\[(N\w:\-\sl+):\s+(\w+)\1/) {
$List{$1}.

$2.' '; # $1= "Library name", $2=
"slot ID"

}
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if (lkeys(sList)) {

print " [Warning] No ta 's) to e :t.\n";
return (1);

}

return (0);

if (SENV{"0S"}=~/Windov ) { # Windows NT
$OM JIN ='c:\\program files\\omniback\\bin\\"';
} else {
local ($uname)="uname -a~;
chop $Suname;
@uname: Hlit (' ', ne) ;
if ($uname[0]) {
if ($uname [0] eq 'HP-UX') {
SOMNIBIN /opt/omni/bin/"';
( ) } else {
SOMNIBIN ='/usr/omni/bin’;
}

} else {
exit (1);
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print "[Normal] Starting eject of media that have
be 1 used in the last 24 hours.\n";

exit (0) if (&Omnirpt());
exit (1) if (&Eject());
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Examples of Pre-Exec and Post-Exec Commands for UNIX

wxamples of . re-uxec and . vst-Exec
Commands for UNIX

The following scripts are some examples of Pre- and Post- exec

commands on UNIX.

The script shuts down an Oracle instance.

#!/bin/sh

export ORACLE_HOME=$2

export ORACLE_SQLNET NAME=$1

if [ -f SORACLE_HOME/bin/sv jrl ]; then

SORACL™ "IOME/bin/svrmgrl << EOF

connect sys/manager@$ORACLE_SQLNET NAME as sysdba
shutdown

EQF

echo "Oracle database \"SORACLE_SID\" shut down."
exit 0

else

echo "Cannot find Oracle SVRMGRL
(SORACLE_HOME/bin/svrmgrl) ."

exit 1

fi

#!/bin/sh

echo "The disk will be unmounted!™"

umount /disk with many files

if [ 8?2 = 0 ]

then

echo "The disk has been successfully unmounted!"

exit O
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else
echo "Pailed to unmount the disk --> ABORTED!"
it 1

fi

#!/bin/sh

This example Post-exec  pt will start up the Oracle database.
#!/bin/sh
export ORACLE_HOME=$2
export ORACLE SQLNET_NAME=$51
if [ -f SORACLE HOME/bin/svrmgrl ]; then
SORACLE HOME/bin/svrmgrl << EOF
connect sys/man: :r@SORACLI" "QLNE™ “TAME as sysdba
Irtup
'F
echo "Oracle database \"$ORACLE SID\" started."
exit 0
else

echo "Cannot find Oracle SVRMGRL
(SORACLE_HOME/bin/svrmgrl) ."

exit 1
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fi

#!/bin/sh

if [ $BDACC != 0]

then

echo "

kup could n

read tl d

echo "Disk will not be automatically mounted!"

fi

echo "The disk will be now mounted!™

mount /dev/vg05/lvol2 /disk_with many files

if [ 8?2 = 0 ]
then

echo "Disk successfully mounted!?"

exit 0

else

echo .led to mount d: %

exit 1

fi

#1/bin/sh

if [ ! -f /etc/logfile ]

then

fi

echo "Backup finished with code $BDACC on " “date™ >>

/etc/logfile

# We do not want a backup to be marked failed even if the

previous
action failed.

exit O
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#!/bin/sh

/opt/omni/bin/omnirpt -report single session -session
$SESSIONID | \

mailx -s "Report for $SESSIONID" S$SOWNER

#!/bin/sh

# First check how the ¢ ‘ent el ) finished
if [ $SMEXIT != 0 -o $SMEXIT != 10 ]

then

echo "Backup not successful --> next backup will not be
started!"

exit ©

fi

if [ $RESTARTED != 0 ]
then

echo "Restarted backup --> next backup will not be
started!”

£ o
fi
/opt/omni/bin/omnib -datalist BACKUP_NO 2 -no_mon

exit 0

#!/bin/sh

# First check how the current backup finished
if [ $SMEXIT != 0 -o $SMEXIT != 10 ]

then

echo "Backup not successful --> backup will not be
restarted!"

exit 0
fi
if [ SRESTARTED != 0 ]
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then
echo "Restarted backup --> backup will not be
restarted!™
exit 0
fi
~ ./b ! 1 -restart $SESSIONID -no_mon
it ©
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Disaster Recovery:
Move Kill Links on HP-UX 11.x
6] shown! w hes emw yt want k up to
" : links:
# The system will go from "run-level" 4 to "run-level 1"

# retaining the inetd, networking, swagentd services up.
The state is called "minimum activity" for backup
purposes (need networking).

# IMPORTANT: ensure the links are present in /sbin/rcl.d
befo:

# moving and they do have this exact name. You have to
rename them for the rc0.d directory. Put them BELOW the
lowest (original "/sbin/rc0.d/Kxx") "K...-link" in : .d

# Move K430dce K500inetd K660net KS00swagentd into
../rc0.d BELOW the lowest kill link!!!

echo "may need to be modified for this system"
exit 1
#
l, »in/recl.d
mv K430dce ../rc0.d/K109dce
mv K500inetd ../rc0.d4/K110inetd
mv K660net ../rc0.d/Kllénet

mv K900swagentd ../rc0.d/Kl20swagentd
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Creating a libaci.o on AIX

On AIX, Data Protector DAS Agent uses the object module libaci.o to

A.03.10 and Earlier access ADIC/GRAU system. This object module has to be created from

OmniBack Il
A.03.5x and A.04.x

the library archive file 1ibaci. a, that is delivered by the vendor of
ADIC/GRAU system.

1. Create the file libaci.exp containing the list of modules used by
Data Protector DAS Agent:

#! /usr/omni/lib/libaci.o
aci_initialize
aci_gversion
aci_init
d errno
aci_view
aci_drivestatus
ac® “rivestatus2
aci_ariveaccess
aci_mount
aci_dismo
srange
't pe
aci_eject
aci insert

2. Create libaci.o by executing following command:
1d -1, -/ ~ ) -DM:SRE -- -ostart -lc
-bE:<DAS PATH>/libaci.eXp <Dmo PATH>/libaci  -o libaci.o

<DAS PATH>is the path to the di  tory where libaci.a and
libaci  pfiles reside.

3. Copy libaci.o to the /usr/omni/1ib directory.

OmniBack IT A.03.5x and A.04.x DAS Agent on AIX uses the library
object module named libaci.a which has to be created from the library
archive file of the same name. Proceed as follows to create the object
module:

1. Create the file 1ibaci .exp containing the list of modules used by the
OmniBack IT DAS Agent:
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# En : the failover policy for this package. This policy will
be used

# to select an adoptive node whenever the package needs to be
started.

# The default policy unless otherwi S) ed is
CONFIGURED_NODE.

# This policy will select nodes in priority order from the list
of

# NODE_NAME entries specified below.

#

# The alternative policy is MIN_PACKAGE _NODE. This policy will
select

# the node, from the list of NODE_NAME entries below, which is

# running the least numl - of packages tl
needs

# to start.

FATILOVER_POLICY CON URED_NODE

# Enter the failback policy for this package. This policy will
u

# to oW . q
running on

# its primary node and its primary node is capable of running
the

# package. The default policy unless otherwise specified is
MANUATL .

# The MANUAL policy means no attempt will be made to move the
package

# back to its primary node when it is running on an adoptive
node.
#

# The alternative policy is AUTOMATIC. This policy will attempt
to
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# execution of each script.

# Note: The HALT SCRIPT_TIMEOUT should be greater than the sum
of

# all SERVICE_HALT TIMEOUT specified for all services.

RUN_SCRIPT /etc/cmcluster/ob2cl/ob2cl.cntl
RUN_SCRIPT TIMEOUT NO_TIMEOUT
HALT SCRIPT /etc/cmcluster/ob2cl/ob2cl.cntl

HALT SCRIPT TIMEOUT NO TIMEOUT
Enter the SERVICE NAME, the SERVICE_FAIL_FAST_ ENABLED and the
SERV. E ' TIMEOUT values for this package. Repeat these

#

#

# three lines as necessary for additional service names. All
# service names MUST correspond to the service names used by
#

cmrunserv and cmhaltserv commands in the run and halt

scripts.

#

# The value for SERVICE_FAIL FAST ENABLED can be either YES or
# NO. If set to YES, in the event of a service failure, the

# cluster software will halt the node on which the service is
# running. If SERVICE_FAIL F. ' ENAI ) is not € ied, the
# de 11t will be NO.

SERVICE_HALT TIMEOUT is represented in the number of seconds.
This timeout is used to determine the length of time (in
seconds) the cluster software will wait for the service to
halt before a SIGKILL signal is sent to force the termination
of the service. In the event of a service halt, the cluster
software will first send a SIGTERM signal to terminate the

service. If the service does not halt, after waiting for the

H*+ o H O H H K
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# the subnets defined goes down, the package will be switched
to another

# node that is configured for this package and has all the
defined subnets

# available.

SUBNET 10.17.0.0

# The keywords RESOURCE_NAME, RESOURCE_POLLING INTERVAL,

# RESOURCE START, and RESOURCE UP_VALUE are used to specify
Package

# Resource Dependencies. To define a package Resource
Dependency, a

# RESOURCE NAME line with a fully qualified resource path name,
and

# one or more RESOURCE_UP_VALUE lines are required. The

# RESOURCE POLLING_INTERVAL and the RESOURCE_START are
optional.
#

# The RESOURCE_POLLING INTERVAL indicates how often, in
seconds, the

# resource is to be monitored. It will be defaulted to 60
seconds if

# RESOURCE_POLLING_INTERVAL is not specified.

#

# The RESOURCE START option can be set to either 2 MATIC or
DEFERRED.

# The default setting for RESOURCE_START is AUTOMATIC. If
AUTOMATIC

# is specified, ServiceGuard will start up resource monitoring
for

# these AUTOMATIC resources automatically when the node starts
up.
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# If DEFERRED is selected, ServiceGuard will not attempt to
start

# resource monitoring for these resources during node start up.
User

# should specify all the DEFERRED resources in the package run
script

# so that these DEFERRED resources will be started up from the
package

# run script during package run time.

#

# RESOURCE_UP_VALUE requires an operator and a value. is
defines

# the resource 'UP' condition. The operators are =, =, >, <,

>=,

# and <=, depending on the type of value. Values can be string
or

# numeric. If the type is string, then only = and != are valid

# oy ators. If the string contains whitespace, it must be
enclosed

# in quotes. String values are case sensitive. For example,
#
# Resource is up when its value is
# ________________________________
RESOURCE_UP_VALUE= UP"UP"
RESOURCE_UP_VALUE!= DOWNAny value except "DOWN"

#
#
# RES(C E_UP_VALUE= "On Course""On Course"
#
#

If the type is numeric, then it can specify a threshold, or a
range to

# define a resource up condition. If it is a threshold, then
any operator

# may be used. If a range is to be specified, then only > or
>= may be used
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=+

for the first operator, and only < or <= may be used for the
s nd o} .or.

# For example,

# Resource is up when its value is
U

# RESOURCE_UP VALUE = 55 (threshold)

# RESOURCE_UP_VALUE > 5.lgreater than 5.1 (threshold)
# RESOURCE_UP_VALUE > -5 and < 1l0between -5 and 10
(range)

#

# Note that "and" is required between the lower limit and upper
limit

# when specifying a range. The upper limit must be greater
than the lower

# limit. If RES _UP_VALUE is repeated within a
RESOURCE_NAME block, then

# they are inclusively OR'd together. Package Resource
Dependencies may be

# defi | by repeating t. entire R URCE NAME block.
#

# Example : RESOURCE_NAME
/net/interfaces/lan/status/lan0

# RESOURCE_POLLING INTERVAL120
RESOURCE_STARTAUTOMATIC
RESOU: Up_ RUNNING

RESOU: _Up_ O E

net/interfaces/lan/status/lano

will be checked every 120 seconds, and is considered

#

#

#

#

# Means that the value of resource

/

#

t

# be 'up' when its value is "RUNNING" or "ONLINE".
#
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NODE_FAIL_FAST_ENABLEDNO
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Example of the Packes ~~ Control File

This section gives an example of a package control file that you need to
modify while configuring Data Protector Cell Manager package in an
MC/ServiceGuard environment:

dedede gk ok ko kA Kk kg gk Ak ok ok ek ek ok sk ok sk ok ek ke e ok ke Tk ok ok ok K K ok ok ok ke ok ok ko kb ok ok ok ok

%k odkok ok k ok ok

# *

*

#* HIGH AVATLABILITY PACKAGE CONTROL SCRIPT (template)
*

++
*

#* Note: This file MUST be edited before it can be used.

*

#

dhhkkhkhkhkdkdkkhkhkd kb hkhkhkhkhkAkAkrdrdrhddtdddd ddhdddddrhddhkdkhhkhkrhrhkdkhkdhhhdth

%k okokokk ok

# UNCOMMENT the variables as you set them.

# Set PATH to reference the appropriate directories.

PATH=/usr/bin: /usr/sbin:/etc:/bin

# VOLUME GROUP ACTIVATION:
# Specify the method of activation for volume groups.

# Leave the default ("VGCHANGE="vgchange -a e") if you want
volume

# groups activated in exclusive mode. This assumes the volume
groups have

# been initialized with 'vgchange -c y' at the time of
creation.
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#

# Uncomment the first line (VGCHANGE="vgchange -a e -g n"), and
comment

# out the default, if your disks are mirrored on separate
physical paths,
#

# Uncomment the second line (VGCHANGE="vgchange -a e -gn -s"),
and comment

# the default, if your disks are mirrored on separate
physical paths,

# and you want the mirror resynchronization to occur in
parallel with

# the package startup.
#

# Uncomment the third line (VGCHANGE="vgchange -a y") if you
wish to

# use non-exclusive activation mode. Single node cluster
configurations

# must use non-exclusive activation.

#
# VGCHAI =" ‘hange -a e -g n"
# VGCHANG : e -gn

#VGCHANGE="vgchange -a y"
VGCHANGE="vgchange -a e"# Default

# VOLUME GROUPS

# Specify which volume groups are used by this package.
Uncomment VG[0]=""

# and fill in the name of your first volume group. You must
begin with

# VG[0], and increment the list in sequence.

i

# For example, if this package uses your volume groups vg0l and
vg02, enter:
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# filesystem will be fsck'd prior to being mounted. The
filesystems will be

# mounted in the order specified during package startup and
will be unmounted

# in reverse order during package shutdown. Ensure that volume
groups

# referenced by the logical volume definitions below are
included in

# volume group definitions above.
#
#LV[0]=""; FS[0]=""; FS MOUNT OPT[0]=""

LV[0]=/dev/vg_ob2cm/1lv_ob2cm
FS{0]=, i shared

FS_MOUNT_OPT[0]=""

# FILESYSTEM UNMOUNT COUNT

# Specify the number of unmount attempts for each filesystem
during pa e

# shutdown. 2 default is « to 1.

FS_UMOUNT _COUNT=2

# IP . RES

# Specify the IP and Subnet address pairs which are used by

# Uncomment IP[0]="" and SUBNET[0]="" and fill in the name of
your first

# IP and subnet address. You must begin with IP[0] and
SUBNET [0] and

# increment the list in seguence.

#

# For example, if this package uses an IP of 192.10.25.12 and a
subnet of
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#

# SERVICE_NAME [1] =pkglb

# SERVICE CMD[1]="/usr/bin/X11/xload -display
192.10.25.54:0"

# SERVICE_RESTART[I]:"—r 2" # Will restart the
service twice.

#

# SERVICE NAME [2] =pkgilc

# SERVICE_CMD[2]="/usr/sbin/ping"

# SERVICE RESTART[2]="-r 1" # Will restart the service
an infinite

# number of times.

#

# Note: No environmental variables will be passed to the
command, this

# includes the PATH variable. Absolute path names are required
for the

# service command definition. Default shell is /usr/bin/sh.
#

SERVICE_NAME [0] =omni_sv
SERVICE_CMD[0]="/etc/opt/omni/sg/csfailover.ksh start"

SERVICE TART [0]="-r 2"
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Further Information
Data Protector Log Files Example Entries

otector Log . .les ...:ample wntries

T  section provides some typical Data Protector messages that are
logged to in some Data Protector log files. This section does not intended
to provide further in-depth information on troubleshooting. For a
complete list of Data Protector log files and for more in formation on
them refer to “Data Protector Log Files” on page 550.

The contents and format of entries to Data Protector log files are subject
to change.

debug.log
02/11/00 12:22:01 OMNIRPT.23856.0
[, lib, str.c 1 it/27:212] A.03.10
b325
StrFromUserSessionId: "-detail": not in correct format

03/01/00 14:19:28 DBSM.21294.0
["PANSRC/db/RCS/cmn_srv.c,v 1.40":229] A.03.10 b325

DB[1] internal error [9] cannot exclusively cpen
database, it is already opened

03/01/00 14:21:14 DBSM.: 0
[ !’ /RCS/cmn_srv.c,v 1.40":272] A.03.10 i

CDB cell server "bmw" different than current host
"bmw.hermes"

03/01/00 14:21:43 OMNIB.21471.0 [“"/src/cli/omnibackup.c
/main/23":2585] A.03.10 b325

[Process] CanBackup failed!
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03/02/00 09:36:51 1INET.26130.0 ["/src/lib/ipc/ipc.c
/main/r31 split/10":6920] A.03.10 b325

IpcGetPeer: Could not expand ConnectionIP "10.17.6.227"

03/16/00 19:09:42 BSM.13152.0 [ db/cdb/cdbwr. _ ¢
/main/84":1538] A.03.10 bPHSS_ 21234/PHSS 21235

DB[1] internal error [-2009] The session is
disconnected

05/17/01 12:00:30 OMNIMM.7515.0 ["lib/cmn/obstr.c
/main/17":187] A.04.00.%B3 b335

StrToUserSessionId: "0": not in correct format

5/14/01 11:08:53 AM TUPGRADE CFG 7.
["integ/barutil/upgrade cfg/upgrade cfg.c
/main/27":1472] A.04.00.%B3 b335
_rade! ] Can not d registry value
\ .1 t-Packard\0; wiew\OmniBackII\Agents
\MS-SgL/u\sauser

[UpgradesQL] Warning: 2, The system cannot find the
file specified.

5/14/01 11:¢ :54 AM UPGRADE CFG.369.368
["integ/barutil/upgrade_cfg/upgrade cfg.c /main, '":154]
A.04.00.%B3 b335

[GetConfig] Can not read configuration from Cell Server
"brainiac.hermes" with integration "Oracle8" and
instance " OB2_GLOBAL"

[GetConfig] Error: 1012, [12:1012] Can not access the
file.

System error: [2] The system cannot find the file
specified.
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Neste contexto , contamos com os habjtuais préstimos ~»-

Marta Maka €oelko Tania Regina Teixeira Munari
Pregoeira/AC Presidente da CPL
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Diretoria de Administragdo
Departamento de Contratagdo e Administragdo de Material - DECAM
Comissao Permanente de Licitagac "PL/AC
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ABERTURA:24/07/2003 CI/CAS/DCON/DECAM-4.544/2003 ORCAMENTARIA: 00.8.00/7.03
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ANTYX"™ 5DO RELA . .10, {TEC-028/2003

05 2.187.229.00
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10 2.187.229,00
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